The Essential Guide to
CLOSE-UP PHOTOGRAPHY
INVENTIVE TECHNIQUES AND ORIGINAL IDEAS FOR ENTHUSIASTS

INSIDE

CREATIVE CLOSE-UPS
WONDERFUL WATER IDEAS
STUNNING STILL-LIFES
NATURE MASTERCLASS
Welcome...

“I can still vividly recall what it was like attempting close-up photography with a dedicated macro lens for the first time, even though more years than I care to remember have passed since that day! I was trying to capture creative images of a garden flower and, when looking through the viewfinder, I couldn’t believe how magnified and detailed a small section of the subject appeared. Wonder soon turned into frustration as I discovered the many challenges of macro photography, from limited depth-of-field to image composition and lighting. However, persistence and experimentation eventually paid off and I was able to successfully capture some beautiful images. If you’ve developed a strong interest in close-up photography, then The Essential Guide to Close-up Photography offers everything you need to develop your skills and create captivating images, from expert advice and creative ideas to pro inspiration and essential techniques. All manner of subjects are covered, from insects to flowers to everyday items you’ll find around the home, so you won’t be short of options. In this latest edition, we’ve also added extended sections on still-life and creative close-ups to help broaden your expertise. We hope you’ll find the tutorials and images educational and inspirational. Enjoy your close encounters! All the best!”

DANIEL LEZANO, EDITOR

Meet our macro experts

All our macro experts are regular contributors to Digital SLR Photography magazine. For further advice and inspiration to help you improve your photo skills, pick up the latest issue, available on the second Tuesday of every month. For more information, visit: www.digitalslrphoto.com

•ROSS HODGINOTT
  Ross is an award-winning photographer with many years of experience and is the author of several books dedicated to macro photography.

•DANIEL LEZANO
  An enthusiastic photographer for over 30 years, Daniel is an avid fan of macro photography, with a preference for flowers and other natural subjects.

•JORDAN BUTTERS
  A keen photographer for many years, Jordan utilises his in-depth knowledge of Photoshop with creative camera skills to add extra impact to his images.

•CATHERINE MACBRIDE
  A professional stock photographer who makes her living creating and shooting imaginative still-lifes and macro images. A true inspiration!
Contents

6 Introduction to macro
Everything you need to get started, including essential kit and your best focusing options.

14 Understanding the basics
The key techniques you need to master for great close-up photography, including aperture choice, exposure modes and lighting.

22 Understanding macro kit
The right kit is crucial for great close-ups. Here we cover your main options: macro lenses, close-up filters and extension tubes.

30 Still-lifes
Discover how countless still-life close-ups can be explored in your home and the garden.

42 Still-life masterclass: Colour Impact
48 Expert tutorial: Backlit Blooms
52 Expert tutorial: Patterns in Fruit

56 Nature masterclass
Shooting close-ups of nature’s finest requires understanding the right kit to use, how to ‘garden’ and creating a shallow depth-of-field.

58 Insects
64 Expert tutorial: Colourful Critters
66 Expert tutorial: Shooting Butterflies
71 Photo challenge: Insects
76 Wild flowers
81 Photo challenge: Woodland

86 Water in close-ups
Whether it’s frozen, static or in full flow, there is nothing that offers so many possibilities as water for the close-up photographer.

88 Expert tutorial: Water droplets
92 Expert tutorial: Cool reflections
94 Expert tutorial: Retro refraction
96 Expert tutorial: Ice patterns
98 Expert tutorial: Raindrop patterns
100 Expert tutorial: Water splash
102 Expert tutorial: Droplets on flowers

104 Creative close-ups
Combine your imagination with your photo talent to produce exciting close-up images.

106 Expert tutorial: Time-lapse
110 Expert tutorial: Feathers
115 Expert tutorial: Bokeh
118 Expert tutorial: Fine-art silhouettes
120 Expert tutorial: Paint the town red
122 Expert tutorial: Love story
124 Expert tutorial: Conceiving new ideas
126 Expert tutorial: Snow patrol
128 Expert tutorial: Forks
130 Expert tutorial: Road map of roses
132 Expert tutorial: Smoking candles
134 Expert tutorial: Flying high
136 Expert tutorial: Ethereal glow
138 Expert tutorial: Camping torch
140 Expert tutorial: Getting fruity
142 Expert tutorial: House of cards
144 Expert tutorial: Vignette
146 Expert tutorial: Black & white boost
148 Expert tutorial: Create a triptych

150 Close-up equipment
A selection of our favourite close-up kit

152 Budget test: Macro LED ringlight
156 Budget test: Raynox attachment
160 Lens test: Canon MP-E macro lens
162 Using grey & white cards

Turn to page 114 to find out about our fantastic subscription offers
Macro magic!

Are you ready to see the world in a whole new way? As you’ll soon discover, capturing high-magnification close-ups is one of the most rewarding forms of photography. Whether shooting nature, abstracts or still-lifes, viewing everyday subjects in miniature opens up the potential for exciting and colourful photography.

Image: Ross Hoddingott
Essential kit for close-ups

Whether you’re just starting out or taking your macro work to the next level, there are some bits of kit that are perfect for the job in hand...

TO CAPTURE good macro images, you need to be able to achieve a high level of magnification, beyond the capability of most standard lenses. In order to get close to small things, you either need a dedicated macro lens – optimised for close focusing – or an attachment that will convert your standard optic into a close focusing device. A dedicated macro lens is best, offering both quality and convenience, but being a specialist lens choice, these can be pricey. If you intend to take a lot of close-ups, it is well worth the investment and it will prove a useful addition to your kit bag. However, if you are just dabbling with macro photography at this stage – or need to work within a tight budget – a close-up filter or auto extension tube is likely to be your better and cheaper option.

There are also a few essential accessories you will require, several of which you will likely already have. The most important is a tripod. The smallest movement is exaggerated in close-up, so whenever practical, use a support. A remote release will also prove useful, as will a small reflector – either bought or homemade.

Three of the best ways to get close...

MACRO LENS
A true macro lens is capable of a reproduction ratio of 1:1 (life-size). Typically, they are prime, fixed focal lengths with a fast maximum aperture, ranging from 50mm to 200mm. Although – bar one or two – they’re all capable of the same level of magnification, the actual focal length is significant, helping determine the weight, size, cost and working distance. Shorter macros from 50mm to 90mm are lighter and smaller, and tend to be cheaper. They don’t provide such a large camera-to-subject distance, so for frame-filling shots, you’ll need to get closer to the subject. This is fine for inanimate objects, but can prove a problem with wildlife. A tele-macro, with a focal length upwards of 90mm, provides a larger working distance, reducing the risk of you disturbing subjects. However, they are heavier, so you’ll need a tripod. Also, due to the narrower angle-of-view, they appear to produce a shallower depth-of-field, so focusing must be precise.

AUTO EXTENSION TUBES
A cut-price option is auto extension tubes. Basically, they are hollow tubes that fit between your camera and lens. In doing so, they reduce the lens’s minimum focusing distance, therefore increasing the level of magnification. As they are constructed without optics, they don’t degrade the lens’s optical quality, but they do reduce the amount of light entering the camera; the higher the magnification, the more light that is lost. Auto extension tubes are compact, light and – combined with a quality lens – capable of great results. Common lengths include 12mm, 25mm and 36mm – the wider the tube, the greater the extension. They are best combined with short prime focal lengths – in the region of 35mm to 100mm. Kenko is among the few brands to produce them. Non-auto versions are available cheaply – for around the £10 mark. However, you should be aware that the lack of electronics means they disable many of the camera’s key automatic functions, like certain exposure modes and focusing, so you will need to do everything manually.

CLOSE-UP FILTERS
Don’t worry if you can’t afford a macro lens or extension tube – this is the most affordable option. They are circular screw-in type filters, which act like a magnifying glass. They provide a great introduction to close-up photography. They are light and do not affect the lens’s automatic functions. Hoya, Kood, Micro Tech Labs, Nikon and Raynox are brands to look out for. Their magnification is measured in diopters and they are available in a range of diameters and strengths, typically +1, +2, +3 and +4. The higher the number, the greater their magnification. +10 versions are also available, but their quality tends to be fairly low. They are best paired with short prime lengths, in the region of 50mm to 135mm. Close-up filters don’t provide a large working distance, so be prepared to get close to your subject to capture frame-filling shots. They are also prone to spherical and chromatic aberration – image quality can be maximised by selecting an aperture no smaller than f/8.

Essential accessories

REFLECTOR: A reflector is a ‘must have’ for close-up photography – invest in one if you’re taking a lot of close-ups. A 30cm or 45cm reflector will more than suffice for much of the time. Its colour is important: white will provide a soft, diffused light; silver is more efficient, but can look harsh; while gold or sunfire will add warmth to close-ups. A cut-price alternative is to wrap foil around a piece of card.

REMOTE RELEASE: Even when your camera is tripod-mounted, physically depressing the camera’s shutter release button can generate slight movement. At slower shutter speeds, this can soften picture quality and ruin a potentially brilliant image. Therefore – whenever practical – trigger the shutter remotely using either a corded or infrared remote. This maximises image sharpness – particularly when used in combination with your camera’s mirror lock-up facility.

TRIPOD: For pin-sharp close-ups, use a tripod whenever it’s practical to do so. Look for one with good low-level capability. For example, Manfrotto’s XPROB design allows the centre column to be positioned horizontally, the Gitzo Systematics lack a centre column altogether, while Gittos models with a 3D column are also perfectly suited to close-up work. The design and type of head you combine it with is very much down to personal taste. However, the precision of geared heads is well-suited to macro.

PLAMP: The Wimberley Plamp is a ball & socket segmented arm with a clamp fixed at each end. One clamp fastens to one of the legs on your tripod, while the other can be used to hold an object. They are particularly handy for holding a reflector in place, but can also be used to hold your subject steady or in position – for example, a windblown flower or branch. A useful addition to your kit bag.

RIGHT-ANGLE FINDER: The introduction of LiveView and vari-angle monitors means right-angle finders are less popular now. They are L-shaped attachments that fit onto the camera’s eyepiece to allow you to view and compose images by peering downwards, rather than horizontally, into the viewfinder. When shooting at low or ground level – which can be often with macro work – an angle finder allows you to compose images more comfortably.
Suggested macro outfits to suit every budget...

**GETTING STARTED**
You haven’t tried shooting close-ups before, but want to give it a go. You have a limited budget and there is no point spending too much at this stage. Although you can’t justify a dedicated macro lens, you can still get close enough to most subjects by using an inexpensive close-up attachment. However, macro lenses don’t provide a large working distance, so prioritise photographing inanimate subjects, like still-lifes, patterns, flowers and plants, rather than small wildlife.

1) **Close-up filters (£10+)**: A +3 or +4 close-up filter will provide a good introduction to macro photography, converting your normal lens into a makeshift macro. Combining them will provide a greater level of magnification, but expect image quality to drop. Hoya produces a good range of filters.

2) **Reflector (£10+)**: Although you could make your own by attaching kitchen foil to card, buying a proper reflector is recommended. They fold away and will easily slip into your camera bag. A sunlite/soft silver version will provide a nice natural light source. A 30cm reflector is large enough for small subjects.

3) **LED ringflash (£30+)**: Provides soft, shadow-free lighting for close-ups at a fraction of the cost of a normal ringflash. You can control the output level of the LEDs, and either fire them or keep them on constantly. A power pack attaches to the camera’s hotshoe. Hama, Polaroid and Seagull are among the makers.

**GETTING EXPERIENCED**
You are hooked and want to take better close-ups. Therefore, it is time to invest a little more cash to buy kit that will allow you to capture superior image quality. A macro lens is still beyond your current budget, but auto extension tubes will provide sharper, crisper results compared to using diptres. Camera-to-subject distance will still be short, but the addition of a good tripod to your set-up will allow you to widen the list of subjects you can shoot.

1) **Auto extension tubes (£50–£75)**: Unlike close-up filters, extension tubes don’t degrade image quality. A 50mm f/1.8 is a good choice for use with tubes. Polaroid and Zeikos produce budget auto tubes and eBay has a wide selection.

2) **Tripod (£100–£150)**: A tripod helps you fine-tune composition and enables you to place your point of focus more accurately. The Manfrotto 190XPROB is a good choice, with a centre column that can be placed horizontally and legs that can be splayed flat.

3) **Ringflash adaptor (£80+)**: These convert a hotshoe-mounted flash into a ringflash. They lack the functionality of a dedicated ringflash, but are a good cut-price option. Try Rayflash or Orbis, but arguably they offer little advantage over the cheaper LED ringflash for macro.

4) **Plamp (£35)**: Not particularly expensive, but a useful gadget to keep in your gadget bag when shooting close-ups. Ideal for holding a reflector in place, for steadying a branch or flower stem, or for generally acting like an extra hand.

**GETTING SERIOUS**
Close-ups are your thing. You’re specialising in macro photography and will spend whatever it takes to ensure you have the right kit for the job. A dedicated macro lens is your priority. By allowing you to take close-ups from further away, it is possible to shoot any close-up subject, including timid insects. A dedicated macro flash is also on your list, together with a tripod head that will give you ultimate control and precision over composition and focusing.

1) **100mm macro lens (£400+)**: A sensible choice, giving a practical working distance, but short and light enough to use handheld when required. A lens with image stabilisation is beneficial for handheld work.

2) **Tripod & head (£100+)**: You want to be able to make small, precise adjustments to composition quickly, without any movement when you tighten controls. The geared design of the Manfrotto 410 is a popular choice.

3) **Macro flash (£200+)**: LED ringlights and adaptors are good makeshift options, but a dedicated macro flash is best. They give you the most functionality and allow you to take well-lit close-ups in any conditions. Check units from Sigma, Canon, Nikon and Metz.

4) **Right-angle finder (£40+)**: Unless your DSLR has a vari-angle screen, a right-angle finder is a great aid — when shooting at ground level, for example. Nikon and Canon both make right-angle finders but budget brands like Seagull are available, too.

---

**RING/MACRO FLASH**
When natural light isn’t enough, a dedicated macro ringflash is best for functionality and performance. It attaches to the front of the lens via an adaptor, producing a ring of light, enabling the flash to illuminate subjects in all directions. To prevent this type of light from being entirely shadowless and flat, most allow ratio control so that the light from one side of the ring can be stronger than the other. They can be difficult to diffuse, though, and tend to produce doughnut-shaped reflections on shiny surfaces.

**AUTO REVERSING RING**
Reversing rings allow a lens to be mounted back to front. Doing so generates a high level of extension, which enables the lens to focus much closer. The level of magnification achieved by reversing a lens is determined by focal length and the level of displacement, but can exceed twice life-size. Electronic lens mounts mean manual rings are far less popular, but there is a solution if you’re a Canon user: the Novoflex EOS-Retro Adapter (www.speedgraphic.co.uk) retains all the camera’s auto functions.
Essential skills you need to master for close-ups

Shooting strong macro images comes down to good in-camera technique and strong composition. Taking control of focusing, depth-of-field and lighting will help you get the best possible results.

**CONTROL YOUR FOCUSING**

In close-up, the point of sharpest focus appears more pronounced through the viewfinder. However, just because it is easier to see doesn’t mean it is easier to position! Honing a good focusing technique is essential for close-ups – even the smallest error can prove disastrous to the final shot.

Depth-of-field is inherently shallow at high magnifications, meaning your point of focus needs to be placed with pinpoint accuracy. You might think that the best option would be to use autofocus. In practice, though, AF is rarely the best choice as it can struggle to lock on to nearby objects – particularly in low light or if the subject is low contrast – so AF tends to ‘hunt’ or ‘search’ for focus.

It is normally easier, and a more precise method, to focus manually, so switch your camera to manual focus (MF). Doing so allows you to place an area of your subject on your chosen point – an insect’s eyes or the flower stamen, for example.

If you are shooting handheld, it can be useful to prefocus your lens and then move slowly forward towards the subject, with camera to your eye, until it looks sharp. If necessary, gently move back and forth, releasing the shutter when the subject is in sharpest focus. With the zone of sharpness being so narrow – maybe only a matter of millimetres – it is best to take a couple of frames to help ensure at least one bitingly sharp result.

You’ll find that a tripod is a great focusing aid – with the camera in a fixed position, it is far easier to focus. Better still, employ your camera’s LiveView facility in combination with a tripod – this is undoubtedly the best technique for close-ups. No other technique allows you to place your point of focus with such accuracy. Again, focusing manually is generally the best method.

**REFLECTORS**

Reflectors are circular disks with either a white, silver or gold side that can be positioned near to the subject in order to bounce light onto the subject. Small collapsible versions are produced by the likes of Interfit and Lastolite, but card covered in tin foil or a mirror can also do the job. They allow you to control the light and its direction, and ensure your subject isn’t in shadow. You can alter the light’s intensity by simply moving the reflector closer or further away. Unlike flash, you can see the effect of what you are doing instantly and adjust the reflector’s position accordingly. Reflectors are perfect for relieving dark, harsh shadows and for giving small subjects extra illumination in shady or overcast conditions. They are a must-have accessory for close-up photographers working outdoors.
Introduction to macro

**MAKE THE MOST OF AMBIENT LIGHT**

Light is a key ingredient to all photographs, but close-ups especially. The light’s colour, contrast and direction play an important role in enhancing or concealing the appearance of miniature detail. However, light can be in short supply when working in close proximity to your subject. When shooting close-ups, it is often impossible to avoid your body or camera physically blocking the light and casting your subject into shade due to your close shooting position. Also, quite a lot of light is naturally lost at higher magnifications – two stops at 1:1. Ideally, when working with natural light, choose scenarios where the subject is side- or back-lit. Side-lighting can suit close-ups, as it will enhance surface texture and detail and give your images a three-dimensional feel. Beware of strong side-lighting, though, as shadows can be too exaggerated, resulting in too much contrast.

Backlighting, where the light source is behind the subject, can create fantastic results and will highlight shape, form and intricate detail. It is particularly well-suited to translucent subjects, like butterfly wings and leaves. Backlighting can fool TTL-metering systems into underexposing results, though, so keep an eye on the histogram and apply positive exposure compensation if required. Attach a lens hood, too, to reduce flare.

Of course, side- or back-lighting may not always be possible or desirable. However, when the subject is lit from the front, it is often difficult not to obstruct the light’s path. In instances like this, you may need to give the natural light a helping hand by using flash or a reflector. One of the biggest advantages of working in close-up is that photographers have far more control over their subject, their surroundings and – crucially – lighting. If the natural light needs supplementing, it is easy to do so. While the quality of light is best during dawn and dusk, close-up photographers can capture good images any time of day as they are able to manipulate the light more. The easiest way is with a small reflector.

**The beauty of cloud cover**

As with most things artistic, there is no universal rule as to what constitutes the best light – much depends on your subject and creative intent. Photographers often obsess about light, but sometimes the best conditions are when it is dull. You don’t always need strong or dramatic directional light to capture great shots. Overhead clouds act as giant diffusers, creating flattering, low-contrast light that will enable photographers to capture fine, intricate detail and record colour with greater accuracy. In fact, there are times when the best option is to cast your subject into shade as this eliminates unwanted shadows and lowers image contrast. However, when shooting in overcast light, shutter speeds will be longer, meaning subject and camera movement is a greater concern. Therefore, either increase your camera’s ISO sensitivity to generate a workable fast shutter speed or only shoot static subjects when using a tripod.
TRIPOD CHOICE
When working with close-ups, depth-of-field gets progressively shallower. Also, the smallest movements seem greatly exaggerated at high magnifications. As a result, achieving correctly composed and focused close-ups can prove difficult if shooting handheld. Though it isn’t always practical to use a support, use a tripod whenever possible. While a monopod or beanbag can be suitable in certain situations, tripods offer an unrivalled level of stability. They virtually guarantee sharp, shake-free images and allow you to fine-tune your composition and place your point of focus—either through the viewfinder or via LiveView—with greater precision. Don’t opt for a cheap, flimsy model—buy good, sturdy legs. Close-up photographers require certain functionality in a tripod, like the ability to shoot at a low level. Look for a design that allows the legs to be spread low to the ground, particularly with a centre-column that can be split in half or tilted down to get the camera even lower. Giotto’s has a good range, or the popular Manfrotto 190 and 055 models with a horizontal centre-column option. Benbo’s unusual, innovative tripod design is also perfectly suited to close-ups. Budget at least £100 for good legs.

Next, consider head type. A three-way pan & tilt design is a good option, while many close-up photographers favour a ball & socket head as they offer quick, easy movement. Buy a model with an appropriate load capacity for your kit. For static subjects, a geared head, like Manfrotto’s 410 Junior head (above), is the perfect choice, allowing very fine, precise movements. Budget between £50 - £140 for a good head. The leg/head combination you prefer can be very subjective; the combination you opt for greatly depends on the way you prefer working and personal taste. Therefore, always try before you buy.

Creative close-ups
An abstract subject and an extremely shallow depth-of-field are all that’s needed for this beautifully simple image.

Q&A: The fundamentals
Q My camera has a Macro exposure mode. Is it worth me using it?
Most digital SLRs and CSCs have a number of scene modes, developed to bias settings according to a specific type of subject. Basically, they are variations of the fully automatic Program (P) setting. By selecting the camera’s Macro mode, it will attempt to select the best f/stop and shutter speed combination to shoot close-up subjects. The camera will prioritise a high f/number in order to create a large depth-of-field to render close-up subjects in focus, while still providing a fast enough shutter to eliminate camera shake. While auto picture modes may seem hassle-free, in reality they offer very limited creative control and your camera can’t predict the type of result you are after. Therefore, your best bet is to select aperture-priority mode, as this will allow you complete control over depth-of-field, and give you a much greater chance of getting the result you’re after.
Q Can I shoot close-ups in windy weather?
The smallest movement can seem hugely exaggerated in close-up, so wind can be a major obstacle. Check the weather forecast and shoot close-ups when the wind speed doesn’t exceed 10-14mph. However, this is the UK, so you can rarely rely on the weather! On windier days, select subjects growing in more sheltered areas, or position yourself – or a friend – to block the breeze with your body. Alternatively, erect a makeshift windbreak using clear polythene and garden canes. Another option is to use a clamp. A Wimberley Plamp is ideal. It is a flexible segmented arm with a clamp at both ends. Attach one end to a tripod leg, using the other to stabilise your subject.

Q Is it worth buying a right-angle finder?
A right-angle finder is an L-shaped attachment that fits to the camera’s eyepiece, allowing you to view and compose images by peering downwards, rather than horizontally, into the viewfinder. They are useful when shooting close-ups from low or awkward angles. If you regularly shoot at a low level, or suffer from back pain, then you’ll find it is a good investment. However, LiveView makes it easier to compose images from awkward angles, and if you own a model designed with a vari-angle LCD, you won’t need a right-angle finder.

Q Should I trigger the shutter remotely when shooting close-ups?
It largely depends on the situation, but if you are shooting a static subject, and the camera is on a tripod, then yes – doing so will maximise image sharpness. Using a tripod doesn’t completely guarantee sharp pictures; physically depressing the shutter button can generate a small amount of movement that may soften image quality, particularly at slow shutter speeds. Although the effect is fairly minimal, even the tiniest vibration appears greatly magnified in close-up, so this is of particular relevance to macro photographers.

It is good practice to always use a remote device or the camera’s self-timer facility, when practical to do so, as it will enable you to trigger the shutter remotely without touching the camera and risking movement.

Q When photographing shiny objects, how do I reduce reflections and hotspots?
While flash diffusers and reflectors can help, to eliminate highlights altogether you need to diffuse the light. Try a light tent by Lastolite or Kaiser, or create your own with translucent acrylic, tracing paper or a white sheet draped over a frame. Place your object within your tent, positioning your camera so the lens enters the tent through the open front. Position at least two lamps, or off-camera flash units, outside the tent, either side of it. If hotspots still exist, adjust the lamps’ positions. Also try shooting outdoors on an overcast day – cloud cover is a perfectly diffused natural light source. Polarising filters also reduce reflections.
Which exposure mode for macro photography?

There are many functions you need to master, none more important than your choice of exposure mode.

Close-up photography presents many challenges, so it's important that you have your camera set up correctly so that when presented with the ideal scenario for great pictures, you're ready to capture perfect results. With digital cameras boasting an incredible range of functions, it's easy to lose track of some of the settings, so it's important that before you start taking pictures, you ensure the camera's key features, such as autofocus, metering and White Balance are set up correctly. Doing so means that when you are ready to begin capturing stunning images, your camera is too.

Top of the list of functions you need to set correctly is the exposure mode. The basic job of an exposure mode is to ensure that just the right amount of light reaches the image sensor to record a 'correctly' exposed picture, using a suitable aperture and shutter speed combination. Most cameras offer the core four exposure modes: program, manual, aperture-priority and shutter-priority, plus a range of specialist program modes biased to specific subjects, such as sport, landscape, portraits and close-ups.

All the modes are designed to give the correct exposure, but where they differ is in how they influence the final result, the amount of control you have over the aperture and shutter speed selected, and also how quick and easy they are to use. With macro photography, as the relationship between apertures and depth-of-field is so important, you must choose a mode that allows you to determine the aperture being used. In most instances, your best bet will be to use aperture-priority mode, so that you choose the aperture setting leaving the camera to set the appropriate shutter speed.

More experienced photographers may want to try manual mode, which allows you to take full control of apertures and shutter speeds. This is particularly useful in tricky lighting situations such as backlighting, as changes to exposure can be made quickly. For most situations though, using aperture-priority mode is best.
The fundamentals of shooting great close-ups

Beginners are often put off trying close-up photography due to its specialist reputation. However, it isn’t as tricky as people think, and you’ll be pleased to know you can use kit you already own. This section will arm you with the know-how to begin taking great close-up images today.

**Reproduction ratio**

The ‘reproduction ratio’ is a way to describe the actual size of the subject in relation to the size it appears on the sensor – not the size to which the image is subsequently enlarged on screen or when printed. For example, if an object 40mm wide appears 10mm wide on the sensor, it has a reproduction ratio of 1:4 – or quarter life-size. If that object appears 20mm in size, it has a ratio of 1:2 – or half life-size. If it appears the same size on the sensor as it is in reality, it is described as having a reproduction ratio of 1:1 – or life-size. This can also be expressed as a magnification factor, with 1x equating to 1:1 life-size. A lens will have its reproduction ratio listed among its specification. Some standard and telezooms include the word ‘macro’ in their title. However, it is worth noting that this is simply an indication that it has a closer minimum focusing distance than normal. In reality, they can’t be classified as a true macro lens, but they often boast a handy reproduction ratio of 1.3 or 1.4.

<table>
<thead>
<tr>
<th>Eighth life-size</th>
<th>Quarter life-size</th>
<th>Half life-size</th>
<th>Life-size</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Eighth life-size" /></td>
<td><img src="image2.png" alt="Quarter life-size" /></td>
<td><img src="image3.png" alt="Half life-size" /></td>
<td><img src="image4.png" alt="Life-size" /></td>
</tr>
</tbody>
</table>

**Sensor cropping**

You are probably aware that the vast majority of digital SLRs have a cropped-type image sensor, most commonly APS-C or Micro Four-Thirds, meaning that they are smaller than the traditional 35mm film frame. This narrows the field-of-view and effectively multiplies the focal length of the lens, although the actual focal length doesn’t change. The degree of multiplication depends on the size of the sensor, but with a crop-factor of 1.5x, for example, a 100mm lens effectively becomes 150mm. This can be a disadvantage in some areas of photography, such as landscapes, as wide-angle lenses lose their characteristic effects. However, for close-ups it is hugely beneficial in two ways. Firstly, the narrower angle-of-view can be used to provide a larger working distance from the subject as you can shoot from further away while maintaining the same level of magnification that would be achieved with a full-frame sensor – useful if you’re shooting wildlife that is easily disturbed. Also, you will block less light from reaching the subject. Alternatively, a DSLR with an APS-C sensor can be used to increase the subject’s size within the frame. This is because the sensor crop doesn’t alter the minimum focusing distance, so its reproduction ratio is effectively extended.

<table>
<thead>
<tr>
<th>Full-frame</th>
<th>Cropped</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Full-frame" /></td>
<td><img src="image6.png" alt="Cropped" /></td>
</tr>
</tbody>
</table>

**Depth-of-field**

One difficulty of close-up photography is working with a very limited depth-of-field. The zone of sharpness that exists in front of and behind the point of focus – for any given f/stop – grows progressively shallower as the magnification increases. For example, when photographing a flower, its stamens may be pin-sharp, but the petals in front and behind may be out of focus. Moving further away from the subject creates more depth-of-field, but this rather defeats the object. Instead, the solution is to use a smaller aperture (higher f/number), as this widens depth-of-field. As a result, the light reaching the sensor will be reduced so, to compensate, the shutter speed has to be lengthened in order to maintain the correct exposure. Unfortunately, a slower shutter speed raises the chances of camera shake. If the subject is static, the problem is easily remedied by using a tripod to support the camera. However, if the subject is moving or is wind-blown, the resulting shutter speed may not be fast enough to freeze movement in your shots. When you’re confronted with situations like this, select a faster ISO rating or consider using a burst of flash. A good understanding of depth-of-field is important when shooting close-ups. The degree of back-to-front sharpness can greatly alter the appearance of the final image. Contrary to popular belief, lots of depth-of-field is not always desirable with close-ups, as it can bring distracting foreground and background elements into focus. Many photographers purposely opt for a shallow depth-of-field to isolate their subject and direct the viewer’s eye to their chosen point of focus.
Lighting for close-ups

Natural light can be restricted when shooting close-ups. Often this is due to the minimal camera-to-subject distance and the photographer, camera or both casting a shadow across small subjects. This can be tricky to avoid, especially when using close-up attachments as the lens may be only be centimetres away from the subject. Sometimes the problem can be solved by simply altering the shooting position or by using a longer focal length to increase the distance between the camera and subject. However, if this isn’t possible you may need to supplement the available light. For the most natural-looking results, reflect light back onto the subject using a reflector. The intensity of light can be altered by moving the reflector closer or further away, and by adjusting the angle. Compact, collapsible reflectors are cheap and an ideal accessory to keep in your kit bag. Alternatively, a piece of white card or tin foil can be used. If a reflector doesn’t work, try using flash. However, flash from a hotshoe-mounted flashgun may well miss (or only partially illuminate) the subject, either passing overhead or being obstructed by the lens barrel. Therefore, position your flashgun off-camera, using an off-camera flash cord.

When you’re making your first steps into close-up photography, we’d recommend you experiment with window light to begin with as it’s relatively easy to work with.

 IMAGE: PETER ADAMS

TOP TIP

DEPTH-OF-FIELD PREVIEW

If your DSLR has a depth-of-field preview button, use it. It stops down the lens to the current aperture setting, so you can preview what will and what won’t be in focus through the viewfinder. Works well with LiveView, too.
Apertures and close-ups

Your point of focus can make a good close-up shot brilliant. Here are the pros’ secrets to achieving amazing macro results...

AS YOU’VE ALREADY discovered, the wider the aperture (low f/number), the narrower depth-of-field becomes. However, this effect is exaggerated further when shooting close-ups, as it also grows progressively shallower at higher magnifications. The zone of sharpness can be wafer-thin at reproduction ratios of 1:1 (life-size), so in order to capture pin-sharp close-ups using wide apertures, your focusing and technique must be precise.

With depth-of-field being so limited at wider apertures, you might assume that a smaller f/number would be better to generate a larger zone of sharpness. Doing so, though, can sometimes bring distracting foreground and background details into focus, creating messy backdrops that draw the eye away from your subject. Selecting a higher f/number will also result in a much slower corresponding shutter speed, which can be impractical when working handheld or if you’re photographing moving subjects, like insects or flowers that are blowing in the wind.

Practical considerations aside, there are also many aesthetic advantages to employing a wide aperture when shooting close-ups. It will help you throw the subject’s surroundings beautifully out of focus, creating a diffused wash of colour that will help your subject stand out boldly — a technique known as differential focusing. For example, when photographing insects or wildflowers, an aperture in the region of f/4 or f/5.6 will ensure only the subject itself is sharp and that the background is clutter-free without the need to ‘garden’ surrounding vegetation or alter viewpoint. In order to maximise the available depth-of-field, at any given aperture, try to keep your camera’s sensor plane parallel to the subject. This is because there is only one geometrical plane of complete sharpness, so you want to place as much of your subject within this plane as possible to maximise depth-of-field.

Whether you’re photographing wildlife, plant life or still-lifes, selecting a large aperture can prove a highly useful creative tool when using a macro lens or close-up attachment, emphasising your point of focus. Virtually everything in front of and behind your point of focus will drift progressively out of focus, offering all kinds of creative potential. For example, you may want to place your point of focus on a flower’s petals or stamens while allowing the rest of the flower to drift attractively out of focus. The trick is to achieve just enough depth-of-field to ensure your background subject is nicely diffused but remains recognisable. If your camera has a depth-of-field preview button, use it to view the effect and stop the f/number up or down if less or more depth-of-field is required, respectively. This type of selective focusing can create striking, artistic results and convey far more about the subject’s size, beauty and design than had it been sharp all over.

A wide aperture allows close-up photographers to be far more creative with focusing, but it’s not all good news. The shallow depth-of-field created by using a low f/number means focusing has to be pinpoint accurate. With the zone of sharpness potentially just a matter of millimetres, achieving sharp results handheld isn’t easy. Whenever possible, use a tripod. This will allow you to place your point of focus with far greater accuracy. In situations where using a tripod isn’t practical, take a larger sequence of shots to ensure at least one is correctly focused. Manual focus is best as AF can struggle to lock on to close-up subjects. Better still, use LiveView and zoom into the area of interest before carefully fine-tuning your focus accordingly.

Pro tip: Ross Hoddinott

“When shooting close-ups, depth-of-field is often very shallow due to the high level of magnification. As a result, the general perception is that a high f/number should be used. I disagree: I rarely employ high f/numbers when shooting wildflowers and insects. First, that would result in a slower shutter speed, which is often undesirable when shooting wildlife in natural light. Second, doing so can bring too much distracting background detail into focus, creating messy backdrops. I often use wider apertures in the region of f/2.8 to f/8. Such a narrow depth-of-field helps my subject stand out boldly against its backdrop. Results can look striking, but focusing does have to be pinpoint accurate. To ensure you keep the subject acceptably sharp throughout, position your camera parallel to the subject to maximise depth-of-field. Also, if possible, focus manually using LiveView to allow you to zoom in and place your point of focus precisely. A shallow depth-of-field can certainly prove a powerful aesthetic tool for close-ups.”

ALTERING DEPTH-OF-FIELD

Anyone can capture a sharp image, it is where you put the blur that really matters! This picture sequence of a banded demoiselle was taken using the same viewpoint and point of focus – it is only the level of depth-of-field that has been altered. The sequence here shows how background detail becomes more noticeable and distracting in the images taken using a smaller aperture. A wide aperture will help you isolate your subject, emphasising its shape and form, but position your point of focus with great care.
Close encounter!
Where you position your point of focus can have a dramatic effect on the impact of your images.
Creative use of light

How and when to use natural light or flashguns can make a big difference to your close-ups.

Natural light

Dull or bright, you can always shoot close-ups. However, the quality of natural light is at its best in the mornings and evenings. At these times the colour temperature is warmer and more flattering, and the sun is lower in the sky, casting longer shadows that help accentuate shape and form. Strong overhead midday sunlight is normally quite harsh and best avoided. However, at this time of year, the sun doesn’t climb so high in the sky, so it is possible to take good close-ups throughout the day. One of the biggest problems, when shooting close-ups in sunny weather, is preventing your shadow from creeping into the frame. At high magnifications of 1:2 or greater, your camera will be positioned just a short distance away from your subject if using close-up filters or an extension tube. Care needs to be taken to ensure your shadow isn’t a problem and you may have to alter your shooting position, or the level of magnification, to compensate, which can be frustrating. This is where a dedicated macro lens is advantageous, providing a larger working distance and solving the problem. Slight side lighting works best, casting shadows to one side and giving your close-ups added depth. Be aware, though, that strong side lighting may emphasise shadows too much and increase contrast. In situations like this, bounce light back onto the subject using a reflector. Bright, overcast light is often the best light for close-ups. A thin layer of cloud acts like a big diffuser, softening strong sunlight and contrast. This form of light is especially well suited to photographing plants and foliage. The surface glare from vegetation is greatly reduced, so colours appear more saturated.

Built-in flash & flashguns

Light is often limited when working in close-up. The miniature objects you wish to photograph will sometimes be cast into shade by their surroundings – or even the camera itself. For this reason, macro photographers often need to supplement the available light with flash. Practically every DSLR and many CSCs have a built-in flash and while they might not be useful for distant subjects, this isn’t an issue when shooting close-ups.

Integral flash is especially useful when you simply need a small burst of fill-in flash to lift harsh, ugly shadows. However, their usefulness is restricted by their fixed position and, typically, they are only effective at a reproduction ratio no greater than 1:4 (quarter life-size) – if the subject is any closer, the flash burst will pass over the top. Whilst they shouldn’t be overlooked, a built-in flash is no substitute for a dedicated flashgun, which can be fired off-camera, bounced and diffused for greater creative control.

There is a vast array of sophisticated flashguns available. Although they can be attached directly to your camera’s hotshoe, this will normally produce quite flat, uninteresting light. It is possible to simulate a more natural or interesting angle of light by positioning the flash off-camera. You can even position the flashgun below, overhead or behind the subject if you wish, creating dramatic or surreal effects. One drawback of using a single flash unit is that it can create quite harsh, hard shadows. Although a second unit can be positioned, and programmed to fire a weaker burst to help relieve shade, most budgets won’t stretch to two units. However, working in close-up means it is far easier to manipulate and redirect light. By just placing a reflector – or sheet of white card – opposite the flash, it is possible to bounce light back onto the subject, lifting ugly shadows. One more thing… with the flash in such close proximity to the subject, the use of a diffuser is important to soften the intensity of the burst.
The beauty of backlighting

Backlit subjects can look stunning in close-up. This form of illumination relies on the main light source being positioned behind the subject. Used correctly, backlighting will emphasise your subject’s shape and form, highlighting fine, intricate detail. It is especially well suited to translucent subjects, like plastic, foliage or an insect’s wings.

Whilst you can create the effect of backlighting indoors – using a lightbox, lamp or off-camera flashgun – you really can’t beat natural light for close-ups. Mornings and evenings are ideal as the sun needs to be relatively low in the sky. You need to carefully align your set-up, so the light illuminates your subject from behind. Take care, though, by shooting towards the light, there is an enhanced risk of lens flare, a result of unwanted sunlight entering your lens. A lens hood will help; alternatively try shading the lens using your hand.

One more thing to consider before you rush outside with your camera: by shooting in the light’s direction, there is a greater likelihood of your camera’s multi-zone metering being fooled, resulting in erratic exposures. Therefore, simply bracket your exposure or take a spot meter reading from a suitable area of the subject, then check it on the LCD monitor.

Your subject will be transformed with backlighting. Despite being taken moments apart, these two images are totally different: the backlit shot has far greater impact.

Lighting accessories

- **RINGFLASH**: A ringflash is designed with a circular flash tube that attaches directly to the front of the lens via its filter thread. They are compact, portable and designed specifically for lighting objects close-up. However, due to the way they illuminate the subject from every direction, a ringflash produces very even, shadowless light, which won’t satisfy creative photographers. This can be easily remedied by masking parts of the ring using black tape.

- **TWIN FLASH**: Twin flash units work using a similar principal to ringflash. The unit is designed with twin miniature flash units. They are adjustable and can be rotated vertically and horizontally, either side of the rotating mounting ring. They can even be removed from the ring and handheld or positioned on, say, a tripod leg. This versatility enables them to deal with the trickiest close-up lighting conditions. They are expensive but brilliant.

- **FLASH BRACKET**: By positioning a flash unit off camera, it is possible to reduce or exaggerate shade creatively. A specific flash bracket or arm will give you added control over the direction and effect of your flash burst. Although quite specialised, flash arms designed for macro photography are produced by the likes of Wimberley and Manfrotto. Designs and flexibility vary depending on the make and model. Typically, they have two adjustable arms – or rods – extending from the base plate, enabling the flash units attached to be positioned at any angle required.
Understanding macro kit

Macro photography gives you the chance to capture a world too small to see with the naked eye. While you need dedicated kit, Ross Hoddinott reveals the best macro lenses and the more cost-effective alternatives.

TAKE A QUICK GLANCE around you. Indoors or out, you are surrounded by objects that suit being shot “up close and personal”. Bugs, flowers, foliage, textures, machinery: the list of potential subjects is endless. By picking out subjects for a closer inspection, you begin to see potential that you would probably ignore or normally overlook. Through a macro lens or close-up attachment, colour, texture and intricate detail is revealed or highlighted.

Once you’ve caught the ‘macro bug’, you’ll begin seeing everyday, mundane objects in a completely different light. Suddenly, a rusty old chain or peeling paintwork presents an opportunity to capture a timeless still-life or an arty abstract.

It is no surprise that the popularity of close-up photography is growing by the day – and it’s never been more accessible or affordable. One of the most appealing things about close-up photography is that you don’t need to spend a fortune on specialist kit – a £10 set of close-up filters bought on eBay will get you started. This was exactly how my love affair with shooting all things miniature began. By simply attaching a close-up filter, I was able to enter the realms of the miniature world around me and countless new photo opportunities followed.

Close-up photography is regarded by many as a specialist and technically challenging niche. Limited light and wafer-thin depth-of-field are synonymous with shooting at high magnifications, but don’t let this put you off. The available light can easily be supplemented by using reflectors or flash, while shallow depth-of-field can be used for creative effect.

Still not convinced? Don’t take my word for it, give it a try for yourself. For the same cost as a new DVD or CD, you can get yourself started at some inexpensive close-up filters – hardly a big gamble. If you find close-up photography isn’t for you, at worst you’ll have wasted a few quid. However, more likely than not you will love all the new opportunities available to you to capture great, interesting images. This guide will ensure you have all the knowledge you need to get you started. So what is stopping you?

**Main types of close-up kit**

<table>
<thead>
<tr>
<th>Macro lens page 24:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A dedicated lens that is optimised for close focusing. Most offer a reproduction ratio of 1:1 (life-size).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Close-up filters page 26:</th>
</tr>
</thead>
<tbody>
<tr>
<td>These attach to the lens like any screw-in filter, but act like a magnifying glass, reducing the lens’s minimum focusing distance. They are available in different strengths and filter threads.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Extension tubes page 28:</th>
</tr>
</thead>
<tbody>
<tr>
<td>These are hollow tubes without optical elements that fit between camera and lens. They allow for closer focusing, thereby increasing the lens’s maximum magnification. Short focal lengths give most magnification.</td>
</tr>
</tbody>
</table>

**Close-up accessories**

- **Wimberley Plamp**: The Plamp basically works like a helping hand. It is a ball-and-socket segmented arm with clamps at either end. One end attaches to a tripod leg; the other can hold a reflector or subject in place.

- **Reflector**: Light is often limited when shooting in close proximity to a subject. Using a small, foldaway reflector, it is possible to bounce light onto the subject. The light’s intensity can be altered by moving it closer or further away.

- **Ringflash**: A flash dedicated to close-up photography. It surrounds the barrel of the lens, enabling it to illuminate subjects close by.

**Practical tips for better close-ups**

- **Camera shake**: Shake is a major concern. It occurs when shooting handheld with a shutter speed that is too slow to eliminate camera movement. It is common with close-ups, as the slightest movement can appear exaggerated at high magnifications. The easiest way to avoid it is to use a support like a tripod or beanbag. However, if this is not practical, set a fast shutter speed: typically, a speed of 1/125 sec, or faster, will guarantee sharp images. If necessary, increase ISO to raise the shutter speed. Several macro lenses now boast image stabilisers, which allow sharp images to be produced at speeds two or three stops slower than one without.

- **Depth-of-field**: This is the zone in front of and behind the point of focus that is acceptably sharp. It is determined primarily by the lens aperture, but it is also influenced by the focal length of the lens and also the camera-to-subject distance. Close-up photography is synonymous with a very shallow depth-of-field, and at high magnification can be wafer-thin. In general photography, a small aperture of f/16 or f/22 usually gives front-to-back sharpness, but when shooting close-ups, achieving sufficient depth-of-field can be difficult. Your focusing will need to be pin-point accurate. While working with such a shallow depth-of-field can be challenging, it can also be used creatively, allowing you to isolate the subject against an attractively diffused background, or place emphasis on their point of focus. It is also possible to increase the amount of depth-of-field falling in front and behind the point of focus by roughly equal.

- **Working distance**: This is the distance between subject and lens. Close-up photographers have to work very close to their subject in order to achieve frame-filling results – particularly if using close-up filters or a reversing ring. It is an important consideration if you are photographing wildlife, as there is a greater chance of frightening the subject away if you get too close. You are also likely to block natural light from reaching the subject if positioned very close to the subject. Therefore, larger working distances are normally preferable. For this reason, longer focal length macros of 100mm or more are the best choice.
Close-up lenses in detail

A dedicated lens is the easiest (but also the most expensive) option for macro photography. Here’s how to choose and use one...

A MACRO LENS IS A specialist optic optimised for close focusing, allowing it to focus far closer than a conventional lens. Thanks to its highly corrected optics, it offers high image quality and performs best at high magnifications. Macros don’t require any supplementary attachments in order to achieve a truly macro – reproduction ratio of 1:1 (life-size). This is when the subject is projected on to the imaging sensor the same size as it is in reality.

The vast majority of macro lenses are produced in prime, fixed focal lengths, ranging from 40mm up to 200mm. Shorter focal lengths tend to be compact and lightweight, making them portable and easy to use handheld; while ‘tele’ macros provide a larger camera-to-subject distance. They are also fast: normally having a maximum aperture of f/2.8 or faster.

Such a large aperture not only helps provide a lovely bright viewfinder image – aiding pin-point focusing and composition in poor light – but the narrow depth-of-field produced at the lens’s maximum aperture is ideally suited to capturing close-up images with beautifully diffused backgrounds.

A macro lens is well-suited to any close-up subject, but they are particularly popular among nature photographers, providing a more practical working distance from the subject compared to other close-up attachments. By doing so, it helps maximise the chances of success when shooting wildlife that are easily frightened away.

Being a specialist lens type, macros are generally not cheap, costing between £300 to £1,000 – depending on the brand, focal length and features. However, for the dedicated close-up enthusiast, a macro lens is a very worthwhile investment. It is also worth noting that macros are suitable for general photography, too, being particularly popular for shooting flattering portraits and still-lifes.

Using a macro lens

The margins for error in macro photography are small, meaning that you need to concentrate more on focusing, stability and depth-of-field. Focusing is particularly important. Depth-of-field is often limited, even at small f/stops. Macro lenses are renowned for their sharpness, but at high magnifications, your subject will be recorded soft if your focusing is out by even a millimetre or two. It really can be that critical.

Therefore, it is usually best to switch your macro lens to manual focus, rather than rely on AF. Doing so allows you to place the point of focus with even greater accuracy, and prevents your camera searching for focus – something AF can do when trying to focus on fine, small close-up detail. When practical, LiveView focusing can help ensure razor-sharp results, as you can magnify your desired point of focus for precise, critical focusing. The smallest camera movement looks exaggerated in close-up and it is easy to overestimate how still you can hold your camera. While using longer, heavier macros is great for providing a larger working distance, they are naturally more difficult to keep still. A tripod solves the problem, but if it is impractical to use one, select a fast shutter speed that will eliminate shake. When using short macro lenses (eg a 50mm or 70mm), you will regularly find yourself working close to the subject, meaning you often can’t avoid your body or camera casting the subject in shade. Reflectors or ringflash will alleviate the problem. Depth-of-field is limited using macros, but use this to your advantage. Shallow focus can help direct the eye to your desired focal point. Remember: you don’t have to record the entire subject in sharp focus. Using a macro’s fast maximum aperture creates an extremely shallow focus that is perfect for capturing images where the subject, or part of it, stands out against its surroundings.

Choosing the right macro lens

Macro lenses can be split into two categories: short and telephoto. The main advantage of short focal lengths, in the region of 50mm to 70mm, apart from being slightly cheaper, is that they are compact and lightweight, making them perfectly suited to being used handheld. They are well-suited to shooting static subjects, like flowers and still-lifes.

The main drawback is that the working distance is shorter. Macros with a focal length of 70mm or more are considered to be telephoto, with lengths of 100mm, 150mm or 180mm being popular for the larger working distances they provide. On the downside, more powerful macros are longer and heavier, making it trickier to capture correctly focused, shake-free images without the aid of a support. However, if you intend shooting mostly natural history, a ‘tele’ macro is the best choice. Another consideration is image stabilisation. Although more costly, if your budget allows, opt for a macro with a stabiliser as it offers several stops benefit. A macro boasting internal focusing is also preferable, meaning its physical length doesn’t increase when focus is adjusted.

KEY FEATURES TO LOOK OUT FOR

1. Focus limiter switch: Allows you to restrict the amount of the full focus range that the autofocus system will use. This is designed to speed up autofocus and stop the lens 'hunting' for correct focus.

2. Manual focus ring: You may need to be prepared to regularly use manual focus to achieve critical focus, so a wide manual focus ring with a smooth, firm action is important.

3. Tripod mount: Longer focal lengths feature a detachable tripod mount that helps with stability.
Macro lenses: A selection of some of the best macro lenses available

- **Canon EF 100mm f/2.8L Macro IS USM**
  - Boasts a stabiliser and delivers incredibly sharp results.

- **NIKKOR AF-S 60mm f/2.8G ED Micro**
  - Compact and light.
  - Quiet and fast AF.
  - Has a minimum aperture of f/45.
  - Ideal for APS-C DSLRs.

- **Sigma 50mm f/2.8 EX DG**
  - A popular choice with enthusiasts and pros.
  - Sports a stabiliser.

- **Sigma 150mm f/2.8 EX DG OS HSM**
  - Fast f/2 aperture delivers high-quality results with APS-C cameras.

- **Tamron 60mm f/2 DI II**
  - Fast f/2 aperture delivers high-quality results with APS-C cameras.

- **Tamron 90mm f/2.8 SP Di USD VC Macro**
  - A classic lens that offers excellent optics and great handling.
Close-up filters

For beginners, this is the most affordable and simplest way to try out close-up photography

THE EASIEST, MOST affordable entry route to shooting miniature subjects is by using close-up filters — or supplementary close-up lenses as they are technically known (because they don’t filter anything). These are circular, screw-in type filters that act like reading glasses for your camera, reducing the lens’s minimum focusing distance. By doing so, they are able to transform a normal lens into one with a better close-focusing ability. They are lightweight and don’t affect the camera’s automatic functions (like metering and autofocus) or reduce the amount of light entering the lens. They couldn’t be easier to use, either — simply screw one onto the front of your lens and you are ready to shoot close-ups. Costing as little as £10 for a set of three strengths of magnification (measured in dioptres: a unit you might be familiar with from visits to an optician), they are perfectly suited to beginners and also any photographers on a budget. Most major filter brands have close-up filters in their range, so there is no shortage of choice. They work by shifting the camera’s plane of focus from infinity to the distance corresponding to the focal length of the close-up lens attached. They are convex meniscus-type lenses — thicker in the middle than at the edges — and most close-up filters are a single element construction. They are available in a range of strengths, typically +1, +2, +3 and +4. The higher the number, the greater their magnification. Powerful +10 versions are also available. They can be purchased singly or as a set and, generally speaking, are best used with short telephoto lengths, in the region of 50mm to 135mm. However, they also work well with zooms, too. They are suitable for all types of subjects, from still-lifes to nature. However, they don’t provide a large working distance, so be prepared to have to get very close to your subject to capture frame-filling shots.

The pros & cons...

- Easy to use
- Inexpensive
- No reduction in light
- Retains camera’s auto functions
- Lightweight and portable
- Not the best image quality
- Results can suffer from spherical and chromatic aberration
- Short working distance

Helpful hints

1) Close-up filters are available in different filter threads, with the most common sizes being 49mm, 52mm, 58mm and 67mm. Remember to check the size you need before buying.
2) Instead of buying several dioptres of different sizes to fit the different diameter lenses in your system, consider ‘buying big’ and using ‘step-up’ rings so that one filter will fit all. Step-up rings are designed to adapt a filter to a lens when the two have different diameters: both saving money and conserving vital space in your camera bag.
3) For best image quality, use lens apertures of f/5.6 and above. This reduces aberrations inherent to such simple optics and also increases depth-of-field usefully, though will make shutter speeds longer, so be wary of camera shake!

Using close-up filters

Close-up filters couldn’t be simpler to use: screw one on to the filter thread of your camera’s lens and it reduces its minimum focusing distance. However, it is useful to be able to calculate the level of magnification achieved by any given lens and close-up filter combination. To do this, you’ll need to be prepared to do a little arithmetic — so if maths wasn’t your strong point at school, now’s the time to reach for your calculator.

First, establish what the dioptre’s equivalent value is in millimetres. To do this, divide 1,000 by the strength of the dioptre. For example, to calculate the value of a +4 dioptre: 1,000 / 4 = 250mm. Next, divide the focal length of the lens in millimetres by the equivalent focal length of the filter. So, for instance, if you were to attach a +4 dioptre to a 50mm prime lens, this would achieve a magnification of 50 / 250 = 0.2x — approximately 1.5. So, the equation you need to remember is: magnification = focal length of lens / focal length of dioptre. However, this calculation only reveals the magnification of the lens when it is focused on infinity: even greater levels of magnification are possible when the lens is set to a shorter focusing distance.

It’s possible to combine close-up filters to achieve even higher levels of magnification — for example, coupling a +1 and +2 filter together achieves a level of magnification equivalent to a +3 dioptre. However, if you do this, always attach the most powerful first and the weakest last, as this maximises image quality. Avoid coupling three or more close-up filters together, as this will significantly degrade image quality and exaggerate any optical flaws.

While there are many advantages to using close-up filters, they cannot compete with the image quality of other close-up attachments — which is hardly surprising, considering their low price tag and basic construction. Edge sharpness in particular can suffer, and they are prone to ghosting and spherical and chromatic aberration.

However, you can maximise image quality by selecting an aperture of f/5.6 or higher, and only combining them with the best quality optics — for example, prime, fixed focal lengths. Opting for higher quality filters, with two elements (doublet construction) is another option. However, expect to pay around £50 or more for one.
Close-up filters may not match a macro lens for sharpness, often noticeable around the edges, but they’re a brilliant budget introduction to close-ups.
Extension tubes

Find out why extension tubes are an excellent option capable of brilliant close-ups for budget-conscious photographers.

If you cannot justify buying a dedicated macro lens, but don't want to compromise image quality by using close-up filters, consider investing in a set of auto extension tubes. These tubes fit between the camera and lens in order to extend the lens further away from the sensor plane. By doing so, they reduce the lens's minimum focusing distance, allowing you to focus closer and achieve a greater level of magnification. They are available in different camera mount fittings and, as they are constructed without any optical elements, image quality is good. However, they do reduce the amount of light entering the camera: the higher the magnification, the more light lost. Your camera’s TTL metering will automatically compensate for this reduction, but shutter speeds will lengthen as a result of using one: an important consideration if you intend shooting handheld.

Auto extension tubes are compact, light and, combined with a good quality lens, are capable of producing excellent results, comparable to that of a macro lens. They can be bought individually or in sets. Most are 12/20/36mm including Kenko’s (right): the longer the tube, the larger the reproduction ratio. They can also be used together to generate higher levels of magnification, equal to or exceeding 1:1 (life-size). They are a very versatile and useful close-up attachment.

Non-automatic versions are available and are typically quite cheap to buy. However, they disable many of the camera’s key automatic functions, like metering and focusing, so you need to take more care when using them. Auto extension tubes cost around £100 or more, but you can find some budget brands online for as little as £50, and retain all the metering and focusing connections, making them convenient and simple to use. Their biggest restriction is that, like close-up filters, working distances tend to be short, making it difficult to position additional light sources and increasing the risk of frightening away live subjects. However, they are well-suited to most close-up subjects and are a useful attachment to have in your camera bag, being handy for reducing the minimum focusing distance of longer lenses, too.

**The pros & cons...**

- With no optical elements, good image quality is maintained
- Light and easy to carry
- Affordable
- Simple to use
- Useful for reducing the minimum focusing distance of longer lenses
- The greater the magnification, the more light is reduced entering the camera
- Short working distance
- Non-automatic versions disable camera functions, like metering and autofocus
- More fiddly than macro lenses

---

**Extension tubes: Frequently asked questions**

**Q** What are the best lenses to use with auto extension tubes?

If you want images with a high magnification, extension tubes are best combined with short focal lengths — a lens in the region of 35mm to 100mm is ideal. Small amounts of extension, like 12mm, are most effective coupled with short focal lengths, like 35mm or 50mm. The amount of extension you require will greatly depend on the size of the subject and the level of magnification desired. While extension tubes can be useful with any focal length in order to reduce its minimum focusing distance, achieving high reproduction ratios using focal lengths exceeding 100mm is usually impractical: the amount of extension required is too great, resulting in too much light being lost.

**Q** How do I attach auto extension tubes to my camera?

Attaching and using auto extension tubes couldn’t be easier. With the camera switched off, remove the body cap. Next, attach the extension tube as you would a lens: aligning the indicators marked on the tube and camera mount, and then rotating it (in the correct orientation) until the tube clicks into position. Next, attach the lens, aligning the indicators on the tube and lens, and then rotating the lens until it clicks into position. Auto extension tubes are constructed with contacts to enable automatic metering and focusing. Therefore, when you switch the camera on, the camera and lens will function normally and you are ready to begin.

**Magnification**

The magnification achieved using extension tubes varies depending on the length of the tube and focal length of the lens. However, approximating the reproduction ratio of any given tube and lens combination is fairly simple: divide the amount of extension by the focal length of the lens. For example, if you combine a 25mm extension tube with a 50mm lens, the magnification is 25/50 = 0.5x or 1:2 (half-life-size). Using the same level of extension with a 100mm lens would result in a reproduction ratio of 1:4 (quarter life-size). If you want to achieve a level of magnification equal to 1:1 (life-size), you need to employ a level of extension equal to that of the focal length of the lens — for example, 50mm of extension with a 50mm lens. See the quick reference chart (right) for the level of magnification achieved using...
An eye for detail

Combine an extension tube with a short focal length lens and you can capture stunning close-up images like this.

### Extension tubes with popular focal lengths.

As you can see, the shorter the focal length, the greater the magnification.

**COMPARISON SET (RIGHT):** This set of images shows the major difference in magnification using 12mm, 25mm and 36mm auto extension tubes when combined with a standard 50mm lens.

<table>
<thead>
<tr>
<th>Extension</th>
<th>35mm</th>
<th>50mm</th>
<th>100mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>12mm</td>
<td>0.34x</td>
<td>0.24x</td>
<td>0.12x</td>
</tr>
<tr>
<td></td>
<td>(1.29)</td>
<td>(1.41)</td>
<td>(1.83)</td>
</tr>
<tr>
<td>25mm</td>
<td>0.71x</td>
<td>0.5x</td>
<td>0.25x</td>
</tr>
<tr>
<td></td>
<td>(1.4)</td>
<td>(1.2)</td>
<td>(1.4)</td>
</tr>
<tr>
<td>36mm</td>
<td>1.03x</td>
<td>0.72x</td>
<td>0.36x</td>
</tr>
<tr>
<td></td>
<td>(1.097)</td>
<td>(1.13)</td>
<td>(1.27)</td>
</tr>
</tbody>
</table>
Still-Lifes

Let your creativity run wild as you discover the beauty of the inanimate object as we take you through a masterclass that explores the experimental and diverse world of still-life photography. Learn the basics of composition, focusing and exposure and try the creative ideas and lighting techniques used by the professionals.

It’s the one area of photography that allows you to try a range of creative techniques at your own pace; yet despite offering an infinite variety of subjects to shoot in countless ways, it is one that is often overlooked by many close-up photographers. Still-life photography, as its name suggests, is the art of photographing inanimate objects, whether in the place you find them in or a prepared arrangement. As still-life subjects are static, you’re able to experiment with different aspects of creative picture-taking such as composition, lighting and backdrops, while developing your general shooting skills. Our masterclass covers all the essential elements that you’ll need to begin shooting your own high-quality still-life images. We’ll also advise you as to which lenses and accessories are best for the task, the basics of composition, lighting and subject matter, and share some creative ideas to try while you gain confidence in your abilities.

IMAGE: LEE FROST
A general introduction to shooting still-lifes

One of the great things about still-life photography is that regardless of the time of day or the weather, you always have the opportunity to give it a try. Here we cover the basics of what you need to get started.

AVID STILL-LIFE PHOTOGRAPHERS can spot photographic possibilities quite literally everywhere they look; so if you start to seek them out, you'll probably find that you will also start spotting them in no time at all too! From simple household objects, such as vases, bottles or toys, to items in the garden or shed (such as plant pots, flowers, or even garden equipment like a shovel or pair of shears), with some careful thought about composition, lighting and effect (eg mono or colour etc.), great still-life shots should be relatively easy to produce. Many photographers are put off trying out still-lifes for two main reasons: it sounds boring, and it's seen by many as being overly-technical. The reality in both cases is quite the opposite. Sure, shooting a flower or a bottle isn't as glamorous as... well, shooting glamour, or the awe-inspiring moments presented to a landscape photographer at sunset, but there is something very satisfying and rewarding when you've set up and photographed your own still-life and produced a great image, so give it a try.

- CHOOSING A STILL-LIFE CLOSE-UP THEME

Before you start, it's worth looking through books, magazines, and on the internet, studying the various kinds of still-life close-ups that exist. As you'll discover, there is an infinite number, so think about the type of still-life you want to shoot and what you'll need to do it. Are you going for a bright, powerful image with colour impact, or a more subtle effect with softer lighting and muted colours? Or, you may want to shoot an abstract, apply some heavy post-production work, or keep everything natural and shoot 'found' still-lifes (in other words, subjects as you find them, in situ). Much like an artist with a blank canvas, you have total control over each element within the frame and it's up to you to conceive the final result. As you can see, the options are extensive, so there are plenty of creative possibilities open to you - the hardest part is deciding what to shoot first and how!

- THE BASIC PRINCIPLES TO STILL-LIFES

The key to shooting a nice still-life is to take things slowly and make sure you have properly prepared for the picture you plan to take. The key areas you may want to consider are: your choice of subject matter, which background you will set it against, the type of lighting you wish to use, and how you're going to compose all the elements within the frame. You've no shortage of subject matter as literally any inanimate object can be used. However, still-life is often a very graphic form of photography, so it's worth starting out with subjects that have distinctive or symmetrical shapes and are appealing to the eye, such as vases, bottles, fruit or flowers. These types of subject are also very manageable in size, which makes it easier to set up a composition than with very small or large and heavy objects.

Remember to avoid clutter – keep things as simple as possible to begin with, only introducing extra elements to the frame once you've exhausted the possibilities with your current set-up. A good starting point for many people is to combine their still-life close-ups with their favourite hobby or pastime. Keen anglers could set up a still-life based on hooks and flies; while collectors could try shooting their favourite or most cherished items.

While thinking about your subject, you should also consider the backdrop. Are you shooting the subject where you found it, or setting it up against a textured or patterned background, or in a plain, neutral or coloured setting? You'll have to face all these options but at least you know that you don't have to rush as your subject isn't going anywhere! However, one factor that may change as time lingers on is the lighting, especially if you're relying on natural light. Using ambient light is a good idea to start with as it's one less thing to 'assemble'. Set up indoors near a large window or patio doors and use a diffuser or reflector to control the light. The alternative is to use an artificial light source, which is when your still-lifes can take on a whole new dimension. You can opt for using studioflash, but you should also consider using any form of artificial lighting that you can control and manipulate – even a desk lamp could be suitable!

How should I set up my camera?

Still-lifes aren't the most challenging of subjects when it comes to in-camera techniques, but setting up your AF, exposure and White Balance systems properly will enable you to work faster.

1) EXPOSURE MODE: Aperture-priority is the mode to use. Careful and creative use of depth-of-field is a vital element in all still-life photography, so you'll want to be in full control of your choice of aperture. Also, your subject is static, so you don't need to worry so much about the shutter speed (unless you're shooting handheld, thus needing to think about camera shake).

2) ISO RATING: For smooth tones, bright colours and the lowest noise levels possible, we'd recommend that you set a low ISO rating. An ISO rating between 100 and 400 should be fine.

3) AUTOFOCUS: Because depth-of-field is limited when shooting subjects quite close-up, you'll want to be sure that you focus on the right part of the subject and for this reason we recommend that you set your AF to single-point AF and ideally use the central focusing sensor, which offers the best sensitivity. Set your AF mode to single-shot AF (S, S-AF or AF-S) so that when you focus on the subject, you can lock the AF and recompose before fully depressing the shutter.

4) EXPOSURE: The multi-zone meter should give the correct exposure, unless too much of the frame is dominated by a very dark or light subject or background, which could lead to under- or overexposure. Check the image on the camera’s LCD monitor and if this is the case, use the exposure compensation to add or subtract around 1-2 stops of exposure to give a better result. To do this press the button with the +/ - symbol, dialing in a negative (-) figure if the image is too light, or a positive (+) if it is too dark. You can also use the histogram display on the LCD monitor to ensure the image was captured correctly.

5) RAW OR JPEG: For the ultimate in quality and the option to play with parameters such as White Balance or exposure in post-production, shoot in Raw rather than JPEG.

6) WHITE BALANCE (WB): The AWB (Auto White Balance) generally works well, but when shooting with mixed lighting (i.e. ambient and artificial light), set up a custom White Balance preset with a grey card or white sheet of paper (check the camera instructions for details). If you shoot in Raw, you can change the WB on your PC when you process the shots.
A ‘found’ still-life refers to shots where little preparation was required to set them up. Something as simple as autumn leaves found on the ground are enough to create a striking still-life.
Getting started with still-lifes

Once you’ve decided on what you plan to shoot, your next challenge is to determine what equipment to use and how to light it.

RECOMMENDED EQUIPMENT

A great thing about still-lifes is that you don’t necessarily need any specialist equipment to shoot it, though some bits of kit are more suitable than others. Here are our recommended choices for still-lifes:

- **LENSES** You could get away with using your standard kit zoom as its range is more than suitable for general still-life photography. However, you’ll find that a macro lens offers a significant advantage in being able to focus more closely. We’d suggest a short focal length such as 50mm over the more powerful 90mm/105mm macro lenses, as the wider field-of-view is preferable when working in confined spaces. You’ll find most DSLR brands have a 50mm or 60mm macro lens (for Four-Thirds, check out the Olympus 35mm macro), while Tamron’s 60mm macro is a brilliant optic that has the advantage of a very fast f/2 maximum aperture.

- **TRIPOD** Using a tripod will mean you’re less likely to have images ruined by shake, especially if you’re shooting close-ups and require a small aperture, resulting in long exposure times. A tripod will also encourage you to take more care with your still-life composition. You can make slight adjustments to the position of your subject, then check it in the viewfinder (or on the LCD monitor if you’re using LiveView).

- **LIGHTING ACCESSORIES** A reflector is an essential accessory for still-life close-ups, allowing you to bounce light onto the subject or background, fill in shadows and vary the lighting ratio. A silver/white reflector is probably the most useful of the many types available. A diffuser is worth considering as well, if you plan to shoot under strong, directional lighting, such as bright sunlight. Place it between the light source and the subject, and it will bathe the scene in a soft, diffused light. As well as a purpose-built reflector and diffusers, you should look around your home for material that can be converted into a diffuser. Wrap or tape some tinfoil onto cardboard to make your own reflector, or simply use some white card or polystyrene. For DIY diffusers, use some muslin or a net curtain as diffusing material or pick up a budget reflector for under £10 from eBay or Amazon.

---

**Using LiveView**

As well as using the viewfinder to compose the image, consider giving your camera’s LiveView facility a try. As well as being a useful composition tool, LiveView allows you to change aperture settings and immediately see its effect on depth-of-field. Adjust the White Balance and you can see the changes to the colour balance on the monitor. Whether you use AF or focus manually when using LiveView depends on the DSLR you have, so check your camera’s instructions, but whichever system you use, always magnify the image to check sharpness.
START WITH NATURAL LIGHT...

Think carefully about your lighting choice and try to stick to the simplest lighting arrangements possible to begin with. Set up your first attempts in a shaded area and concentrate on the composition of your still-life. This way, while your first pictures may not be the most exciting, at least you’ll gain invaluable experience on how to use your DSLR, compose and prepare your still-lifes. Try using a reflector to bounce light on the scene and see how it affects the result. Once you’ve gained more confidence, set up the same still-life in direct light, using a diffuser to see the effect it has. Windowlight on an overcast day is a fantastic source of ambient light so make sure to give it a try!

...THEN TRY ARTIFICIAL LIGHTING

Of course, when ambient light is low, you’ve little choice but to use artificial lighting. The ideal option is a studio flash set-up and you can pick up a very good two-light system for as little as £200. Using studioflash really opens up the creative possibilities available to you, so it’s worth consideration. However, it’s not the only option when it comes to artificial lighting. Literally any light source can be used — the humble angle poise desk lamp is capable of providing suitable lighting, you could light some candles, or even think about really weird options such as using the light from a lava lamp, a torch or even the light that is emitted from your TV screen.
At-home still-lifes
Pro photographer Ross Hoddinott spends a day at home looking for close-up still-lifes

WHEN IT'S TOO cold, wet or dark to be tempted outside with your digital SLR, why not shoot great still-life close-ups in the comfort of your home? Practically anything can make a good subject, and most homes are full of photogenic objects. Start in the kitchen, where cutlery, pots and pans, wine bottles, fresh fruit and vegetables are all potential subjects. In the living room, electrical appliances, ornaments and even family board-games might get your creative cogs turning. Look under the stairs, and in the bathroom, where bubble-bath bottles, linen, or a shapely tap could prove the perfect subject. And finally, if you have kids, don't forget to have a quick rummage through their toy box. Colourful building bricks and crayons are ideal for creating eye-catching close-ups.

Having identified your still-life close-up subjects, it's time to consider composition and lighting. Many beginners to still-life photography make the mistake of trying to cram too much into the frame or of attempting overly complex compositions. In truth, simplicity often works best. If you are photographing more than one subject at once, try to select objects with a common thread. Begin by positioning a single key subject and then add other complementary objects one at a time. Regularly examine your arrangement through your DSLR's viewfinder and experiment with viewpoints until you achieve the most aesthetically pleasing balance.

To shoot still-life close-ups around the home, very little is required in terms of equipment. A DSLR with a kit lens and tripod will suffice — the key ingredient to success is your originality and creativity. Many of the subjects are relatively small and can be arranged on a table top, so a window is normally the ideal source of illumination. Windowlight is perfect for home still-lifes, as it is soft and diffused. However, if you need to further diffuse the light, hanging a net curtain or some muslin across the window should do the trick.

BATH REFLECTOR: Bath toys provide fun still-life subjects. Bright yellow rubber ducks can be arranged to create striking, fun images. Shoot them against the simple backdrop of a white bath tub. Baths can make great mini-studios as the sides act as reflectors, to give even lighting.

LIVING ROOM WINDOW: While a bowl of fruit or vase of dried flowers might seem clichéd, if photographed well, such items create elegant still-lifes. Windowlight is a wonderful and often underrated form of lighting. It produces natural, atmospheric results without the complication of using flash. Place a table or chair in window light as the surface on which to arrange your subject, and opt for a clean background — a shady corner formed the backdrop to my windowlit vase. Switch off the room lights too.

Using a lightbox

Many still-life photographers rely on natural light for their images, as it's soft and flattering. However, a good, artificial alternative light source for around the home is a lightbox. Lightboxes can be useful if you wish to backlight translucent subjects, like glass and thin plastics, or to emphasise shape and form. A lightbox can also be placed on its side, to provide sidelight or to simply act as a white background, helping to create still-lifes with a shot-in-the-studio edge. Many digital cameras still have a lightbox from their film days, but if you don't own one yet, it would still be worth investing in one. Battery-operated lightboxes can be picked up for around £20.
KITCHEN ABSTRACTS: You will find more still-life potential in your kitchen than in any other room. Food is a popular subject, while the shape and form of drinking glasses, cutlery and cooking utensils look intriguing in close-up. Also, consider crockery. Many modern plates, bowls and cups have attractive curves that photograph well from either an overhead or low angle. Use their shape and lines, maybe contrasting the curve of a bowl with the straight edge of a square plate.
Garden still-lifes
Ross Hoddinott heads out into his backyard to discover what still-life close-ups can be found

FORGET THE WEEDING and mowing for once – instead look around your garden or allotment for potential still-life subjects. Very ordinary objects can be lit, arranged and photographed to create striking images. Flowers, fallen leaves and vegetables are among the most obvious subjects, but there are countless others. For example, take a closer look at a coiled hose pipe, stacked flower pots, rusty garden utensils, dusty cobwebs or the paint peeling on an ageing garden shed. This type of still-life relies on the creative eye and vision of the photographer. You’ll need to learn to look at mundane objects in a fresh way before capturing them with your DSLR. Look for texture, patterns, contrast, conflicting colours and interesting detail. Very little is required in terms of equipment. A standard zoom lens should prove more than adequate unless you are shooting very small objects, in which case a macro lens or close-up filter would prove useful. A tripod will help you to fine-tune your composition, and a reflector will give you more control over the ambient light. If you don’t have a garden, ask a neighbour, friend or relative if you can take photographs in theirs. Alternatively, visit a park or public garden. To help you get started, visit: www.rhs.org.uk

CONVERT YOUR SHOTS TO BLACK & WHITE Black & white is a powerful and dramatic medium. It can be particularly effective when combined with still-life close-ups. Removing colour places extra emphasis on the subject’s shape and form and also the composition and light. Mono is well suited to garden still-lifes, especially rustic subjects, like old terracotta pots and rusty garden machinery. Although many DSLRs allow you to capture greyscale images in-camera, more detail and information is recorded in colour. Therefore, to maximise image quality, continue to shoot in colour and convert later during post-processing. Using Photoshop, there are several methods to transform colour files into mono. However, many photographers consider the Channel Mixer the most versatile option. Click Image>Adjustments>Channel Mixer and tick the monochrome box in the corner. Using this tool, it is possible to mix the colour channels to alter the image’s tonal range and contrast. This can be done by individually adjusting the red, green and blue sliders until you achieve the result desired. Try to keep the combined total of the three Mixer settings to 100%.

TRY ADDING GRAIN Usually photographers are advised to keep their DSLR’s ISO rating low, to minimise noise and maximise image quality. However, the effect of noise is similar to that of film grain and can enhance a photograph, creating a textural, arty quality. Noise works well with still-life and black & white images, so is perfect here. The best way to create the effect of noise is to apply it post capture using photo editing software. Click Filter>Noise>Add Noise... to open the dialogue box. By clicking the Monochromatic tick-box and adjusting the Amount slider you can precisely adjust the effect until it looks just right.

EXPERIMENT WITH CONTRAST Strong lighting can be advantageous but also a drawback depending on the subject and the result you wish to achieve. Strong directional lighting will create deep shadows, which can add interest, depth and emphasise shape; but it can also diminish saturation and the contrast can extend beyond the dynamic range of the camera’s sensor. If you’re unsure whether your subject will benefit from strong lighting or not, take two images – one with the subject brightly lit and one with it shaded by casting your shadow across the subject and using a remote shutter or the self-timer. The results can look radically different.
USE A REFLECTOR It is easy to overlook familiar objects that you walk past most days, as you take their appearance for granted. The peeling paint and decaying handle on this garden shed's door create character and interest. It is a good example of the type of still-life that you might find in your own back garden, but could be forgiven for overlooking. Simple compositions often work best. Here, the keyhole and handle were obvious points of focus, but thanks to some overhanging trees, they were poorly lit and lacking vibrancy. However, by simply placing a reflector opposite, I bounced some natural light onto the door, creating far more impact. Reflectors are the perfect accessory for outdoor still-lifes. They are inexpensive and collapsible, making them easy to carry around and to store.
Secret to shooting glass

Glass can be a tricky subject to shoot well, but pro photographer Lee Frost demonstrates a simple one-light technique for great images.

THOUGH I'm a landscape photographer, even I enjoy honing my skills shooting still-life close-ups in the studio. While I am more at home when working with daylight in the great outdoors than indoors with studio flash, challenging myself to try new things keeps my skills sharp. Far too many photographers give studio still-life photography a wide berth because it seems alien and complicated, so I'm going to now show you how nothing could be further from the truth.

It's been so long since I last used my old Jessops studio flash kit that I wasn't even sure where it was – and when I did find it, I realised, in a state of panic, that the stands for the flashheads must still be in the loft of my old house. Luckily, with at-home shoots you've the resources to makeshift any props and a roll of Gaffer tape and a spare tripod solved my problem!

My other props were a wine glass and a bottle of red wine (yum!), which I'd soaked in a bowl of warm water to remove the labels. My challenge was to create a simple rim-lighting effect, to highlight the curves of the glass objects. This meant that the glass and bottle had to be positioned against a black background while being lit from behind.

As a glass and bottle are small in comparison to a 1x3m softbox, I decided that I could probably manage with just one light and keep the set-up nice and simple. To achieve this, a piece of black velvet was draped down the centre of the softbox, creating a narrow black background which effectively split the softbox into two, so that I was left with a narrow strip light either side of the velvet. I poured some wine into the glass, and then positioned both glass and bottle in front of the softbox, on a stool that had been draped with a sheet of black fabric.

To check the lighting effect and exposure, I took a test shot with the camera set to manual exposure mode – 1/125sec at f/8. The image on the preview screen told me several things – the props were too close to the background, the wine glass needed a good clean and the exposure could be reduced. I also decided that a full wine bottle would look better than the half-full one that I was using.

With a second bottle de-labelling, I moved the glass and bottle further away from the softbox – they ended up about 12in in front of it. This gave me a better rim-light effect. I varied the lens aperture between f/22 and 1/4, and the wider I went, the more colour and detail I could see; while with smaller apertures, the image became more graphic, until a fine white outline around the props was the only thing visible.

Experimenting with different compositions produced a range of stylish shots. I tried just the glass on its own, then the bottle, the glass and bottle next to each other and, finally, the bottle behind the glass.

After a little Photoshop clean-up, I was happy with the results. I had created a series of stylish still-life images using just one light, a piece of black velvet, some simple props and a bit of imagination. Cheers!

**FULL-LENGTH SHOT:** My first attempt shows a work in progress. The rim-lighting isn't fine enough, I need to use a full bottle to avoid the green colouring and the wine glass needs another clean.

**KEEP IT SIMPLE:** By reducing the aperture to f/16 and the flash head to half-power, the light wasn't intense enough to penetrate the wine inside the bottle so only the fine white outline recorded.

**GRAPHIC GLASS:** With the positioning, lighting and exposure sorted, the images look much better, so I experiment with different set-ups, starting with the glass on its own and moving in close.
A bottle of your finest!
I felt that the most effective compositions were created when both bottle and glass were photographed together, to create a series of overlapping shapes and tones. Tweaks in Photoshop made sure the image was clean and simple, and the wine, just in case you're wondering, went down a treat!

TOP TIP
KEEP IT CLEAN!
Make sure the props are clean and scratch-free, as any blemish will show up against the studio lights. Any marks that can’t be avoided can be removed during post-production.
Creating colour impact

It’s cold outside, the wind is biting and the rain is lashing down; you hardly need an incentive to stay in the warmth of home, especially when you can take some colourful close-ups.

YOU CAN FIND suitable subjects bursting with colour practically anywhere, but if you’re not feeling very energetic or adventurous, where better to start looking than your own home. Photogenic objects are all around the house – you just need to identify them. Once you have, you need to set up your own makeshift tabletop studio. Light is a vital ingredient. You could position your arrangement near a window and simply use the available natural light. Alternatively, you may prefer to rely on the consistency and precision of flash. Regardless of whether you employ natural or artificial light – or even a mixture of the two – a tripod will prove essential to keep your images shake free. Also, experiment with depth-of-field, the angle-of-view and composition. Most of all, remember to have fun... Here, at Digital SLR Photography, we like to practice what we preach. So, with camera at the ready, we went in search of colourful household objects that we could transform into a potential winner. What better than a pack of pencils.

1. Looking around the house, there was no shortage of potential subjects: shocking pink drinking straws in the kitchen, multi-coloured drawing pins in the study and toy building bricks in the kid’s room. However, it was a set of coloured pencils gathering dust at the back of a drawer that had the most picture potential for colour impact.

2. To create a simple, mobile set-up, white card was placed on a table. Rather than laying the card flat, it was curved upward to bounce light back toward the subject. Once the pencils were arranged ready to shoot, the camera was positioned directly overhead to keep the sensor plane parallel with the subject.

“REGARDLESS OF WHETHER YOU EMPLOY NATURAL OR ARTIFICIAL LIGHT, A TRIPOD WILL PROVE ESSENTIAL TO KEEP YOUR IMAGES SHAKE-FREE.”

3. It was early evening and it was already dark outside; using natural light from a window wasn’t an option. Therefore, a flashgun was attached to the hotshoe. The problem with using flash close to the subject is that the burst can prove too harsh. In this instance, it was no more than 30cm away from the subject and colour is washed out.

4. To combat this, a negative flash exposure setting of -1½ stops was applied to reduce its intensity. As a result, colour is recorded with greater strength and accuracy. However, despite selecting White Balance to Flash, there is still a warm colour cast evident; caused by the light bulbs in the room.

5. To eliminate the unsightly orange colour cast, the Fluorescent WB preset was selected. This has produced faithful colour rendition, but the image still lacks impact. The problem is the arrangement. There is too much wasted space between the pencils, with the white background diluting the strength of the shot.
By arranging the pencils differently, it is now obvious what the subject actually is. The pencil tip adds interest and a needed focal point. The composition is strengthened by the pencils’ shafts cut diagonally across the frame, giving it impact.

This arrangement is more striking and the image is now bursting with colour. A diffuser eliminates any distracting catchlights. However, it is not immediately obvious what the subject is anymore and the shot lacks a focal point. Time to experiment further, with different arrangements, viewpoints and compositions.

**APERTURE SETTINGS**
The f/stop you select will greatly dictate the type of effect you achieve. If you require front to back sharpness, employ a small aperture like f/22. Or use a wide aperture like f/4 for creative use of shallow depth-of-field.

**WHITE BALANCE**
Although WB can be used creatively, when accurate colour rendition is a priority, it is important to match the setting with the type of light available. Therefore, when taking pictures indoors, match the WB to the lighting.

**FLASH EXPOSURES**
Flashguns are very sophisticated, but you may still need to alter the level of their output to create the effect you require. You can manually set positive or negative compensation via controls on the flashgun or the camera.
Give it a go yourself!
If you’re itching to put our advice and ideas in to action, remember these pointers...

A PHOTOGRAPH JAM-PACKED with bright, vibrant colour will never fail to catch the eye. Frame-filling results often work best, so cram your viewfinder edge-to-edge with colour. Subjects can be big or small, but should you need to isolate finer detail, a macro lens, or close-up attachment, may well prove handy.

There is no limit to the type of subjects you can use and some will be more obvious than others. Colourful peeling paint, brightly-coloured crayons, confectionery, fruit, toy building bricks... you probably have your own ideas, but the list is quite genuinely endless. With such a large contrast in potential subject matter, it is tricky to dish out good, general advice. However, regardless of the object that you shoot - indoors or out - the quality, direction and type of light can prove the difference between a good or great image. Remember, every picture-taking situation is unique, so there are no hard and fast rules. For instance, bright, overcast light can actually help saturate colour when shooting in natural light; whilst a burst of flash may be needed to bring colours to life indoors.

Good use of your digital SLR’s White Balance is also vital. WB can often be used creatively to either warm up or cool down the look of your photographs. However, when faithful colour rendition is required, it is essential to select a WB setting that most closely represents the ambient lighting. In case we’ve not given you enough inspiration to try your hand at indoor still-life close-ups, here’s four more ideas that maximise colour.
FAR LEFT: If you are after a kaleidoscope of surreal colours, try cross-polarisation. This is a technique where you photograph a backlit, clear plastic object between two polarising filters. The rainbow of colour is created by stresses in the plastic. Colour will fade or intensify depending on the level of polarisation. This fun technique will transform mundane objects – like this CD case – into an interesting and unusual colour pattern. See page 47 for more details.

LEFT AND BELOW: If you’re using a flash to directly illuminate a subject with a shiny surface, you can expect to see hotspots of light appearing on the result. The easiest ways around this is to bounce the flash light or fit a diffuser to soften the nature of the light.

LEFT: Let’s face it, you would never normally consider snapping something as dull as a handful of paperclips, yet in close-up, they create a fun, colourful snap. In this instance, the bright, white background was created by placing the clips on a lightbox.

RIGHT: Translucent objects can look striking backlit. An old lightbox is useful for creating this effect. However, to add colour and impact to your shots, why not filter the colour of light – and the subject – by placing a coloured gel over the light source itself.

Brightly coloured cellophane only costs a few pounds from a crafts shop, but can radically alter the look of a familiar subject. This simple technique will transform commonplace objects like plastic cutlery, bubble-wrap or even thin slices of fruit, like lime or lemon.

"FRAME-FILLING RESULTS OFTEN WORK BEST, SO CRAM YOUR VIEWFINDER EDGE TO EDGE WITH COLOUR!"

Essential kit

Macro lens: If you wish to capture colourful images bursting with impact, it will often be necessary to crop in tight to your subject. Most standard zooms can focus reasonably close so are worth a try, but they still can’t rival a macro lens for image quality and ease of use.

Flashgun: When shooting indoors, a burst of flash can be useful to give colour more life and impact. Photographers who are relatively new to DSLR photography may be wary of using artificial light. However, modern flashguns are so sophisticated, they can be relied upon to achieve good, accurate results in almost any shooting situation.

Diffuser: The one drawback of using flash – especially when in close proximity to the subject – is that it can produce distracting catch-lights and harsh shadow. Therefore, it should be diffused. Either buy a specific diffuser, like the Sto-fen Omnbounce, or soften the light using a DIY diffuser, made from an opaque material – like a plastic milk carton, tissue paper or muslin.
Still-lifes: Get creative!

Experiment, open your mind, crop in close and use your subject to create something different with your own unique style.

WHEN TAKING STILL-LIFE CLOSE-UPS, you, the photographer, have complete control over every aspect of the capture, including composition, lighting and exposure. The subject is stationary, so there is no rush or panic – you can take your time until you get things just right. However, that doesn’t mean that it is easy. In fact, it’s far from it, being one of the few subjects where you actually have to ‘manufacture’ the picture before you can take it. Creativity is a key ingredient to successful still-lifes. While shooting such subjects as a vase of flowers or bowl of fruit is fine, they can appear quite clichéd and, before long, you will want to be more experimental and original with your subject choice and approach. You can increase the appeal and impact of your still-life images by being creative in a number of ways: through your use of depth-of-field, for example; manipulating White Balance creatively; with your choice of focal length; or simply selecting an unusual viewpoint or angle. Still-life images should be creative, so don’t be afraid to experiment and have fun. Once your creative juices begin flowing, you won’t be short of ideas, but to help you get started, here are a few suggestions...

- **CREATIVE DEPTH-OF-FIELD** Regardless of what you shoot, depth-of-field is an important creative tool in still-life close-up photography. If you select a large aperture (a low f-number, like f/2.8), depth-of-field will be shallow. This can help to draw attention to your point of focus, rendering foreground and background detail in soft focus. An aperture of f/4 or f/5.6 is often ideal, being large enough to draw the viewer’s eye to an intended point, whilst still obtaining sufficient focus to ensure foreground or background objects remain recognisable. In contrast, a small aperture (high f-number) will maximise back-to-front sharpness. Therefore, in situations when you wish to prioritise back-to-front sharpness to record all, or the majority, of your subject in sharp focus, select an aperture of f/16 or f/22. It really is remarkable how, by simply changing the f-number, you can greatly alter the look and feel of the resulting image. While our example images help to illustrate this, try shooting your own depth-of-field comparison sequence by using a variety of different apertures. (For example: f/2.8, f/5.6, f/8, f/11, f/16 and f/22.) By studying the results, it will help you to recognise the creative influence of apertures and help you to select the most suitable aperture for any given situation.

- **LOOK FOR CREATIVE VIEWPOINTS** The most obvious angle from which to shoot a still-life subject isn’t always the best. Photographers instinctively shoot from a parallel angle, but in order to produce the most striking, original shots of a subject, you often need to think more objectively. Before deciding on your composition, walk around your subject and experiment with different viewpoints by looking through the viewfinder from different angles. Often high or low viewpoints work well, distorting the subject’s appearance to create unusual shots. Intriguing viewpoints may help to entice the viewer to take a closer look. Still-life pictures taken from directly overhead, for instance, will create more abstract and dramatic results, condensing perspective and emphasising shape. This viewpoint works particularly well with simple, uncluttered arrangements in which just one or two items are included.

- **USE AN ‘INCORRECT’ WHITE BALANCE** Breaking the rules is one of the best ways to expand your creativity. A popular way to do this is to shoot a subject and use White Balance settings that are inappropriate to the lighting conditions. This allows you to warm up or cool a scene and can really add to the impact of your still-life images. If you shoot in Raw, you have even more flexibility as you can try literally every White Balance option quickly and easily with the software you use to process your Raw file.
CROSS-POLARISATION

The effect of cross-polarisation isn’t to everyone’s taste. However, it is a fun, creative still-life close-up technique capable of producing surreal and striking results. Cross-polarisation is the result of photographing a transparent, backlit plastic object between polarising materials – one attached to the lens (i.e. a polarising filter), and the other placed behind the backlit object. Due to the way plastic is produced, internal stresses are generated. While these aren’t visible to the naked eye, when viewed through cross-polarised light, the points of stress are revealed, appearing as a garish kaleidoscope of colour.

To create the effect, a sheet of polarising material, which can be bought from some craft shops, would be ideal. However, these can be fairly expensive, so a good alternative is to use a large-diameter polarising filter (although this will restrict you to shooting quite small subjects). To backlight your clear plastic object, a lightbox is ideal as you can place it on the floor and set your camera up on a tripod directly overhead. Your choice of subject is important, as not all plastics work well, so you may need to experiment with different objects. However, combined with the right subject, this technique will transform mundane, everyday household objects, like clear plastic cutlery, a geometry set, a CD case or even the protective cover of your camera’s LCD monitor. With your object positioned on the polarising material and placed on a lightbox, compose your shot, cropping in tight to the interesting detail using either a macro lens or close-up attachment. Now, rotate the polarising filter (the one on your lens) to intensify or lessen the colours until you achieve the effect you desire. Visible areas of the polarising material covering the light source will appear black when fully polarised, helping the colourful plastic stand out boldly. The abstract looking results can create dramatic still-life close-up images.

SETTING UP: Place a circular polarising filter on a lightbox and an empty plastic CD case on top of it. Then fit a polarising filter to your lens. Switch off the room lights (you need complete darkness) and rotate the filter on your lens while viewing the effects through the viewfinder (you can use LiveView). Fire off a few frames and rotate the filter a little to vary the effect and take a few more.
Backlit blooms

If you’re looking to create some beautiful images, look no further than this close-up technique for backlighting florals.

Lee Frost: The idea for this shot came about by accident. Walking into my kitchen to make a cuppa, I noticed the way a vase of tulips on the table was being backlit by daylight streaming in through the French windows. Moving in for a closer look, I realised there was potential for a simple, high-key still-life. Forgetting the coffee, I dashed upstairs to the office, grabbed my camera and tripod and, having recovered from the sudden flurry of activity, got to work turning my idea into reality.

Tulips are an ideal flower for this kind of shot because of their simple, graceful shape and subtle colours. But you could experiment with any type of flower. Gerberas are a favourite with photographers for exactly the opposite reasons – bolder shapes and stronger colours. Stargazer lilies work well too. The key is to keep the composition simple and experiment with exposure to achieve that delicate high-key effect.
Still-life masterclass

• GETTING STARTED Windows make ideal backgrounds for shots of translucent subjects such as flowers: the soft light reveals delicate detail and colour in the petals as well as creating a bright, uncluttered background. I shot my flowers in the position I found them, but if you don’t happen to have a kitchen table in front of French windows, you can always set up the shot somewhere else in your house. Direct sunlight shining through can be too harsh, so choose a north-facing window as it only admits reflected light or wait for an overcast day when the light is much softer. Given our weather, you shouldn’t have to wait long!

TOP TIP
FOCUS WITH CARE
When shooting at maximum aperture – in this case f/2.8 – depth-of-field is minimal, so you need to be able to control exactly where the lens focuses. To do this, always set my lens to manual focus and rely on my eye, rather than the autofocus system, which doesn’t always focus exactly where I want it to.

The tulips might look okay as a table decoration, but photographically they need a bit of a tidy up. With scissors at the ready I did my best florist impersonation, snipping stems and removing leaves. Be careful not to chop too much off or you’ll have to buy more.

I fired off a test shot to see how it looked. Three things immediately became apparent: the composition is poor; the aperture is too small, meaning I’d need to open it up to reduce depth-of-field so the background doesn’t intrude; and the exposure is incorrect.

I moved in closer, recomposed, opened up the aperture to f/2.8 and dialled in +3 stops of exposure compensation. This makes a huge difference to the look and feel of the image. Tulips are difficult to keep in place and work with, but persevere.
As I'm making progress, the sun decides to come out. As you can see, it completely changes the tonal balance. The background is now dark and intrusive and the intensity of the light on the tulips sends contrast through roof. If this happens just wait for it to disappear.

After ten minutes the sun goes and I experimented with two tulips overlapping. I varied exposure compensation between +1 and +3 stops. I'm pleased that I chose white tulips, instead of yellow or red, as the white fits the subtle nature of this shot.

The images required a little work during Raw processing in CS4. I used Fill Light and Recovery to adjust the lighter tones. A little ‘reverse’ Clarity also adds to the high-key effect while increasing Vibrance puts more colour in the stems. Finally I adjusted the Tone sliders.

Blooming lovely! The high-key treatment suits the subject matter really well, and I'd be happy to make a nice big print, frame it and hang it on my wall. Who needs an expensive studio when you've got a kitchen table and some diffused daylight?
Standing out from the crowd

Professional stock photographer Catherine MacBride shows you don’t need to venture far for images that stand out. With a little imagination, potential is all around us...

Catherine MacBride: I’m a big believer that creative close-up images can be made out of almost anything. The key is training your eye to see past the everyday to find potential in the objects around you. A quick Google search for images of green and red apples will reveal this concept a hundred times over in all its various manifestations. The reason why it’s so popular is that, for such a simple shot, it works on many levels. It continues to sell well as a stock image because it can be viewed both at face value, showing a bright, fresh image of healthy fruit, but also because it can be understood conceptually showing individuality and the ability to stand out from the crowd. Who knew apples could convey such a powerful message?
Getting to grips with the basics of this shot will then let you expand on the idea using a whole host of different objects to show the same theme and concept. I have taken the same principles and gone on to shoot buttons, bottles, pasta and a whole host of other objects in a similar, graphic fashion. Supplies are easy to find, in fact you may already have them sitting in your fruit bowl. If not a quick trip to the supermarket will see you well. For this image I bought Granny Smiths because of their bright crisp green colour and for the red apples I choose Red Delicious, but many other varieties will work just as well. It is important though to try and pick apples that are as uniform in size as possible, and free from blemishes, so you may take a little longer than usual at the fruit and veg stand; rather that than time spent in front of the computer cloning out bruises!

Besides your apples all you'll need is your camera and tripod and a source of light; a diffused flash on low power, or diffused daylight works equally well.

1 **PICK YOUR SUBJECTS** Choose your apples carefully: find apples that are uniform in size and colour as best you can, with all the stalks intact too. Once home, wash and dry all your fruit and use a soft cloth to polish them to a soft shine. Don't over shine as the reflective surface can make them difficult to light and photograph.

2 **ARRANGE YOUR APPLES** Place the apples on a sheet of bubble wrap for support. This neat trick allows you to adjust for variations in height by bursting the bubbles under the taller apples. Arrange your apples in rows with the red apple sitting to the right a third of the way across. Use Blu-Tack between the apples to hold them in place, too.

3 **CORRECT EXPOSURE** Set your camera to aperture-priority mode, dial in ISO 100 and select a mid-aperture for good depth-of-field. Focus on the red apple, as this is where most people's eye will travel to first. If your shutter speed is too slow for a sharp shot, try using a tripod or introduce a diffused flash, as shown here.

4 **BASIC EDITING** Open your image in Photoshop. With a combination of the Clone Stamp, Spot Healing and Patch Tools, remove any blemishes from the apples. If you are missing any stalks you can clone them in using the Clone Stamp Tool. Adjust Levels, Curves and Saturation until you're happy with the final result.

Be individual

An eye-catching graphic image that's easy to recreate in your own home. Exposure: 1/160sec at f/14 (ISO 100)
Photographing apples: Common problems

1) VARIATION IN HEIGHT
If any of the apples are still too tall after the bubble wrap adjustment, cut a piece off the bottom so that it sits at the same height as all the others. Cover the cut sides with lemon juice to stop them going brown.

2) LIGHT SOURCE TOO STRONG
If your light source is too powerful you’ll end up with ugly glare. Lower the flash power or move the apples away from your light source. Don’t polish the apples too much as this makes the problem worse.

3) LARGE SPACE BETWEEN APPLES
Use Blu-Tack to keep the apples in place and sit them as close together as possible and move the apples around until they sit well. Adjust your shooting angle too: shoot across the apples for a better composition.
Close up on nature

Reveal the intricate beauties of Mother Nature that are almost invisible to the naked eye

COME THE SPRING there is no end of colourful and interesting miniature critters to snap, from beautiful butterflies and dragonflies to bugs and creepy crawlies. Reptiles and amphibians emerge from their winter slumber, providing great opportunities for wildlife close-ups, and during March many woodland plants like celandine and wood anemone burst into flower. Spring provides some of the best subjects for intimate plant close-ups of the year. Trees and shrubs are erupting into leaf, with fresh growth being colourful and vibrant. Spring is also much cooler than the summer, meaning the wildlife remain still for longer during the mornings making them easier to photograph. Despite these opportunities, nature is still timid and unpredictable. Successful images will be the result of patience, good technique and a little homework. Let’s get started...

**PLANTS**: April and May are the best times of year to photograph plants. The woodlands, countryside and road verges are ablaze with colour, as a wide variety of wildflowers bloom, like wild garlic, bluebells and orchids. Vibrant, fresh growth is colourful and photogenic. Emerging leaves, uncurling ferns and delicate wildflowers are just a small example of natural subjects that look great in close-up, so visit a local park, woodland or public garden with your DSLR. However, taking successful images of plants and flowers is far from easy. Although they won’t suddenly fly away or disappear, a completely windless day is rare in the UK at this time of year. Movement appears exaggerated at high magnifications, so even the slightest breeze can prove troublesome – blowing the subject out of focus. In situations like this a Plamp is useful for holding the subject still. Great plant close-ups often rely on their simplicity. A simple, uncluttered composition often works best, with the subject set against a clear, diffused backdrop. To achieve this effect, employ a large aperture of f/4 or f/5.6. This isolates your subject and helps throw messy, distracting background elements out of focus. To maximise depth-of-field, keep your camera’s sensor plane parallel with your subject, and use a tripod for stability and to aid composition.

**INSECTS**: Tiny bugs and beasties are the perfect close-up subject. Their beauty and design can only be revealed in magnification, and truly eye-catching results are possible. Spiders, beetles and damselflies is a small selection of the subjects you should be looking for. The longer, warmer days of spring will entice a host of bugs to emerge, which is a great time to hone your close-up skills. Early morning and late evening are the best times to take pictures. The light is warm and gentle and if the insect is still asleep, it will prove easier to photograph. During the heat of the day, insects are far more active and you will need to be patient. For flying insects, like butterflies, it is best to watch and wait until one rests, then approach slowly on foot. Insects will quickly scurry off or fly away if disturbed, so you need to be able to approach your subject carefully and quietly. Try not to disturb surrounding vegetation and do not cast your shadow across the subject. Unless you are confident that the insect will remain still, a tripod or camera support will be impractical, so you have to shoot handheld. Use a medium aperture of f/8 to f/11. In sunlight, this will allow you a fast enough shutter speed to eliminate shake. Careful focusing and a steady hand are essential and if the shutter speed is so slow it’s unworkable, increase the ISO rating.

**Recommended reads...**

**DIGITAL MACRO PHOTOGRAPHY**
By Ross Hoddinott. Publisher: Photographer’s Institute Press. ISBN: 978-1861084521
Written by Digital SLR Photography contributor Ross Hoddinott, this book demonstrates that spectacular close-up images are within the grasp of every photographer – regardless of budget. Aimed specifically at digital users, it’s packed with techniques & equipment advice.

**CLOSE-UP AND MACRO: A PHOTOGRAPHER’S GUIDE**
This is a comprehensive sourcebook, with advice on subject matter, creative ideas and pictures. Packed with Robert Thompson’s images, the book gives guidance on shooting popular close-up subjects.
TOP TIP
CAUTIOUS APPROACH
When approaching insects, do so slowly and don't make sudden movements. Also, make sure your shadow doesn't pass over your subject, as this could frighten them into a hasty exit!

Take a closer look
This moth is cleverly camouflaged against the colour and textures of the wood.

IMAGE: NORG WOODHAMS
Insects

Nature is one of the most popular subjects to photograph, as well as being one of the most technically challenging. In this section, award-winning natural history photographer Ross Hoddinott shares his expert knowledge of photographing nature, from finding great subjects to taking your finest shots of them...

BUGS AND CREEPY crawlies do not have a good reputation, do they? Despite their tiny size, they seem to strike terror among people. However, if you’re brave enough to take a closer look, you’ll discover that the majority of them are colourful, intricately formed and very photogenic. In the UK, few insects bite or sting, so it’s actually an irrational fear. Therefore, rather than run away, photographers should put their phobias aside and reach for their camera instead...

Some of the techniques and principles outlined in the Wild Flowers masterclass starting on pages 76 can also be applied to photographing insects — for example, the importance of lighting, originality and the need for ‘gardening’. However, the mobility, size and timid nature of mini beasts present photographers with a fresh set of practical and technical dilemmas. Firstly, you need to identify a suitable habitat where you’ll find them. Wildlife photographers often need to research their subjects before they begin snapping, so visit your local library or surf the internet for information.

IMAGE: ROSS HODDINOTT
Gear up for creepy crawlies!

To photograph insects, you’d need a macro lens or close-up attachment. If your budget can stretch to it, a dedicated macro lens is a great investment, allowing a practical working distance from which to take pictures. A lens in the region of 100-180mm is traditionally best for snapping insects. However, if you are a beginner, student or have a limited budget, try using extension tubes or a close-up lens/dioptrre in combination with a standard focal length. Both accessories are comparatively inexpensive and provide a good introduction to the world of close-ups. A 70-300mm zoom with close focusing can sometimes be used to snap larger insects like dragonflies. If the insect is resting, a reflector may be used to bounce light onto the subject, so keep one in your camera bag. Due to the nature of insect photography, a tripod is often impractical. A monopod can provide a more practical form of support, but if you don’t own one, simply keep the legs of your tripod closed together and use it as a makeshift monopod. Enthusiasts may wish to invest in a ring- or twin-flash unit. These dedicated macro accessories provide artificial illumination for close-up subjects when natural light is insufficient.

GET UP EARLY I won’t try to pull the wool over your eyes: photographing insects is often challenging and full of frustration. For this reason, it’s only logical to make life easier whenever possible. Insects are at their most lively during the warmth of mid-morning to late afternoon, so this time of day is best avoided whenever possible. It’s better to shoot during the lower temperatures of morning and late evening, when their bodies are cold and they remain relatively inactive. So, if you’re serious about capturing great insect shots, you need to set your alarm early.

During summer, you will need to drag yourself out of your warm, snug bed by 4.30am to be at your location by sunrise. Not fun I know, but the results will make it worthwhile. Look carefully amongst vegetation, tall grasses and leaves to find butterflies and bugs asleep. You will need a sharp eye, but with a little experience you will learn where to look. Tread carefully, though – a careless foot can prove fatal to these delicate, sleeping insects. One of the major advantages of photographing resting insects is that while they remain immobile, the area around them can be ’gardened’ – see the Wild Flowers masterclass on pages 76-79. Also, after clear, dewy nights, tiny droplets of water will form on the insect’s wings and body, adding scale and further interest.

CAMERA SHAKE This is a common problem that occurs when the selected shutter speed isn’t fast enough to eliminate your own natural movement, resulting in a blurry, ruined image. It’s further exaggerated when using long focal lengths or high magnifications, so shake can prove a problem for insect photographers. The solution? Easy – just pop the camera on a tripod. Of course, it’s often not that simple when shooting timid wildlife. While using a support is fine for many other forms of photography, a tripod is often impractical when photographing insects. For example, a lightly resting butterfly won’t wait and pose for you while you try to set up your tripod. Insects are highly sensitive to any nearby movement and vibration, so if a tripod leg disturbs any surrounding grasses or vegetation near to the subject, it will soon scurry or fly off. In fact, in my experience, the only time a tripod is useful is during early morning or late evening when insects, like butterflies or damselflies, are asleep or settled for the arrival of night. At other times, you should be prepared to shoot handheld.

It’s very easy to overestimate how steady you can hold a camera, but a good general rule for macro work is to employ a shutter speed at least double the focal length of the lens in use. Therefore, when using a 90mm macro, employ a shutter of at least 1/180sec. If your DSLR/lens has anti-shake technology, use it; sharp images can be produced at speeds two or three stops slower than without. Alternatively, to generate a faster shutter speed, employ a wider aperture (however, this will reduce depth-of-field) or increase your ISO rating. You can also limit the effects of shake through the way you support your camera. For example, kneeling is more stable than standing. Keep your elbows to your chest and hold the camera firmly to your face. Support the weight in your left hand and squeeze the shutter button smoothly. Your subject will often be low to the ground, so to achieve natural-looking results, lay prone to keep the camera parallel with the subject. This will also allow you to either use a beanbag or your elbows to steady your camera. Lying flat on the ground limits body movement, greatly reducing the risk of shake.
TOP TIP
Bugs before bedtime
If you’re not an ‘early bird’, look for insects before sunset instead when they are preparing for overnight. The low, warm light at this time can be great for shooting insects, especially butterflies.
3 **STALKING** Suitable insect-rich habitats can be found by researching a little on the internet, or by contacting a local wildlife organisation. However, locating potential subjects to shoot can be a bit tricky; getting near enough to photograph them can prove far more difficult. Insects are highly sensitive to movement; as they are constantly trying to avoid predators. As a result, they will quickly scurry or fly away unless you approach them with great care. ‘Stalking’ is a term nature photographers use to describe approaching wild animals to within photographic range – in a stealth-like manner. Having found a suitable subject, consider your approach. Note the position of the sun and begin moving nearer, doing so slowly and avoiding sudden or jerky movements, while always being mindful of where your shadow is falling. If the subject is low to the ground, get down on your knees in advance and ‘wriggle’ forward. Admittedly, you will look rather silly to any onlookers, but it is a small price to pay for a great shot. When you get near, slowly bring the camera up to your eye while moving yourself into a shooting position. Take a frame from slightly further away to guarantee one shot ‘in the bag’ and the creature get accustomed to the sound of your shutter. Still looking through the viewfinder, move closer again – refocusing as you do so – compose your shot and shoot. If the insect moves, try to keep it in sight. Some insects – for example, dragonflies and some butterflies – are territorial and, having flown away, may return to the same resting place a few moments later. Therefore, if you remain in position, you may well get a second chance.

4 **GET YOUR DSLR PARALLEL** At the high level of magnification required to shoot insects, depth-of-field grows progressively shallow. Often it isn’t practical to stop down to a narrow aperture of f/16 or f/22 as the shutter speed will be too slow. Also, background detail becomes more defined and can prove distracting. Even in shooting situations where you are able to use a high f/number, depth-of-field may only be a matter of millimetres, making good technique and focusing essential.

More often than not you will want to record your subject in sharp focus throughout, from the head to the tip of its abdomen. Therefore, to maximise the depth-of-field available for any given f/number, carefully position your camera so its sensor plane is parallel with the subject. If you fail to do this, you risk the insect’s body or wings drifting out of focus.
Common insects

Here are five of the most likely insects you will find and photograph in the UK.

- **Large red damselfly**: There are many species of damselfly, but one of the most widespread is the large red. It’s on the wing from May–August and favours ponds, lakes, streams and bogs.

- **Garden spider**: This arachnid is found in huge numbers in gardens, hedgerows, woodland clearings and meadows from July until mid-autumn. Its large web comprises radial and spiral threads.

- **Red admiral butterfly**: Widespread throughout the UK. Easily enticed into gardens by planting nectar-rich plants like buddleia. Commonly spotted during July and August.

- **Four-spotted dragonfly**: Has distinctive spots on the leading edge of each pair of wings. It flies from May–August and hunts along hedgerows and near wetland habitats.

- **Angel shade moth**: One of the more widespread moths, on the wing from May to October. Recognised by its forewing having a ragged margin and its pinkish triangular mark.
Capturing colourful critters

Head outdoors and explore your garden for new ways that you can combine flowers and insects for striking results

Daniel Lezano: If you’re lucky enough to have a garden, chances are you’ll already be aware of its potential as a location for great nature photography. Flowers in full bloom provide a wonderful opportunity to capture some colourful and intricate close-ups, but have you ever considered compositions that deliberately combine plants and wildlife together? While sat in my garden, inspiration quite literally flew into view as a ladybird landed on some flowers in front of me, giving me the idea of combining a beautiful floral still-life with my garden visitor.

**GET PREPARED FOR CLOSE-UPS**

Shooting close-ups is an extremely rewarding activity as you’re able to discover, explore and capture an often overlooked miniature world. You’ll need kit that’s able to produce high-magnification images of small subjects within a short distance from your lens. The ideal option is a macro lens, which provides a life-size reproduction ratio (1:1) and a very close focusing distance, allowing you to fill the frame with small subjects. Use a tripod so that you can fine-tune the composition and leave your camera set up in position. It also means your images won’t be ruined by shake if shutter speeds are slow. A small silver/white reflector is handy for filling in shadows, but isn’t essential.

While it’s possible that you may find a ladybird in the perfect position, it’s more likely that you’ll need to find a suitable plant and backdrop, then introduce your ladybird into the scene.

Ladybirds are unlikely to hang around for long, so it’s essential that you have everything ready before you place one on the plant. This is why a tripod is so important – you can set up the camera’s position so the image frame is composed how you like it, prepare the camera settings and then, once you’ve introduced the ladybird, you can start taking pictures. If the ladybird moves, try to coax it back into position rather than adjust the camera.

With close-ups, depth-of-field is limited even at high f/numbers, so make sure you’ve focused correctly. Select a single AF point rather than use multi-point AF, so you can be in control of exactly where the lens focuses. The central point is usually the most sensitive, but you can choose whichever AF point covers the corresponding area of the plant you want to focus on. If your camera allows you to select small groups of AF points, then use this option for added sensitivity.

Start with an aperture setting between f/5 and f/8, then after a couple of frames, take a sequence at different aperture settings to capture images with the background slightly sharper or thrown further out of focus.

Once you’ve captured a set of images that you’re happy with, make small adjustments to the camera angle and see how this affects the image. You may discover an angle that gives a better perspective of the flower or the ladybird, or one that gives a better background.

---

**Ensure a perfect focus**

While AF systems are excellent for everyday situations, they can struggle with macro, so you should be prepared to focus manually if required. If you stick to AF, you’ll improve the chances of success if you switch from multi-point to single-point AF and select the AF point over your subject. Be ready to change AF points if your subject moves. If your DSLR allows you to select a small group of AF points, use it as it’s ideal for this type of image. Finally, select continuous shooting – by taking a sequence you increase the chance of success.

1. **Get set up and ready** With your camera tripod-mounted, position it so that you have the plant you want to use positioned neatly in the image frame. Ensure that it’s well-lit and not obscured by other foliage. Take a test shot to ensure that the plant is focused correctly.

2. **Introduce the ladybird** Gently introduce the ladybird on to the plant. Whether it remains stationary or starts moving is out of your control, but you should ensure that the ladybird is in sharp focus and start firing the shutter immediately before it wanders off.

3. **Make slight adjustments** After taking a few frames, quickly review the images and make any changes that you feel are appropriate. Having reviewed the first set of pictures, I lift the camera slightly so that the stem enters the frame at an angle to improve the composition.

4. **Fine-tune the image** Don’t be afraid to make more changes if you feel you need to. I really like the viewpoint but pull back slightly to add contrast to the background. I also experiment more with aperture settings. This is taken at f/10, which adds slightly more background detail.
Further tweaks gave this result, with the ladybird and plant set against a pleasing blurred backdrop. Not bad for five minutes’ work in the garden!
How to shoot butterflies

Getting great shots of butterflies isn’t as simple as point and shoot – these nuggets of advice will help you achieve brilliant results.

Ross Hoddinott: The warmer, longer days of spring herald the emergence of a whole host of spectacular insects. The skies buzz with bees and acrobatic dragonflies, while among the undergrowth, colourful beetles and other minibeasts busily scurry about. At first, photographing insects might hold limited appeal, but in frame-filling close-up, their colour, beauty and intricate design is revealed. Simply put, bugs make great pictures. Of all the insects, butterflies are unquestionably the most popular and photogenic. Thanks to their colourful and varied markings and graceful flight, most people adore them — even self-confessed ‘insect-phobes’. If you have attempted to photograph butterflies before, maybe at a butterfly house or in your own back garden, you’ll know that they can be challenging subjects. They are easily disturbed, with a nasty habit of flying away just as you are about to trigger the shutter. Even the largest UK species – like red admiral and peacock – only have a wingspan of around 70mm, so to capture frame-filling images a high level of magnification is required. A macro lens is the perfect tool for the job – particularly one with a focal length upwards of 90mm, as this provides a practical working distance.
The perfect choice of optic is a macro lens – but as this is a costly item, it may make more sense to opt for an inexpensive close-up attachment instead, unless you are a dedicated close-up enthusiast. While cost-effective, the big drawback of using either a close-up filter or extension tube is that you have to get closer to the subject, increasing the risk of frightening the flighty insects away. They do, however, provide a great introduction to the fascinating world of close-ups.

At the risk of stating the obvious, before you can photograph butterflies, you first need to locate them. Butterfly numbers are sadly in decline, so you may have to travel a few miles in order to find suitable environments. Different butterflies require different habitats and food plants – some enjoy grassland, while others prefer heathland, woodland or chalky downs. Research is crucial. Spend time reading about butterfly types, where to find them and when. Search the internet for suitable local reserves, or better still, join your local Wildlife Trust and mix with the experts.

It is easiest to find butterflies during the day when they are most active. However, you will probably find they rarely settle or allow you close enough to take pictures. Instead, it is better to visit habitats early in the morning or during the evening when butterflies are less active or roosting among vegetation and tall grasses. Search carefully – always watching where you tread. Still days are best as even the slightest breeze will move the subject about and make it difficult to shoot.

Having located a butterfly, move yourself into position slowly. Avoid disturbing the surrounding vegetation or casting your shadow across the insect – doing so will frighten it away. On cool mornings, before it’s warm enough for the insect to fly, it may be possible to use a tripod. This is hugely advantageous, aiding both pinpoint focusing and considered composition. If you have to shoot handheld, switch on the image stabiliser if you have it, or employ a workable fast shutter speed, upwards of 1/200sec, to eliminate camera movement. Before releasing the shutter, search the background for anything distracting. If necessary, adjust your shooting position to exclude anything that might draw the eye away from your subject. Alternatively, select a wider aperture to help throw background detail out of focus. Do bear in mind that at high magnifications, depth-of-field is naturally shallow. Therefore, in order to keep the insect sharp throughout – and maximise the depth-of-field available at any given f-number – keep your camera parallel to the subject.

Admittedly, photographing butterflies can prove a fiddly and frustrating business. Be prepared to crawl through the undergrowth and put up with lots of ‘near misses’. However, with good preparation and perseverance, you too will soon be taking great butterfly images.

**Close-up attachments**

You can quickly and cheaply transform your standard lens (or a short telephoto) into one capable of capturing great insect images by using a close-up attachment.

**Auto extension tubes**

These hollow rings fit between the camera and lens to reduce the minimum focusing distance without degrading image quality, although they do incur a degree of light loss. Auto extension tubes are compact, light and retain all the camera’s functions. The most common lengths are 12mm, 20mm and 36mm – the wider the tube, the larger the reproduction ratio. For more information on auto extension tubes, see page 28.

**Close-up filters**

These screw onto the front of the lens and act like a magnifying glass. They are inexpensive, lightweight and available in varying filter diameters. They come in a range of strengths, typically +1, +2, +3 and +4 – the higher the number, the greater their magnification. They do not affect normal camera functions, but edge sharpness can suffer, and they are prone to ‘ghosting’, and spherical and chromatic aberration. Maximise image quality by selecting an aperture no smaller than f/8. For more information on close-up filters, see page 26.

---

**Final image**

A large aperture, tripod, reflector = a beautifully sharp shot of a butterfly with a shallow depth-of-field.

---

**1 Locate the subject**

To photograph butterflies, you first need to know where, when and what to look for. For example, a local reserve close to me is home to hundreds of cuckoo flowers – a food plant of orange-tip butterflies. I set my alarm for daybreak and, after careful searching, find a butterfly clinging to one of the blooms.

---

**2 Get into position**

Slowly move into picture-taking range, being careful not to disturb surrounding vegetation. A low viewpoint will often provide the most natural-looking results, so I lay on the ground and use my elbows as support. I select an aperture of f/16 to help generate a wide depth-of-field, but doing so creates a distracting, messy background.
Blur the background To help the butterfly stand out from the rest of the scene, I set a wide-ish aperture of f/5.6 to render the background as an attractive blur. The disadvantage of employing a lower f-number is that focusing has to be very precise due to the limited depth-of-field. To help with my focusing, I carefully set up my tripod nearby and use LiveView.

Adjust the lighting Although the result is better, detail in the wing is obscured by shade. To relieve the shadows, I use a small reflector to angle light onto the butterfly and reveal the beautiful detail in its under-wing. In situations like this, when the subject is static, a reflector gives more control than using flash, and the final result still looks natural.
THE IDEAL COMPANION FOR YOUR DIGITAL CAMERA

THE ESSENTIAL GUIDE TO
PORTRAITS
THE SKILLS, IDEAS & INSPIRATION YOU NEED FOR PROFESSIONAL-LOOKING IMAGES

EXPERT ADVICE
SECRETS OF THE PROS
STEP-BY-STEP GUIDES
IMPROVE YOUR SKILLS
ESSENTIAL PHOTO KIT
AND MORE!

INSIDE

On sale now!
Order your copy direct from amazon.co.uk

MagBooks cover a range of topics, from IT to Motoring, and Fitness to Lifestyle
Insects close-up

Minibeasts can be tricky to photograph at the best of times. On a chilly and windy day, would photographer Ross Hoddinott and reader Andrew Beattie succeed in this macro challenge?

WORDS ROSS HODDINOTT / PICTURES ANDREW BEATTIE
THE CHALLENGER

Name: Andrew Beattie
Age: 44
Equipment: Nikon D300, NIKKOR 105mm VR macro, 18-70mm, 10-24mm, Sigma 70-300mm, reflector, Lee Filters, remote cord, Manfrotto 055CXPro4 tripod.
Website: www.andrewbeattiephotography.co.uk

Andrew says: “I enjoyed taking pictures as a teenager, but only returned to photography seriously a few years ago, when I bought a Nikon D50 – my first digital SLR. I quickly progressed to a Nikon D300 after getting bitten by the photography bug again. I enjoy outdoor photography, particularly landscapes and close-ups. With Ross’s expert guidance, I’m hoping this challenge will help develop my photography further. I want to hone my skills, particularly on finding and using the right clean, uncluttered backgrounds. I also have quite a few questions on technique and equipment to ask Ross!”

F YOU HAVE EVER tried photographing bugs and minibeasts, you will know just how challenging it is. Simply locating subjects in the first place can be time-consuming. Getting near enough to take photographs can also be a frustrating business, with the subject often flying or running away just as you are about to release the shutter. Then there are the technical difficulties to overcome – subject motion, limited light and wafer-thin depth-of-field being among the biggest challenges. It is fair to say that insect photography can soon have you pulling your hair out in frustration! All the hard work is worthwhile, though, when you finally capture a great close-up, revealing the beauty, design, intricacy and colour of the subject.

Considering the challenges involved, the prospect of trying to capture great insect images within just one hour might seem more than a little ambitious. However, this is exactly what we asked reader Andrew Beattie to do when he volunteered for our one-hour nature close-up photography challenge. Summer is one of the best times of year to be photographing insects, so we arranged the challenge for the middle of July – the peak of British summertime. However, instead of being bathed in glorious sunshine, we were greeted with thick cloud cover and blustery conditions on the day. Andrew had travelled down from his home near Bristol to meet me in north Devon at a nature reserve, which is home to a diverse array of invertebrates, such as dragonflies, butterflies and beetles. They all could be found – with careful searching and a lot of patience – in a relatively small area, so it was perfectly suited to the time constraints of the challenge.

Having looked at Andrew’s website beforehand, I knew he was a good photographer, with a passion for close-ups already. He would be using a Nikon D7000 during the challenge, one of the top consumer digital SLRs on the market. Using an unfamiliar camera only adds to the challenge, but being a D300 user already, Andrew quickly felt at home, and was soon scrolling through the menus and setting up the camera to his preference. Being a regular reader, Andrew knew the format of the challenge. I would set him three individual challenges that he would need to complete in just 60 minutes. Considering the difficulty of the subject matter this month, I decided to keep it simple. Andrew would need to capture three top insect portraits – one of a ‘dragonfly or damselfly’, another of a ‘butterfly or moth’ and lastly, a ‘bug or beetle’. However, simple snapshots just wouldn’t do – I wanted technically good, pin-sharp close-ups. “Just finding those subjects in an hour won’t be easy,” Andrew commented.

CHALLENGE 1: Dragonflies and damselflies

Although the challenge is an hour long, the stopwatch only begins when the first picture is taken. Therefore, we could take a little extra time looking for our first subject – a dragonfly or damselfly. They enjoy wetland habitats, so we headed for a small pond on the reserve. Dragonflies can usually be found darting and hunting above the water on warm, sunny days. But the cool, blowy conditions meant few were on the wing. We searched around the pond’s edge, being careful of where we were treading, as careless feet can be fatal to small bugs. Finally, we found a few damselflies, clinging to reeds at the water’s edge.

With the macro lens attached to the D7000, Andrew began slowly moving into position. He already knew to avoid any sudden movements and to be careful of disturbing surrounding grasses or the insects would fly away. A profile shot often works best for damselflies, but unfortunately the reed that the damselfly was resting on was moving in the wind, causing Andrew considerable problems. In situations like this, you have to play the odds – taking a larger series of images to maximise your chances of capturing at least one sharp result. Andrew did exactly that. We reviewed the images, and while some were out of focus, one or two were bitingly sharp. It was a good start. Moments later we found our first dragonfly – a recently hatched common darter. We watched it land on a nearby tuft and Andrew was soon moving into position. Photographers often opt for an overhead view...
of dragonflies, but I suggested Andrew try a side angle. An aperture of f/7.1 was large enough to blur background vegetation, but small enough to keep the subject’s body acceptably sharp. Andrew only had time to take two or three frames before the insect flew away but the results looked good on the D7000’s large LCD screen and we agreed that, in processing, a squarer aspect ratio would work better. That’s the first challenge complete.

CHALLENGE 2: Butterflies and moths
With 24 minutes already gone, there was no time to waste – butterflies or moths were next on the agenda. Butterflies are often flighty subjects and hard to shoot in the heat of the day when they are most lively. However, with the weather being cool and cloudy, they would be less active today – if we could find them! The reserve’s meadows are good for members of the brown family, like meadow browns, ringlets and marbled whites. Marbled whites are particularly attractive and, as we wandered through the long grasses, we noticed a dozen or more flitting about. Andrew spotted one feeding on a nearby flower and he was soon in pursuit. He carefully moved into position, but just as he was about to squeeze the shutter, it flew away! Another unproductive ten minutes passed before we found a marbled white resting among the grass. Andrew knelt down and leaned forward to achieve a low, natural viewpoint. The butterfly remained relatively still as Andrew began shooting, taking the opportunity to experiment with a

TOP: After a long time waiting, a marbled white butterfly emerged to pose for Andrew among the grass.

ABOVE LEFT: Too many surrounding grasses means the background is too distracting and looks messy. Andrew needs to zoom in closer or try a different angle to get a cleaner backdrop.

ABOVE: Andrew moves in tight to the butterfly to capture this unusual but effective portrait.

TOP AND BOTTOM RIGHT: Andrew’s first image (bottom right) of Burnett moths is a little dull. Using a reflector gives the shot more life and impact.

Recommended kit
To capture frame-filling shots of insects, there is no better lens choice than a macro. They are optimised for close focusing and typically offer a maximum magnification of 1:1 life-size. They are available in a variety of focal lengths, with 105mm being a popular choice for nature photography. It provides a practical working distance from subjects, reducing the risk of frightening away timid, flighty insects. The NIKKOR AF-S 105mm f/2.8G VR Micro is the perfect choice. It is compact and lightweight enough to use comfortably handheld. It is also the world’s first macro lens to incorporate Vibration Reduction (VR) technology. Its Silent Wave Motor (SWM) and Internal Focusing (IF) system ensure quick, quiet operation. Optically, it is superb. Camera choice is equally important. A high-resolution model, like the 16.2-megapixel Nikon D7000, allows photographers to capture biting sharp detail. Also, its LiveView function aids focusing and composing images when shooting at low or awkward angles. Its impressive high ISO performance is helpful when using higher sensitivities to generate a fast shutter to freeze subject movement. A good tripod is also essential, as is a remote release. Also carry a small, foldaway reflector and wear waterproof clothing if you expect to be crawling around in damp undergrowth.
THE IDEAL COMPANION FOR YOUR DIGITAL CAMERA

50 PHOTO PROJECTS
Ideas and inspiration to help you capture stunning images

INSIDE
OUTDOOR  INDOOR  PORTRAITS  CREATIVE  PHOTOSHOP

On sale now!
Order your copy direct from amazon.co.uk

MAGBOOK MagBooks cover a range of topics, from IT to Motoring, and Fitness to Lifestyle
few different angles. One of the key factors to shooting good close-ups is capturing clean backdrops free of distraction. Therefore, I suggested Andrew keep to a large aperture of f/4 – combined with precise manual focusing – in order to blur the background. It was difficult prising Andrew away from such a willing subject, but the clock was ticking and I had just spotted a mating pair of Burnett moths. Being rather preoccupied, the moths were very approachable and for the first time today, Andrew was able to use his tripod. While Andrew fine-tuned his composition, I removed some distracting grasses from behind the subject using scissors, in order to create a clean, flattering backdrop. After the first few shots Andrew suggested adding a reflector to help lift the image. Using a tripod gave him more control and stability, but the wind was still causing problems. To ensure sharp results, he waited for lulls in the breeze before triggering the shutter. Job done. However, with just seven minutes now remaining, we would have to work quickly to complete the challenge.

**CHALLENGE 3: Bugs or beetles**
The meadow is full of bugs and critters, like soldier beetles and grasshoppers. Almost anything would do for this last challenge, but typically everything seemed to be hiding. I spotted a few crickets, but they had messy surroundings. Then I spotted a small bug on a hawkweed flower. With time almost up, it would have to do. The insect was tiny, so Andrew would have to shoot near to the lens’s maximum 1:1 magnification to get a decent shot. The greater the level of magnification, the more exaggerated any movement appears. Like any subject, the eyes need to be sharp – if they are out of focus, the shot would be ruined. Depth-of-field was wafer-thin, so the tiniest movement back or forth would result in the point of focus being fractionally too close or far away. Andrew’s first attempts suffered in this way, with the bug’s rear or middle being sharp, rather than its head and eyes. However, it only took another few attempts before Andrew got the shot he was after. The bright yellow flower created a colourful backdrop and, while neither of us was sure what type of bug it was, Andrew had completed the challenge.

**ANDREW’S VERDICT**

“On the day my excitement quickly changed to apprehension, due to the weather. I knew the gusty wind would make it difficult to achieve sharp results and that subjects would be harder to find in the cool conditions. However, you just have to accept that the weather is part of the challenge for outdoor photography. With such limited light, I was grateful for the lens’s image stabilisation, allowing me to capture sharp results when working handheld. I soon felt at home using the Nikon D7000, as it has a similar button layout to my D300. I felt satisfied with my images and pleased with the variety of subjects I managed to capture in what proved a very busy hour! Ross’s help was invaluable, constantly offering advice regarding depth-of-field, lighting and viewpoints – his knowledge is second-to-none on macro. I thoroughly enjoyed myself and picked up lots of tips which will help me in the future. Thanks for a really valuable and enjoyable experience.”

- **ANDREW’S HOTSHOT:** This butterfly was stunning, especially the burnt ochre on her rear under-wing. With care, I was able to get this close-up without her flying away.

- **ROSS’S HOTSHOT:** I’ve opted for another of Andrew’s butterfly shots. I like the unusual angle of this portrait. The insect really stands out against the clean, green backdrop.
Wild flowers

Nature is popular but challenging to photograph. Ross Hoddinott shares his expert knowledge.

OUR MEADOWLAND, hedgerows and woodland are brimming with colour come the summer. Wild flowers reach their annual peak, presenting countless opportunities. They can spring up anywhere, so you shouldn’t need to venture far to find flowering plants to snap. They can be shot using almost any focal length; a wide-angle can be used to capture them within their surroundings; a zoom or telephoto to shoot small groups; and a macro to isolate individual flowers. As a result, regardless of your kit and budget, great shots are within your grasp.

The size, shape, colour and form of our native wild plants vary tremendously, making it tricky to give specific advice on how best to shoot them. The subject, its environment and the light will dictate your approach. However, I guarantee your images will benefit from my tried-and-tested tips.

**Gear up!**

To photograph wild flowers, you ideally need a macro lens or close-up attachment. If you can’t justify the cost of a dedicated macro, consider using either extension tubes or a close-up filter combined with a standard focal length. A telephoto – in the region of 200mm to 300mm – is useful for shooting larger flowers, like orchids. Also, a wide-angle lens can prove handy if you wish to photograph carpets of flowers or images including the subject’s surroundings. Always carry a sturdy tripod to avoid camera shake and aid composition, although if you’re shooting from ground level, a beanbag will prove more practical – along with a groundsheet to lay on. A reflector is another ‘must-have’ accessory. An atomiser (water spray bottle) can be employed to add fine, dew-like water droplets. A polarising filter is useful to reduce reflective glare from foliage and a soft-focus filter can work well in combination with backlit subjects. An angle-finder is ideally suited to shooting wild flowers at ground level. Always focus manually for precision, unless your eyesight won’t permit. Also, if your camera has a depth-of-field preview button, use it to check your selected aperture has generated sufficient depth-of-field. Release the shutter using the camera’s self-timer to minimise camera movement.

1 **USING A REFLECTOR** When photographing wild flowers, I only employ a burst of flash when the fastest available shutter speed remains too slow to freeze movement. Personally, I feel flash ruins an image’s natural feel – destroying subtle colouring and fine detail. Instead, when the lighting is poor, I prefer to manipulate the natural light available. This is possible with the use of a reflector, such as the collapsible, lightweight types made by Lastolite. Alternatively, it is possible to make one by stretching kitchen foil over a piece of cardboard. A reflector couldn’t be easier to use. Simply position it near to your subject and angle to direct natural light onto the area required. The intensity of the ‘bounced’ light can be increased or lessened by moving the reflector closer or further away from the subject. While an essential aid when it’s overcast or while taking pictures in woodland under a thick canopy of leaves, a reflector is also useful in bright, sunny conditions. For example, overhead sunlight will create ugly, harsh shadows that can be lifted by bouncing light onto the shaded regions. A reflector can prove fiddly and awkward to accurately position while taking pictures. Personally, I use a Wimberley Plamp to position my reflector. It is a ball-and-socket segmented arm with a clamp at either end; one end can be attached to a tripod leg, while the other holds the reflector.

2 **GARDENING** Pruning is an essential part of wild-flower photography. Don’t worry, though; you don’t need green fingers. ‘Gardening’ is a term given to the selective removal of grasses and other distracting elements from the foreground and background of the frame. Rarely, in my experience, will you photograph a plant in the wild without having to do some degree of tidying first – unless the subject is filling the viewfinder. The extent you have to garden depends on the environment and f/stop employed. At wide apertures, depth-of-field is shallow; so less tidying is required as the subject’s background quickly drifts out of focus. In contrast, when using narrow apertures, the extended depth-of-field created retains more detail and definition in the subject’s surroundings – making gardening a more fiddly, time-consuming process.

While minor background distractions can be later removed in Photoshop, others cannot without it being obvious in the final image. It is far better to get the image right in-camera. My approach is to first compose the image and set the exposure. I then preview the depth-of-field, carefully studying the frame to identify anything that might prove distracting. If your DSLR lacks a preview facility, take a shot and scrutinise it on the LCD monitor. I then carefully flatten them with my hand or use scissors to remove them. This should be done with care and consideration. Only remove grasses, never cut or destroy other wild flowers. Ultimately, you are striving for a clean and diffused background.

Aesthetically, the difference between a garden and non-gardened image can be striking. While selective tidying might slow down the picture-taking process, unlike other natural-history subjects, wild flowers are not going to move or fly away. Therefore, there’s no need to rush. Remember, what you exclude from the frame can often prove as important as what you actually include.
After gardening
Taking a few moments to tidy up your composition before triggering the shutter can make the difference between an average image and one that really stands out. Your subject isn't going anywhere, so take your time and get it right.
LIGHTING As with any subject, lighting is a key area and the way in which you use ambient light greatly dictates the look of the final image. I often prefer to work on bright, but overcast days. Foliage glare is reduced, colours are more saturated and the lower contrast allows me to capture fine detail that might otherwise be washed out. However, shutter speeds are lengthened in overcast conditions, so a still day is required and a camera support essential. Side or frontal light is fine, but avoid shooting around midday when the overhead sun is harsh. If unavoidable, cast your shadow across the subject to lower contrast and use a tripod and self-timer to trigger the shutter.

To capture wild-flower images with more drama and impact, backlight it. Evening or morning light is best, when the sun is low in the sky and is perfect for highlighting shape. It can create wonderful results – illuminating tiny hairs and detail on stems, and giving petals a transparent appearance. To backlight a subject, you need to shoot into the direction of the light, so there is the risk of lens flare. To avoid this problem, use a lens hood or shield it with your hand or a piece of card. The tricky lighting conditions can easily deceive metering systems, so check images via the LCD monitor and bracket exposure settings.

DEPTH-OF-FIELD The aperture you select, and the resulting depth-of-field, will greatly dictate the look and feel of the final image. There is no definitive rule regarding how much, or how little, depth-of-field is required; this is a decision you need to make at the time of taking the picture, based on the effect you wish to achieve. If you want to draw the eye of the viewer to a specific point of focus, use a wide aperture, like f/2.8 or f/4. If you want to maximise back-to-front sharpness, opt for a high f/number like f/16 or f/22. Your camera cannot predict the effect you desire, so it is important to set apertures manually, rather than rely on one of your camera's automated exposure modes. If you are unsure which aperture will create the best effect, why not simply take a sequence of images with different f/numbers and decide later which you prefer? I did this when I photographed this close-up of a celandine flower. In this instance, I much prefer the images taken with a shallow depth-of-field.
Originality Producing fresh images of common, well-photographed flora is far from easy and too often we record a subject in a certain style or way, simply through habit. In other words, preconceived ideas can stifle our creativity. Digital capture has made it easier than ever to experiment, so be imaginative. Every species has the potential to be shot in an infinite number of ways; it is possible to produce a varied set of images from the same subject by simply altering the viewpoint, focal length, lighting, exposure, background or camera-to-subject distance. Each parameter can have a dramatic effect over the look and feel of the final image. In my experience, it is best to begin by taking the image that is immediately most obvious, then move around the subject and consider different approaches. Try shooting from low and high viewpoints, then vary focal lengths and depth-of-field. Fill the frame with the flower, but also take a shot showing it small in its environment. If it is breezy, use a long shutter speed to deliberately blur the flower. The possibilities are only limited by your imagination. Here, I visited a local woodland where wood anemones grow in large numbers and captured these very different results within minutes.

Here are five of the most popular wild flowers to photograph in the UK.

- Early purple orchid One of the most widespread wild orchids, thriving in woodland, scrub and grassland. Dark green leaves are spotted and the flower spike is pinkish-purple.

- Primrose Familiar perennial of woodland, hedgerows and shady meadows. Also a garden favourite. Flowers are 20-30mm across and borne on long, hairy stalks.

- Bluebell Although a common sight during spring in the UK, bluebells are sparse abroad, with Britain being home to more than 50% of the world’s population. Often found as impressive, dense, photogenic carpets.

- Wood anemone Widespread and locally common woodland perennial. Long-stalked stem leaves are divided into three lobes. Shoot them individually or as large carpets of flowers.

- Foxglove Tall, instantly recognisable flower – common along coast paths, woodland glades and scrub. Its spike bears a succession of pink-purple, tubular poisonous flowers.
THE IDEAL COMPANION FOR YOUR DIGITAL CAMERA

THE ESSENTIAL GUIDE TO
ADVANCED PHOTOGRAPHY
PROFESSIONAL TECHNIQUES FOR SERIOUS PHOTOGRAPHERS

RAW POWER!
HOW TO MAKE THE MOST OF SHOOTING RAW

MASTER YOUR CAMERA & SHOOT LIKE A PRO!
PACKED WITH ADVANCED TECHNIQUES & KIT ADVICE INCLUDING...
FAMILY PORTRAITS / FILTERS / INFRARED / LENSES & MORE!

On sale now!
Order your copy direct from amazon.co.uk
Reader Russell Oliver was sure of a big surprise, as leading natural history and close-up photographer Ross Hoddinott took him down to the woods to get his knees dirty for his first taste of close-up action.

WORDS: ROSS HODDINOTT PICTURES: RUSSELL OLIVER

Photo challenge

Woodland close-up
THE CHALLENGER

Name: Russell Oliver
Age: 41
Equipment: Nikon D80 with several lenses.
Website: www.flickr.com/photos/russolver

Russell says: "I was thrilled when I was offered the opportunity to take part in the challenge. I know that I’ll never get a chance like this again, and it’s amazing to think that Ross is happy to spend some of his weekend teaching me how to take better photographs."

It’s a long train journey from Southend to the heart of Cornwall, especially when you’re stuck in a carriage full of lively, screaming kids. However, in order to meet me the next day, at one of Cornwall’s most beautiful and ancient deciduous woodlands, reader Russell Oliver finished work on Friday evening and jumped straight on a train to Bodmin to take part in this challenge.

After a welcome lie-in, Russ met up with me at the woods. The theme for his challenge was woodland close-ups. I picked a location that was bursting with potential subjects—a variety of wildflowers, emerging foliage, tiny, uncurling ferns and, with a stroke of luck, I hoped we might find an insect or two. Russ wouldn’t be short of subjects, but as we met for the first time and got acquainted with one another, I was keen to explain that the first rule of close-up photography is to look at the world in a different way. I explained to Russ, it is easy to overlook the miniature subjects all around us, but a macro lens will help to reveal their true beauty and intricate design. Russ is still relatively new to digital capture, and had never attempted close-up photography before, so his eyes lit up when I handed him a Nikkor 105mm macro lens to try out. The lens features Vibration Reduction (VR) technology and offers 1:1 (life-size) reproduction. In an instant, it was attached to his Nikon D80 and, after a quick pre-challenge chat, we ventured into the woods.

It was a beautiful, sunny spring day, but Russ and I were both a little concerned about the windy conditions. The slightest subject movement is greatly exaggerated at high magnifications, so this would add to the challenge. We hadn’t walked far before I pointed out a clump of attractive moss. Russ remarked that he would have just walked past it if I hadn’t pointed it out but after years of shooting close-ups, I’m accustomed to looking down towards the ground all the time—and regularly tripping up as a consequence! Once Russ had composed his shot, I had a look through the viewfinder and suggested a few simple tweaks. There were a few distracting grasses in the background, so we gently flattened them, to exclude them from the frame. Also, the moss was in deep shade—a common problem with woodland close-ups. I held a small reflector adjacent to the plant, in order to bounce some extra light onto it. Russ commented on the difference it made, and as he released the shutter for the first time, the hour long countdown began.

Russ had just purchased a tripod with a centre column that can be positioned horizontally, which is perfect for macro work. While he struggled at first to get to grips with positioning it precisely, it wasn’t long before he began to master it. An emerging bluebell was our next subject. I suggested a low, eye-level viewpoint in order to create a natural looking shot and to place extra distance between the flower and its background. I explained that doing so would help to isolate the flower from those behind it. I also told him to select a wide aperture of around f/4, as this would render the flowers beyond as a blue haze. The depth-of-field preview button on his D80 proved handy and the final images on the monitor looked good. After brushing off the mud and dead leaves that we’d acquired from lying on the ground, it was time to move on.

However, Russ was soon lying in the dirt again, as some wood anemone

Recommended kit

For the challenge, Russ was using a Nikon D80 with a Nikkor 105mm f/2.8G micro ED lens. This specialist optic is designed to capture subjects at 1:1, or lifesize reproduction, making it ideal for filling the frame with tiny details, such as the flowers and insects that Russ found in the woods. The fast maximum aperture and Vibration Reduction (VR II) system helps to reduce the risk of blur from camera shake, making it ideal for handheld use. For further information, visit: www.nikon.co.uk

MAIN IMAGE: By selecting a wide aperture, Russ managed to throw the distracting background vegetation nicely out of focus. This helps draw attention to the subject itself.

BELOW: Ross shows Russell the benefits of a collapsible reflector.
Reflectors & VR
Contrast and ugly shadows can ruin woodland close-ups. Rather than use flash to relieve the shadows, a reflector is a useful alternative. Here, Russ manipulated the available light using a small Lastolite reflector. Sometimes it isn’t practical to use a tripod in a woodland environment. In such instances, Vibration Reduction (VR) technology is the perfect solution to minimise the risk of shake.

ABOVE: Russ spotted these two tiny ferns. Their shape and form made them the ideal close-up subject.
RIGHT: Time was running out as Russ selected a low viewpoint to create a natural looking image.
BELOW: Russ focused on a fallen branch and threw the bluebells out of focus.
The Essential Guide to
CREATIVE PHOTOGRAPHY
INVENTIVE TECHNIQUES AND ORIGINAL IDEAS FOR ENTHUSIASTS

On sale now!
Order your copy direct from amazon.co.uk
caught his eye. These delicate, white flowers grow very close to the ground, so the use of a tripod was impractical, so it was time to test the effectiveness of the VR system. The plants were badly wind blown, so conditions were awkward, but the backlit flowers looked good close-up. Russ waited for a lull in the breeze before taking each shot. After a few frames, we checked the images on his LCD monitor. The flowers were sharp and shake-free, which was a huge relief.

Over half an hour had passed already, so there was no time to waste. With the VR switched on, Russ shot some vibrant, backlit beech leaves, and then a single yellow celandine flower. While I was still making suggestions regarding potential subject matter, Russ needed less prompting – his eyes were now tuned-in to the miniature woodland world. “Do you think these little ferns would make a shot?” Russ asked, pointing to a group of hard ferns that were starting to unfurl. Before I’d even finished saying yes, Russ was getting up-close and personal with the tiny plants. A little ‘gardening’ was necessary to create a clutter-free background, but this isn’t a problem as long as the photographer is considerate and doesn’t actually snap, remove or damage any plants. I could tell from his comments that Russ was growing fond of the macro lens, with its sharp images and wide maximum aperture, it allows for some very interesting effects using a shallow depth-of-field. Thankfully, Russ had remembered to bracket his aperture settings – something I had suggested earlier, to increase the chance of an image with just the right level of depth-of-field. A good habit which all macro beginners would be wise to do.

“I can’t believe how much my body aches”, he said, but it didn’t stop him from getting down low again to shoot a clump of wild garlic. Unfortunately, a glance at my watch told me that we’d overrun by a couple of minutes. “It’s time to stop shooting Russ, the challenge is over. And sorry, but no; you can’t take that lens home to Southend!”

**RUSSELL’S VERDICT**

“I’d never have guessed there was so much to consider when shooting close-ups. Finding a good specimen, in good light and with a good backdrop, gardening where required; using the reflector; depth-of-field and manual focus… Eek! Despite Ross’s continued exhortations to try different apertures and experiment with depth-of-field, I was very taken with the fast end of the lens and the wickedly shallow depth-of-field that it provided – so much so that I missed a couple of opportunities to improve some of my shots – but it was a great lens to play with, and so sharp. Thanks to Nikon for the loan! Overall, I had a fantastic afternoon and it was a great challenge. I’d like to pass on my thanks to Ross Hoddinott, who was so knowledgeable about the subject matter as well as the techniques, and so enthusiastic. I can’t wait to get my own macro lens and head out into some nearby woods, so I can try to improve upon what I’ve learnt today.”
Wonderful water

Water is one of the most versatile elements in a close-up photographer’s arsenal and can be used in countless ways to produce interesting and unusual compositions. Whether you’re shooting an individual drop, freezing it or capturing water in motion, this section provides the skills and ideas you need for brilliant results.

Image: Joss Holdstock
Tiny water drops

For when it’s too wet and windy to shoot macro subjects outdoors, close-up specialist Sharon Johnstone shows you the perfect indoor technique.

Sharon Johnstone: Photographing water drops is one of my favourite subjects. At various times of the year you will often find me crawling around on my hands and knees photographing grass and moss covered in early morning dew drops. If I’m shooting indoors, I love the challenge of finding things I can spray with water instead. Cacti plants are something a lot of people have at home or can buy very cheaply at their local garden centre. Look for the variety with soft hairy spikes as the water drops cling beautifully to these.
Suggested kit

It's easy to obtain great results with this technique without breaking the bank. A flashgun or dedicated macro flash will allow you to shoot handheld, but you can use windowlight and a tripod as an alternative. Dedicated macro lenses offer great performance but macro filters and extension tubes are the ideal budget solution. All the rest of the kit needed to practise this technique can be found around the home!

Shooting indoors is also a great excuse to experiment with backgrounds. Things like coloured card or even wrapping paper work well. With macro photography you don't need large expensive backgrounds. These kinds of water droplet shots are very simple to do. You don't have to use a lot of expensive kit either, a macro lens with extension tubes to increase magnification will do. The more tubes you use, the greater the distance from the camera and lens and therefore the greater the magnification.

I used a 60mm macro lens, but you can get similar results using a 50mm prime and extension tubes. I also used a dedicated macro flash; the Canon Macro Twin Lite MT-24 EX. It has two flash heads on a ring that give amazing flexibility in getting your lighting where you need it. However, a flashgun, natural window light or even your camera's built-in flash can all be used to obtain fantastic results – this is one type of image where your technique counts for a lot more than the kit that you use.

1 SET UP Position your equipment by a window but if you can't do that, experiment with other light sources like lamps, torches or bounced flash. You don't need big expensive backgrounds, coloured card or even wrapping paper works well.

2 PLACE THE DROPS Fill an old spray bottle with water, making sure it's rinsed well beforehand. Apply a fine mist of water to the cactus, being carefully not to saturate the bristles. If you apply too much water, just give the plant a shake to remove some of it.

3 APPLY CAMERA SETTINGS In manual mode set your aperture to around f/4.5 to f/5.6 to create interesting background bokeh from out of focus water droplets. If you use a tripod, shutter speed won't matter too much. Select a low ISO for good image quality.

4 SWITCH TO MANUAL FOCUS It is always a good idea to switch to manual focus for macro work as the autofocus will often struggle. Focus carefully using LiveView, if you have it, to zoom in closely to make sure your image is sharp and focusing spot-on.

A prickly affair

Tiny water drops precariously balanced on the finest of bristles look incredible in close-up! Exposure: 1/250sec at f/4.5 (ISO 100)
Common problems to photographing water droplets

1) NO MACRO
You don’t have to splash out on dedicated macro kit. Use extension tubes or macro filters as a cheap alternative. Check out the Raynox DCR-250 Super Macro lens (see page 156).

2) SHAKE
This is a common problem with shooting handheld. If you are struggling to get a sharp image try using a tripod. Watch out for any gusts of air moving the bristles during the exposure too.
Rainy-day refractions

Macro maestro Ross Hoddinott produces creative close-ups using a picture of an umbrella and the condensation on his window

Ross hoddinott: We often endure miserable wet weather in the UK, so this subject matter seems quite apt for a rainy day macro project. When the Digital SLR Photography team challenged me to shoot an image with an umbrella, I put my thinking cap on...

The logical approach was to combine the umbrella with a ‘water’ theme; however, I didn’t want my image to be too predictable or clichéd. Then, as I left the house the next morning, inspiration struck. Our porch suffers quite badly from condensation and, in the morning, the windowpanes are often smothered in tiny beads of water. Water droplets act like tiny lenses, so if you photograph them close-up, with an object in the background, a miniature reflection of that object will appear in each and every drop. The results can look striking and I thought that the effect might be well suited to the umbrella theme.

The biggest challenge would be working out how to do this effectively. I knew that if I simply positioned the umbrella the other side of the windowpane, it just wouldn’t stand out enough. To solve the problem, I decided to photograph the umbrella against a clean white backdrop. I printed the result on a sheet of A4 photo paper – it would be this image that would create the reflections of the umbrella in my final shot.

The next morning, our porch windows were dripping with condensation, but this time, I was pleased. I studied the drops – the bigger they are, the clearer the image of the umbrella. I then set up my tripod outside, looking in, being careful to position my camera so that the sensor plane was parallel with the window. I was using my macro lens close to its maximum 1:1 magnification, so the depth-of-field would be limited. I positioned my print upside down (so the reflections were the right way up) inside the porch, just the other side of the droplets, using a plamp. Through the viewfinder, I could see the image of the umbrella in every drop. I adjusted the position of the print, to centralise the image in the water drops, and began shooting, experimenting with composition and trying vertical and horizontal formats.

On my PC, the results looked OK, but numerous specks of dirt were visible. I cloned these out in Photoshop, and added a cool blue colour cast, using Colour Balance and Hue/Saturation, to emphasise the feel of the water.

I’m pleased with the final result, and hopefully the shots will be quite different to what the others produce. Also, I managed to do it all without opening the umbrella indoors...

ABOVE AND LEFT: The print on photo-quality inkjet paper added contrast, and made the shot easier to set up without an assistant.

SET-UP: I used the plamp to hold the paper in place, parallel with the sensor of the camera, to maximise depth-of-field.

ABOVE AND LEFT: Having cloned out the specks of dirt, and added the colour cast, I was pleased with my final image.

ABOVE IMAGES: I tried several compositions in both landscape and portrait formats. I also turned the paper around and moved it to an area containing more water drops for a better effect.
Retro refractions

Got 15 minutes? Grab a glass of water, two sheets of card and your lighting kit – that’s all you need to achieve this striking still-life.

Caroline Schmidt: Looking for a simple still-life to try on a rainy afternoon, or as part of your 365+ project? We’ve got the one. There are dozens of ways you can employ the refraction of light in your images, from floral water droplets to landscapes through glass spheres, but this has got to be one of the most striking and simple to do.

Lighting the glasses requires a bit of care and technique to minimise reflections from the surroundings, but after that it’s a really easy shoot that has scope for some creative output. Instead of monochrome, you could spice it up with a vibrantly coloured split background or take it a step further and use multiple water-filled glasses. For a simple but striking still-life idea, why not use three wine glasses instead of one? Fill the two background glasses with red wine and white wine and position the water-filled glass symmetrically in front. If you don’t want to waste wine (as some might call that alcohol abuse), opt for Ribena and vegetable oil instead for the same result.

Alternatively, fill three glasses with food-dyed water for your background instead. Always opt for an odd number of glasses, such as three at the back with two water-filled glasses at the front, for more pleasing compositions. You also want to use clear glasses with smooth surfaces so that the light can bend evenly around, rather than textured or tinted glasses that might hinder the refraction and enhance distracting reflections.

So how does it work? By filling a glass with water, you’re causing any light waves that hit the glass at any angle other than 90° or 0° to change direction as they pass through. These light rays refract (bend) giving you the result. Thankfully, you don’t need to know the physics to take good photographs.

1) Remove marks
Even with careful polishing, you’ll find you still need to clean up the picture. Zoom into the image to 100-200% using cmd and = (Mac) or Ctrl and = (PC) and use the Healing Brush Tool or Clone Stamp Tool to get rid of any dust spots, smudges and water drops. To do this, click alt to select an area to sample from and click or brush on the mark that you want to remove.

2) Adjust contrast
To give the image more impact, try boosting the vibrancy and contrast. To do this, go to Layer> Adjustment Layer> Levels or Vibrance. In Levels, manually adjust the sliders or use the White Eyedropper Tool to click on the brightest part of your image. Alternatively, duplicate the image layer in the Layers palette and change the Blend Mode to Soft Light.

Common errors to watch out for...

1) DISCONNECTED LINES
Part of the success of this shot hinges on the line in the background matching up with the line running through the glass. Experiment with the glass and the camera’s positioning to get this right.

2) LACKING DEPTH-OF-FIELD
To avoid any visible paper texture but to get the glass’s rim and line in focus, depth-of-field is key. The closer the background-to-glass and glass-to-camera distances are, the narrower your aperture will need to be.

3) REFLECTIONS IN THE GLASS
It’s all too easy to get unsightly reflections if the light source is not diffused enough or too far in front of the subject. Try moving the light further behind the glass, adding a softbox and make sure surrounding lights are off.

Alternative set-up

If you don’t have a light tent, you can attempt this technique using a table and two studioflashes or flashguns with softboxes, positioned either side and behind the glass at 45° to minimise distracting reflections. Try to remove all reflective materials from the surrounding area, close any curtains and turn off unnecessary lights to avoid casting reflections. You may find black scrims help, too.
Final image
A quick crop at the bottom of the glass's stem to remove the base and you've got yourself a striking mono still-life. Exposure: 1/250sec at f/14 (ISO 200)
Get close-up on ice
Ross Hoddinott demonstrates how you can create photogenic ice patterns, simply and easily, without even having to venture outdoors...

Ross Hoddinott: After a hard frost, the landscape is completely transformed. Grasses, leaves and branches glisten like jewels in the morning sunlight and ponds and puddles freeze over, creating photogenic ice patterns. This is a great time of year to shoot eye-catching close-ups, but with our winters growing increasingly mild – especially in the south of the UK – capturing wintry images is becoming more and more difficult. Also, the chances are that when ‘Jack Frost’ does finally pay a visit, it will be on a day when you have to work or drop the kids to school, meaning you miss out on taking some great seasonal close-ups. Why not cheat instead and create your own ice textures to photograph? This is easily done, by simply placing water in your freezer. The results can be stunning and you don’t even have to step foot outside the warmth and comfort of home.

1. PREPARE THE ICE You cannot control the way the water will freeze. If you are lucky, interesting detail and patterns will appear naturally. However, if you find that your ice is void of trapped air bubbles, swirls and interest, then try pouring a small quantity of hot water on the ice. This will cause cracks to zigzag across the ice, which can look striking in close-up. Refreeze the water before you photograph it.

2. USE WINDOW LIGHT It’s best not to employ flash when shooting a reflective surface such as ice, as it creates ugly catchlights. Instead, simply place the dish on a table-top or on the floor, in front of a window. The natural light filtering through should provide sufficient light. Use a tripod to support your camera overhead, parallel with the dish. Fill the viewfinder so as not to include the edges of the dish.

3. GET CLOSER Details within the ice are quite small, so you will need a high level of magnification to isolate trapped air bubbles, patterns and cracks. A +4 close-up filter will do the job, but a macro lens will work even better if you have one. In this instance, I moved nearer the ice to isolate an area of interest. Using Auto WB, the image looked monochromatic, but I wanted the shot look cooler.

4. WHITE BALANCE We associate ice with winter, so to make your ice pattern look cooler and more natural, deliberately mismatch your digital SLR’s White Balance setting to create a blue colour cast. Use a fluorescent or incandescent WB preset – the equivalent of 2800K to 3400K. I manually selected 3000K. You would never guess from the result that it was taken in the warmth of my home.
TOP TIP
CHANGE THE COLOUR
Placing a black background beneath the dish produces natural-looking results, whereas blue will make the image look cooler. Try greens and reds for more surreal and unusual looking images.
How to shoot raindrop patterns

Rain might often be the cause for ruining a day’s photography, but the potential a shower leaves behind can be used to create some interesting still-lifes, like this abstract for instance.

Daniel Lezano: When in the mood to head out and take pictures, nothing’s more frustrating than having plans washed out by a heavy shower. Sure, the rain may be good for the plants, but that’s little consolation. What is, however, is being prepared to grab some great images shortly after the showers have finished. The idea for this simple abstract still-life came about after a short but heavy downpour, which had left large globules of water on a car. It had just been washed and waxed, so the raindrops coagulating into relatively large, thick droplets.

Like other ‘found’ still-lifes, this is a relatively easy one to photograph, as you don’t have a huge amount of preparation to do. However, there are some factors that you need to consider. The first is that the metallic bodywork is going to reflect anything in the surrounding area, so you need to park your car in a location where you can shoot from a direction that excludes buildings, lampposts and so on, and only includes the sky. You also need to shoot from an angle that excludes yourself, too, so rather than stand right over the bonnet looking down, shoot from a slight angle. If your camera has a vari-angle LCD monitor, this can come in useful.

You’ve little to worry about in terms of the exposure as this is a very simple subject to shoot. Your main concern is ensuring the reflective nature of the car doesn’t cause underexposure. A quick test shot will confirm whether or not you need to apply exposure compensation of +1EV (one stop). Use aperture-priority mode and set f/8-11 for a good level of depth-of-field and optimum lens sharpness. If the shutter speed is too slow and risks shake, use image stabilisation and/or raise the ISO rating. We’d suggest a maximum of ISO 400, otherwise you risk introducing noise into the image – if shutter speeds remain slow, consider using a slightly wider aperture setting.

Recommended kit

- LENSES: Any lens that has a reasonable close-focusing distance is suitable. If you’re using a DSLR or CSC, your standard kit zoom is more than sufficient. If you want to isolate groups of globules, then a macro lens enables you to get closer.
- CAMERA: You can use almost any type of camera for this technique. A digital SLR or CSC gives you the most options in terms of lens choice and image quality. That said, digital compacts and smartphones are capable of giving excellent results.
- POLARISING FILTER: A polariser eliminates reflections and is worth trying out to see how it affects the final results. Although best used in sunny conditions, give it a go even if it’s cloudy to still see an affect. Bear in mind you’ll lose two stops of light, so keep an eye on shutter speeds.

CHECK EXPOSURES: If your car is white or black, you may need to use exposure compensation to avoid under- or overexposure.

UNWANTED REFLECTIONS: Don’t lean directly over to frame the droplets, otherwise you risk including yourself in the reflections.

IMPROVE YOUR OPTIONS: Using LiveView allows you to stretch further over the bonnet without your reflection being included.

AVOID WIDE APERTURES: Shot at an angle using f/3.5, the limited depth-of-field is evident so use a mid-aperture like f/8-11.
Create a triptych of water abstracts

If you’ve captured a set of images you’re happy with, a great way of presenting them is to create a triptych. To do this, crop each image into the same format and resize them to the same width (Image>Image Size). Here we’ve done it 5in wide. Open a new file (File>New) and select Paper Size A3. To help position the three images, access rulers (View>Rulers) and drag the guides from the rulers, placing them 5in from the top and bottom, 2in from the sides and one at the canvas’ centre to aid image alignment. Selecting View>Snap means when you open your images and drag them using the Move Tool into the rough position you want them on the canvas, they’ll snap into place automatically. You’ve now a basic triptych from which you can add borders, resize, crop or print to your heart’s content.

Abstracts often work better displayed as a set rather than as an individual image so spend some time looking for a variety of compositions and adjust focal length or camera-to-subject distance to make droplets larger or smaller in the frame. A neat border around each image adds a finishing touch and once you’ve created your triptych, visit a department store or art shop for suitable frames.

Top Tip

Recreate the Rain

If it’s been a dry spell and you want to try this out, prepare your car by using a hosepipe or bottle of water to douse your car and create your own raindrops to order!
**Fruit shoot**

Jordan Butters tries putting a refreshing spin on a water splash technique

**Camera:** Nikon D800  
**Lens:** NIKKOR AF-S 24-70mm f/2.8G ED  
**Software:** Adobe Lightroom 4 and CS5

*Jordan Butters:* No one will admit it but the challenges the Digital SLR Photography team set each other makes us all competitive. When we see the other’s attempts we smile and say complimentary things, but listen carefully and you can hear the muttering of, “Why didn’t I think of that?” It’s turning into a very serious business indeed.

It seems whenever a photographer shoots fruit they get the urge to throw it in water or throw water at it? I’m no different. I decided to opt for a mid-air collision so it seemed like the fruit was so full of juice that it was literally bursting out. With a vision in mind, I set about working out how to achieve it. I thought about capturing the action in one shot to keep Photoshop work to a minimum, but decided it wasn’t going to be viable – throwing pieces of fruit and water into the air from different directions all at the same time would result in nothing more than a big mess to clean up. So I broke the shot down with a view to composite the images together – the only way to get the effect that I was after and retain my sanity.

My lighting comprised three flashguns; two Nikon Speedlight SB-700 units and a budget model bought off eBay. I positioned the first flashgun facing the camera and fired it through a standard circular diffuser at half-power to blow the background out to white for that clean studio look. I then fixed a broom handle between two light stands from which to hang the apple. After dangling the apple, I set up the second flashgun in a small softbox to the right of the camera and, with the D800 set to its maximum sync speed of 1/250sec, took some test shots to establish an aperture of f/19 at 1/4 flash power. I then moved on to the final flashgun, which was positioned behind the apple to the left and set to 1/16 power to add a highlight to the edge of the fruit.

The first step was to shoot the splashes. I placed a tarpaulin down and positioned a bowl to catch the water and, with my D800 manually focused and on a tripod, I used a cup to throw the water upwards at the fruit, triggering the camera to coincide with the splash. It took a few attempts to get the timing right, but I got the hang of it and was consistently capturing decent splashes. Once I had enough splashes captured, I moved on to shoot the chopped fruit.

After cutting the apple up into pieces, I used cocktail sticks to compose them however I wanted them to appear. It’s surprising how soon fruit starts to brown at room temperature once chopped so, working quickly, I placed the fruit on a plate and at a surface of a similar height to the hanging fruit. Finally, I used a small white piece of foam board as a reflector to lift the shadows at the bottom of the fruit while capturing the shot.

With all images imported into Lightroom, I picked the best splashes and opened the chopped fruit Raw file in Photoshop. After removing the plate, I used the Clone Stamp Tool to remove the cocktail sticks, leaving the fruit on a clean backdrop. One by one, I opened up the splash shots and used the Lasso Tool to select the elements of water that I wanted to use before pasting them onto my image as new layers. I used the Transform commands to position and rotate the water splashes before adding a Layer Mask and using the Brush Tool to hide unwanted elements. I added a Levels adjustment to each of the layers to match the lighting with the main apple image.

Once happy, I merged all of the layers into one and duplicated this layer before desaturating it and applying a High Pass filter. I then changed the Blend Mode to Soft Light and reduced the Opacity to sharpen. Voila – a juicy fresh fruit image!
Water droplets

Adding water droplets can give visual interest to flower images – it’s easy when you know how

Daniel Lezano: With so much rain falling in the UK, especially in the last few years, producing a guide to mimicking raindrops could be deemed a little odd. Unfortunately, most of our rain falls during the colder months when garden flowers are sparse, so with fewer showers during the summer, the only way to photograph raindrops is to create them ourselves.

This can easily be done using a water spray bottle, a watering can or garden hose. If you’re using one of the latter two options, be sure that the nozzle has an attachment that sprays water, rather than one that provides a heavy stream that could damage delicate plants.

There are a number of different ways that droplets can settle on garden foliage, each providing the opportunity for a different type of image. One of the most popular is capturing droplets hanging off a stem, usually in groups of two or three. This is an effective technique that has an added dimension if there are flowers nearby that can be refracted in the droplets, as seen in the image above. If you want to try this technique, then turn over the page to find out how. The other favoured image is a far simpler one, but equally pleasing, and requires you to cover the surface of a leaf or petals with dozens of small droplets by spraying them with water.

For this step-by-step, I wanted to try a technique that I’d not seen before and that was to create a single droplet that rested on a flower, rather than hanging from it. My chosen flower was a purple allium, one of my favourites to photograph due to the intricate nature of its multi-flowered bloom. As I’ll be moving around trying different angles, I’m shooting handheld and using a 100mm macro lens to help me get close. The bright sunlight means avoiding camera shake won’t be a problem, but the odd breeze means I need to keep shutter speeds relatively high to avoid blur caused by the subject’s movement during the exposure. I use aperture-priority mode as I want to retain close control of depth-of-field.

One final point: droplets tend to form more easily and hold their cohesion better on humid days when there is more moisture in the air. Therefore, if a summer storm is brewing, head into the garden and you’ll find this technique easier to achieve than on hot, dry days.

1 Place the water Try applying a light dusting of water on the flower using a spray to see the effect it has. Unfortunately, on this type of flower, I find the spread of water is good, but the droplets are just too small and not large enough in the frame. I need to find an alternative!

2 Experiment I try using a hose, but the result is the same. I decide I need to apply a larger drop with more control and attempt to do this using a straw dipped into a jar of water. By using my finger on the end of the straw, I do my best to control the release of water onto the allium.

3 Keep trying It takes a few attempts, but I eventually manage to settle a large droplet of water on a flower. It’s proof that with a little patience and luck, the straw method can work. This particular droplet is too large, so I shake the allium and keep trying until I manage to do better.

4 Find your viewpoint It takes a few more attempts, but I have a droplet that is a more suitable size. Now it’s a case of trying to find a good viewpoint and the best aperture setting. I start by shooting from above, but the result is flat, so I shift my position and look for alternatives.

5 Get eye-level with the subject Adopting a slightly lower viewpoint gives the image more three-dimensionality and the droplet is clearly visible due to the shallow depth-of-field. However, the out-of-focus foreground is distracting and the dark backdrop is unattractive.

Refraction in droplets

Want to try out this alternative approach? Turn to page 92 to find out how to refract images.
By shifting my position slightly higher, I’ve made a dramatic improvement to the composition. Not only does the subject now dominate the frame, the foreground is less cluttered and the green vegetation in the background is far more appealing. The aperture of f/8 provides the perfect amount of depth-of-field, too.
Creative close-ups

Shooting at high magnification gives you the opportunity to try all manner of creative compositions, abstract ideas, skilled techniques and post-production methods. In this section we provide you with ideas and inspiration that you can try out yourself to expand your possibilities for creative close-ups.
Moments in time

Time-lapse photography is a trend that’s exploded with HD video, but it can also be a way of compiling fractions of time into artistic still images too. Read on to find out how...

Caroline Schmidt: For those that don’t know, a time-lapse is a series of still images placed in sequence to create a moving picture – a bit like a digital flipbook. While it’s not a new technique, it’s certainly getting more popular as technology makes it easier to create and present on the web. The Nikon D800, for instance, has a dedicated time-lapse photography mode that creates the video file for you, so there is no need create it on your computer. But for those of us who don’t have that flashy function on our camera yet, we’ll be doing it the old-fashioned way and using the trusty interval timer. We can then select the key frames that best illustrate the movement or changes in the subject to create a series. If your camera lacks an interval timer, you’ll find it on some remote releases, such as the excellent £70 Hahnel Giga Pro II.

Diptychs, triptychs and montages are brilliant tools for photographic storytelling, which is why they’re ideal for showing a time-lapse. Use it to illustrate a period of time or activity – the transition from morning to night, young to old or a quick succession of actions like popping bubble gum or changing expressions. There’s a huge variety of subjects you could shoot, from landscapes and portraits to still-lifes. Some lapses may be best taken over days, minutes – even nanoseconds, so you’ll need to adjust you settings appropriately. However you shoot it, you’re likely to end up with dozens of pictures, many of which show changes barely noticeable by the human eye. These small changes are fantastic for a movie time-lapse as it speeds up the transformation, but less effective for still images. To make the lapse obvious, you need to pick out frames that show the key stages of transition.

Peonies are beautiful summer flowers and some might say ideal for this technique: they start off as large, tight buds and open to become a multi-layered flowers. Any flower that opens can work, like a rose or lily: ask your local florist to help you select a flower that’s likely to open within a couple of days. I tried several time-lapses for this tutorial: some took just a day others up to two weeks of waiting, so be sure to have empty memory cards and charged batteries to hand for when you need to make a quick swap.
1 Compose the image
Try to visualise how you want your final image to look; it will help you to set up your shoot. I want to create a montage of images against a black background, so I attach black construction paper to a window and on the windowsill where the flower sits. This also helps to control the window light so it falls on the head of the flower, rather than side-lighting it and illuminating its undergrowth. Compose the picture to make sure there’s enough space around the bud for the flower to open so that you don’t cut off any petals. If you can supervise the time-lapse a little, you may be able to change the height of the tripod as needed to expand the frame, but be careful not to adjust the angle.

2 Set camera modes
As you may be photographing your subject for a number of hours, even days, you don’t want to have to oversee the entire shoot; you need to set up your camera equipment to be self-sufficient. Start by setting your camera to aperture-priority mode so that when light levels change the camera adjusts the shutter speed to keep the exposures consistent, and pick an aperture that will get enough of the subject in focus when it begins to move and changes depth. Set your camera to single-point AF and focus on the centre of the flower as this is where it will open from. Set the metering to spot: this way only the flower head will be exposed correctly, darkening the surroundings even more.

3 Set interval timer
Having taken a test shot, you may find that you need to add a stop or two of positive exposure compensation to help illuminate the flower a bit more. When you’re happy, switch from AF to manual focusing to stop the lens from hunting part-way through the lapse and access the interval timer mode (see your camera’s manual for details). Here you can set the number of shots you want the camera to take and the interval between each shot. I set mine to shoot one image an hour for ten hours. I then reset the timer after this period if the subject hadn’t completed its transition and continued the routine for as many days as it took, carefully adjusting the tripod to refine composition when needed.

4 Adjust White Balance
You’ll probably end up with lots of pictures: most of them you’ll discard. First put the images you think show the key moments in the subject’s transformation in a new folder, then open them in Adobe Camera Raw. Click Select All and use the White Balance Tool or White Balance presets to streamline the WB. Click through the images next, pressing Backspace to delete any you don’t want. Six, nine or 12 are a good number to be left with. Look at how the subject is lit, too, and try to select images that look similar. Frames taken in the early morning or late afternoon will have softer shadows than frames taken around midday. Ideally, you’d have overcast conditions so all the frames look consistent.

5 Piece images together
Create a new canvas by going to File> New and select A4 as the size and Black as the background colour. Now open your first frame in the series and using the Move Tool, click and drag the image on to your new background layer and position it in place. To resize the image, hold down Shift while you click and drag the corner of the bounding box. Repeat this step with all of the remaining images to create a multi-layered image and your montage. Try to space the flowers out evenly across the canvas; don’t worry if you see the lines around the images or unwanted leaves, we’ll be getting rid of these in the next couple of steps.
Edit the flowers
You could retouch each flower image before adding them to the background canvas, but I find it’s easier to make each flower look the same in terms of colour and contrast if I can see and compare them all on the same canvas. Start by adding a Levels adjustment layer (Layer>New Adjustment Layer>Levels) and drag that layer above the image layer you want to edit in the Layers palette. Now click on the line between these two layers while holding Alt to link them together. Any adjustments you make now will only affect the image layer that it’s linked to. Repeat this for each image layer until you’re happy with how each flower looks.

Paint in the background
To remove lines and leaves, click Add new layer at the bottom of the Layers palette. Make sure the new layer is at the top of the palette and use the Brush Tool with Foreground Color set to Black. Choose an appropriate sized brush for the area you want to hide, with the Hardness set to 0% and Opacity 100%. Now, with the new top layer selected, ‘paint’ over areas of the background to make it uniform. Use the Eraser Tool if you make a mistake. Using a single coloured background, like this, makes post-production much easier if you want to blend subjects into one canvas. If your backgrounds vary, simply align the images in a grid format instead.
Light as a feather

Still-life subjects are ideal for practising your creative close-ups as you’ve the time to experiment with core elements: lighting, composition and focus, as Caroline Schmidt shows with this tutorial.

Caroline Schmidt: The delicacy of feathers lend themselves well to macro photography, whether it’s colourful veined or white fluffy down feathers: each offers beautiful potential for close-ups. The spectacular spectrum and patterns of peacock feathers undeniably give you striking photo opportunities, depending on the type and angle of the light, as well as the lens you choose: The tiny barbs become iridescent in the right light. If you opt for strong direct sunlight, or flash, you’ll get a vibrant shimmering feather; use diffused sunlight and your colours will be soft and painterly with little contrast. A slight shift in the feather’s angle to the light can transform your images from smooth tones to sparkling bokeh. When working with a macro lens, fill the frame with your image to utilise the 1:1 magnification but that means, with a prime lens like Sigma’s 105mm f/2.8 macro, you need to get as close as the lens’s minimum focusing distance will allow. As you may only be centimetres away from the subject, depth-of-field will be extremely shallow and light levels low, so use a tripod to prevent shake. While a feather can make a beautiful image on its own, adding a droplet can provide a necessary focal point when you’re working with shallow depth-of-field. It’s best to use saline solution rather than water for this, as it keeps its form for longer, but be careful as you wipe the feather afterwards as the solution can alter the feather’s pigment if left for too long.

The placement of the droplet, the angle of your camera and the droplet to the light is also very important, as whatever is behind the droplet gets refracted inside it. If that’s a window or light bounced off surrounding objects, then you’ll get a messy reflection. You may need to flag the light using black card, alter your position and remove items from around your set-up. You may find that as the light changes subtly the resulting image changes considerably, so be prepared with patience, passion and creativity.
SET-UP. Aside from your basic macro camera kit, you don’t need much for this shoot: a window, a table and saline solution. To create contrast, position the feather approximately 45° to the light. It’s worth trying this tutorial in different lighting conditions as you’ll get dramatically different results. In terms of camera settings, select aperture-priority mode and start with a mid-aperture of f/5.6–f/7. Select manual focusing or single-point AF so you can control your focus point and compose your shot, spending time considering viewpoint. The best compositions are those that have the droplet placed on an intersecting third of the frame. It’s imperative that you pay particular attention to the reflections in the droplet so you only have a clear refraction of the subject, without reflections from the light or surroundings.

FOCUSING. You may find that at short focusing distances a lens struggles in autofocus, especially if the image is low in contrast. If tweaking your set-up slightly doesn’t fix the problem, switch to manual focus. Your aim is to get the droplet sharp, so you’ll need to select an aperture to give you enough depth-of-field (f/5.6–f/8). Using centre-weighted metering and focusing on the reflection inside the droplet has given the best result here. As you adjust the angle of the feather to the lens, you may also need to adjust the aperture: the more of an angle the feather is to your camera, the narrower the depth-of-field and the smaller the aperture you’ll need to retain sufficient focus. Similarly, if you decide to include more than one droplet, you’ll need to stop the aperture down to at least f/11–f/16 to get the multiple planes of focus sharp.

Alternative technique

Not only do macro ringflashes, like this Sigma EM-140 DG Macro, offer more light when daylight is limited, but when it comes to shooting peacock feathers it gives a different effect entirely to natural light. As the tiny hairs of peacock feathers reflect different wavelengths of light, by incorporating various light sources and adjusting the angle of the feather, you can capture its iridescence and turn create bokeh. Some macro ringflashes, like the Sigma, can work with your camera’s TTL metering, but all have manual settings if you prefer to take control. The Sigma EM-140 DG Macro has two filaments, which you can control the output of separately to create contrast. For this shot, I manually set the right filament to 1/8 power and the left to 1/4 power. Unfortunately when using flash, you can’t avoid the catchlights in the droplet so you’ll either need to remove them in post-production using the Clone Tool, which is easy to do if you’ve avoided other unwanted reflections, or remove the droplet entirely from the image.
Macro help: Common errors

1) FILL THE FRAME
By getting lower, almost eye-level with the droplet, and filling the frame, this image would be greatly improved. Aim to place the droplet on an intersecting third of the frame for a stronger composition.

2) USE A SMALLER APERTURE
When using multiple droplets, you will need a much smaller aperture of at least f/11 to get all the drops in focus. To make it easier, try to place the droplets along a similar plane of focus to avoid lengthy shutter speeds.

3) FLAG REFLECTIONS
The catchlight from the window makes this droplet distracting and messy. To eliminate unwanted reflections, try altering the position of the feather, using black card or curtains to control the windowlight.
Every month the *Digital SLR Photography* team shows you the best tips, tricks and shortcuts to taking better pictures. With photo projects for all levels, and a dedicated digital editing section, it’s the essential magazine every amateur photographer needs.

To learn more about the magazine and see our great offers, visit [subscribe.digitalslrphoto.com](http://subscribe.digitalslrphoto.com)
Get creative with bokeh

Pro photographer Catherine MacBride delivers a technique that guarantees sparkling results
Catherine MacBrìde: Before I found my passion for photography I was in love with bokeh. Being a child with bad eyesight had its advantages and one of my happiest childhood memories is when I would sit in the backseat of my parents’ car, take my glasses off and watch the whole world turn into beautiful light dappled blur. Street lights and house lights turned into golden globes and, if I squinted my eyes, I could turn the balls of light into stars.

Years later I discovered photography and found out I could create and photograph this dotted blur, technically named ‘bokeh’, leading to a long-time love affair with shooting wide open with my 50mm f/1.4 lens. With the addition of a simple piece of black card, with a shape cut out of its centre, I learned how I could change the shape of the bokeh to whatever I wanted, from hearts or shamrock to stars and skull and crossbones, making it even more fun.

With this in mind, I thought I’d use this photoshoot as an excuse to make a little love heart bokeh for my family. The instructions can be used for any shape you can imagine – as long as you have the dexterity and patience to cut it out of card.

In terms of kit, you’ll need a fast prime lens; I found my 50mm f/1.4 worked perfectly. I also tried using both 50mm f/1.8 and 40mm f/2.8 lenses. Both worked well, however, I found that the slower the lens’s maximum aperture, the smaller the shape that I had to cut out to produce a similar effect.

To try this technique, you’ll need some LED lights (I used a mix of red and white), some black card, a craft knife or scissors and a UV filter to hold the card in place. You’ll also need a main subject for your image. I chose a little paper house but you can use your imagination here. The final piece of equipment is a hand torch, which is used to throw some light on the house.

Have bokeh fun!

The best shots created using this technique come from when there’s a relationship between the subject and the shape of the bokeh. Hearts, stars, Christmas trees, even skull and crossbones are possible with a little patience and thought.

1 Cut out a circular disc
Place the UV filter onto the card and use it as a template to draw around. If you don’t have a UV filter you can use the end of your lens as a template, or draw a circle using a drawing compass. Carefully cut out the circle.

2 Cut your shape
Fold the circle in half and then half again to find the centre point. Using a sharp craft knife, carefully cut out your shape of choice. Take your time with this stage and take care not to crinkle or tear the card – or cut yourself!

3 Secure the card
Place the card on the lens with the heart pointing the right way up, depending on your shot orientation. Attach the UV filter to keep it in place. If you aren’t using a UV filter you can secure the card using a small piece of tape or Blu-Tack.

4 Fix your lights in place
Stick your LED lights to a clean background using Sellotape. Spread them out, as having them too close together can cause them to blur into one another, losing the bokeh shape. It might take a few adjustments to get it right.

5 Prepare for the shot
(left) Place your main subject far enough away from the lights so that when you focus on it the bokeh is heart-shaped, this may take a few moves to get just right. Fix your camera on a tripod and use a remote release, or self-timer.

6 Camera settings (above)
Use manual mode and open up the aperture. I found ISO 400 and a shutter speed of 1/200sec worked – use a higher ISO rating or slower shutter speed if required. Focus on the house, shine the torch on it and take your shot.
Home is where the heart is!
With a little bit of preparation, it’s easy to create striking shots in your home.
Exposure: 1/200sec at f/1.4 (ISO 400)
Create windowlit fine-art silhouettes

In a few short steps you can create simple yet striking fine-art images

Ian Farrell: Silhouettes are graphic images that not only look great but are easy to produce too. All you need is a plain background that's lit more brightly than the subject in front of it. As for what to shoot, some subjects work better than others, so experiment, but it's worth seeking out objects with some transparency or fine detail in them. After some trial and error, I found long grasses to be particularly suitable. They're around all through the summer, and grow in large numbers. The source of your bright background can be as simple or as complicated as you like. If you have studio lighting, a softbox makes a great white background. Alternatively, light a sheet of paper from the rear with a flashgun, or even just tape a piece of tracing or photocopier paper to a window for a simple but effective solution. We used the paper-on-window approach for the photographs you see here. It's such a simple approach that the whole thing was done and dusted in 15 minutes!

1 CAMERA SETTINGS: Using your camera in an auto exposure mode, or metering in manual, straight from the paper, won't give you a good result: a camera's metering aims to make things 18% grey, not white. Instead, start at your meter's indicated exposure in manual mode and take pictures while increasing the shutter speed. Check the histogram and stop when you see proper whites at the right-hand side of the graph.

2 COMPOSE YOUR SHOT: With your correct exposure locked-in, introduce your subject, positioning it slightly away from the background. You'll want to use a shallow depth-of-field to render the paper out of focus and, therefore, devoid of any distracting detail. You may be able to hold the grass stem with one hand and your camera with the other, but we'd highly recommend a clamp or vase to make this step much easier!

3 TWEAKING THE RESULT: Inspect the results of your efforts on your computer - if it's not quite the effect you hoped for, you can tweak things with a simple Levels adjustment. In Adobe Photoshop or Elements, choose Image>Adjustments>Levels and pull the right-hand marker inwards to make the background whiter. Then tweak the left-hand marker to deepen the blacks somewhat until you're happy with the effect.

4 EXTENDING YOUR CANVAS: Sometimes graphic compositions like this can benefit from some extra white in the composition - known in the trade as 'negative space'. An easy way to do this is with the crop tool. Draw round the whole of the canvas with it, then use a drag handle to extend the box beyond the existing image. Hit return and new space will be added and filled with the background colour - which in this case should be white.
A semi-silhouetted approach works well for this stem of grass. This was achieved by not moving the black point in Photoshop’s Levels adjustment screen too much.
Painting the town red

What can you do with the colour red? Cat MacBride took a literal approach to her shoot.

**Camera:** Nikon D5200  
**Lens:** NIKKOR AF-S 50mm f/1.4G  
**Software:** Adobe Photoshop CS5

**Catherine MacBride:** I have to say that the challenge of coming up with some quirky and interesting ways of using paint really got my imagination buzzing! The theme of paint gave me so many options. I could throw it, drip it, splash it, smudge it... the options were endless! But what became apparent very early on was that whatever idea I came up with, I’d be the one doing the cleaning up afterwards so best keep it tidy.

After a little time spent wading through various ideas, I remembered the saying ‘painting the town red’. It’s such a graphic phrase so I thought I should come up with an image that would bring it to life. My first plan was to make a little paper town and drip red paint on it, but I quickly realised that I wanted something that would be far more obvious to anyone viewing it. Something that people would know straight away was indeed painting the town red. I decided to make my town from the word ‘town’ and have a few little model miniatures painting it red.

The first item on my to-do list was to make my 3D letters. To start, I chose a fairly square font in Photoshop, one that would stand up by itself easily, and printed each letter out as my template. I chose a font size that would work with the scale of my little miniature workmen. I then made them 3D by adding sides to the letters, although I didn’t bother with backs of the letters since they wouldn’t be seen in the final image.

When I had the letters finished and checked that they all stood up, I set about painting them. I decided to do a tester of the paints I was going to use on a patch of similar card, just to check out how it reacted. The first paint I chose was red poster paint, but when it dried its high water content caused the paper to buckle, so my next attempt was with red water-based oil paint, which worked a treat! I painted the bases of all four letters, stopping at various increments so that it looked like a work in progress. When the paint was dry I set them up on my white backdrop, adding my miniature models to the shot. It was easy to see that it was lasting so I went about making some paper accessories to accompany the letters. I cut out an aerial, a ladder, paper trees, a washing line filled with red paper washing and added a paper cloud on invisible string to the sky.

Next, it was time to shoot my set-up. I fitted a NIKKOR AF-S 50mm f/1.4 lens to my Nikon D5200, tweaking the composition in the viewfinder until I was happy. My camera was set to manual mode at ISO 100, and I selected an aperture of f/16 for good depth-of-field and dialled in a shutter speed of 1/160sec. I set up a flashgun to the left-hand side, and used a shoot-through umbrella to diffuse the light, triggering the flash using generic wireless transceivers. I took a test shot and adjusted the flash power to suit, until I was happy with the exposure. When my shot was taken, I checked the histogram on the LCD monitor, using the highlight clipping warning to make sure that none of my highlights were lost. Blown highlights are a regular occurrence when shooting white on white, so after making sure everything was perfectly exposed I was done!

Post-processing was minimal and the shot was almost perfect straight off camera. I cleaned up some stray paint and glue spills with the Healing Brush Tool and warmed the White Balance. After ‘painting the town red’ it was definitely time to put my feet up.
Love story

We’re an open book when it comes to tell-all techniques, and quite literally in this case.

**Camera:** Nikon D5300  
**Lens:** NIKKOR AF-S 18–105mm f/3.5–5.6  
**Software:** Lightroom 4 & Photoshop CS5

Jordan Butters: For this creative close-up challenge I had the book thrown at me and it was the trickiest so far. For starters I made it unnecessarily difficult for myself by deciding that I wanted to focus on creating an image with minimal digital manipulation! Scouring the internet for inspiration I found no end of inspiring images of books levitating in the air around people, characters miniaturised and placed on the pages of giant novels and even books coming to life, where their stories apparently leap off the page and into the real world. All great ideas but none of which were really possible if I wanted to capture something entirely in camera.

In the search for inspiration I also came across several book-themed images shot by our very own Catherine MacBride, all of which were created using clever craft work and in-camera technique. Not only did I realise that I had my work cut out as Catherine had previous form shooting this topic, but also, myself lacking any kind of skill when it comes to craft, I knew that I had to keep it simple and within reach of my skill set if I was to succeed! Nonetheless, my research wasn’t without success and, with an idea in mind based around the theme of a ‘love story’, I set about creating my image. I’ll admit it – creating a heart shape from a book isn’t exactly a new idea, but it perfectly represents the theory that you don’t have to look far to see great image potential.

First, I needed to shape the pages of my book into a heart – easier said than done, it turned out! I tried all manner of methods, including Blu-Tack, paperclips and even holding the pages in place, all of which left the method of fixation perfectly visible to the camera. In the end I found the solution in the form of a small piece of double-sided tape which, when carefully placed, held the pages in position without being visible.

With the basic shape sorted, I started to arrange my composition. Using a NIKKOR 18–105mm zoom fitted to a Nikon D5300, I tried out a number of angles and viewpoints but found the strongest composition presented itself when I got in close, placing the front of the lens so that it almost touched the edges of the pages.

Using the wide end of the lens, I was able to use the central gutter of the book as a lead-in line to guide the viewer’s eye up to the heart shape. This angle was achieved by simply propping the far end of the book up using a small box and holding the heart shape in place using a tripod base plate – it was the closest thing I had to hand and worked perfectly.

Next, I set up a Profoto studio flash in a strip softbox and positioned it overlooking my arrangement to create a nice rim light at the end of my heart shape. I set the flash to half power and dialled in my camera’s sync speed of 1/200. An aperture of f/10 at ISO 100 provided me with adequate depth-of-field – I wanted the top few lines of the text to be visible, any wider aperture and the text would have been a blur at this range. After a test shot I noticed that the flash was blowing through the pages, overexposing the text within, but reducing the flash power lessened the rim-light effect that was working quite nicely at the edge of the pages. To remedy this, I used a small strip of black card as a ‘gobo’, or ‘go between’, to block the light from the flash from reaching all but the edges of the paper, correcting the overexposure without removing the nice rim light. Using LiveView, I manually focused on the furthest-most words on the page, locked to manual focus and captured my image.

Although I vowed not to use Photoshop, the image benefitted from a few final tweaks. In CS5, I first added a Curves adjustment layer, which I used to increase the contrast slightly. I then added a second Curves layer and used the independent Blue, Green and Red channels to create a cross-processed effect. Finally, a touch of sharpening using Unsharp Mask and my image was done – a creative image created (almost) entirely in camera. Time to kick up my feet in front of a good book!
Bright idea

Stock photographer Catherine MacBride shines a light on her latest close-up challenge

**Camera:** Nikon D7100  
**Lens:** NIKKOR AF-S 50mm f/1.4G  
**Software:** Photoshop CC

Catherine MacBride: When I heard that my next challenge’s theme was a light bulb, I was delighted! Light bulbs have long been a favourite photo subject of mine and I’ve photographed them on a number of occasions. They’ve always represented ideas and possibilities to me, and the idea for this shot came to me when I was collecting together different types of burnt-out bulbs that I could use in my image and came across a candle-shaped one. I had ‘a light bulb moment’ and decided it would be perfect for half the pieces I needed for an image that would be a play on human conception. Intrigued?

To start with, I began by cleaning out a standard clear bulb as I knew this would give me a cleaner image and a better final result. Doing this would also allow the bulb to stand on its own easier while I photographed it. I did this by taking the end off the bulb with a pair of pliers and cleaning it out with a screwdriver. I made sure to wear thick gloves (gardening gloves work well) and safety glasses as there’s a possibility of the bulb shattering while doing this.

I set up my shot by firstly placing my standard bulb in place on my paper background using Blu-Tack. I arranged my lighting rig, which consisted of a clip lamp fitted with a 6500K daylight bulb onto my flash stand, which I diffused through a shoot-through umbrella; this provided a nice bright constant light source that allowed me to see exactly how the shot would look before I took it.

I attached my NIKKOR 50mm f/1.4 lens to my Nikon D7100 and secured it on a tripod. I set the camera to manual mode and dialled in an aperture of f/14 for good depth-of-field and selected a shutter speed of 1/4sec using ISO 320. I moved my lighting around until the reflection it cast on the bulb looked good and, using LiveView, I centred my image and took the shot making sure to leave enough room around the bulb for the second part of my plan. With the camera still at the same settings, I freed it from my tripod and also took a shot of my candle-shaped bulb lying on its side.

To process my image, I opened the image of the candle bulb in Photoshop and, using a Layer Mask and brush set to Black, I removed everything but the bulb and copied and pasted it onto the image of my standard light bulb. I used the Transform tool to reduce it in size and duplicated the layer until I had enough tiny bulbs to completely surround the larger one. I arranged each bulb’s position until I was happy with it before flattening them into one single layer. I then used the Brush Tool to draw in the tails on a clear layer, reducing the layer’s opacity until I was happy with the effect.

I decided to add a texture layer (from my collection at Flypapertextures.com) and added two lens flares – a big, bright one to the centre of the main bulb and a smaller one on the tip of the winning ‘bright idea’. I then flattened all the layers, adjusted Curves and Levels and that was it, I had conceived a new bright idea!
**Snow patrol**

Boys and their toys! Jordan Butters turns playtime in to a miniature marvel.

**Camera:** Nikon D5300  
**Lens:** NIKKOR AF-S Micro 105mm f/2.8G VR  
**Software:** Photoshop CS5

| Jordan Butters | They say that men never grow up, they just get older. I couldn’t agree more! Which is why I couldn’t believe my luck when I was presented with the challenge to create an image revolving around the theme of ‘toy’. You mean I basically get to play with toys and it’s considered work? Deal! I started thinking about what I could do – luckily inspiration for this theme wasn’t difficult to come by in the Digital SLR Photography offices. We’re a team of self-confessed geeks and so each of our desks is adorned with small collectable characters from our favourite comics, television shows and films. All it took was a quick glance over at all of the Star Wars paraphernalia surrounding art editor Luke’s desk and I instantly knew that I wanted to create an image inspired by the George Lucas blockbusters using Lego – the force was with me on this one!

Some of my recent photo challenges have relied on Photoshop to a certain degree, so I made it my mission this time around to create an image almost entirely in-camera. Challenge accepted!

After being offered the use of Luke and his son Alfie’s extensive Star Wars Lego collection, I opted for the characters from the Battle of Hoth, a snowy barren wasteland that featured in *The Empire Strikes Back*. With the loan of several components from Darth’s Imperial Army, I set about making my scene. I first laid out a sheet of white foamboard on a product photography table and chose my characters – a handful of snowtroopers and the legs of the AT-AT walker – I wouldn’t need to assemble the complete walker thankfully as only the legs would be seen! I set up my Nikon D5300 on a tripod and used a NIKKOR 105mm f/2.8G macro lens to compose the scene. The D5300’s vari-angle scene was invaluable at this point, as I could position the characters by hand while assessing the changes made to the composition using LiveView.

At this point all I had was some Lego men stood on a sheet of white foamboard, and it didn’t look creative at all! I had the bright idea of making a snowy backdrop in Photoshop before positioning my monitor behind my diorama to act as a background, though this didn’t provide the result I was looking for. Scapping that idea, I realised that I needed to make my frozen planet more realistic if this idea was going to work – I needed snow! A quick online search revealed that baking powder is often used in dioramas to mimic snow, so a trip to the local supermarket later and I was stocked up on enough snow to complete my scene.

Again using LiveView I scattered the baking powder about my Snowtroopers, making sure to cover up any sight of foamboard. I used a Bowens studio flash fitted with a reflector and positioned it to backlight my scene before dialling in my camera’s sync speed of 1/200sec and a mid-aperture of f/9. The result was much improved, but without a background my scene still lacked depth. I had some black foamboard in the studio, so tore this to shape to make it look like distant mountains and features in the landscape before fixing it to my foamboard base. Better again, but I still wasn’t happy – the image was lacking something to bring it to life. It was at this point that I thought about making it appear as if it was snowing – this would only add interest but the drops of ‘snow’ would hide the otherwise plain black background! Lacking a remote, I set the Nikon D5300 to its ten-second self-timer mode and waited, before sprinkling the baking powder over my scene as the shutter fired – the result was much better!

As a final touch I wanted to make it look like the AT-AT was walking during the shot, with snow pouring off one of its giant feet. I picked one of the AT-AT legs up with my left hand, along with a handful of baking powder,
and then sprinkled powder with my right hand while letting some fall down the AT-AT leg while the shutter fired. It took a few attempts but after a while I had something I was happy with.

After importing the image into Photoshop I set the White Balance before increasing contrast using a Curves adjustment layer. Finally, a touch of sharpening and my image was complete — some Imperial snowtroopers on a frosty night patrol on Hoth. May the force be with you!
Fork abstract

If you’re lacking close-up inspiration, look no further than your kitchen’s cutlery drawer

Camera: Nikon D800
Lens: NIKKOR AF-S 24-70mm f/2.8G ED
Software: Adobe Lightroom 4 and CS5

Jordan Butters: Creative block is one of the biggest obstacles that we face as photographers. There have been countless times when I’ve sat at home wanting to shoot something but not knowing what! One of the most enjoyable parts of the Digital SLR Photography team challenges is that they take everyday items that you usually don’t give much thought to and challenge you to look at them in different and creative ways. Try it for yourself and you’ll soon notice your eye for spotting a creative photo opportunity improving in no time.

Handed the theme of cutlery for this challenge, I immediately knew that I wanted to shoot an abstract and to present it in monochrome. A clean image, nothing fancy, basic post-production and simple to achieve in camera using the good-old key principles of photography.

After raiding the kitchen drawer for my subjects, I narrowed it down to using only forks as their shapes and curves lend themselves well to abstract photography. As I’d be photographing metallic objects, the first obstacle was dealing with reflections. This was easily overcome with the use of a cheap pop-up light tent courtesy of a certain online auction website. Light tents are a great investment as not only do they cut out most of the distracting reflections that you usually get when photographing shiny objects but they’re also great at diffusing light, making it easy to bask your subject in soft, even light with minimal fuss.

With my light tent set up on a table, I used a large piece of thin foam board to create an infinity curve running along the bottom of the tent and up the back wall. I interlocked the prongs of two forks and arranged them inside the tent. I also placed a single flashgun, set to 1/4-power, inside the tent, out of view and pointing up to bounce off the tent’s ceiling. With my camera set up on a tripod, I composed the shot and connected the camera to the flash wirelessly using a remote trigger and receiver. I dialled in the D800’s maximum sync speed of 1/250sec and selected an aperture of f/9 to retain good focus front to back. With the ISO set to 100, I fired a test shot and assessed the and histogram and LCD monitor – it was overexposed so I narrowed the aperture to f/11 and tried again. I was happy with the exposure but the image looked like a standard product shot, which wasn’t at all what I was after.

I decided to incorporate a reflection into the image and so found a suitably sized piece of glass from a picture frame. I placed the forks on the glass in the same arrangement and took another shot. The shape created by the reflection added symmetry to the image and at first glance you wouldn’t guess that it was a pair of forks – perfect.

Before packing away, I decided to try one more approach with a piece of black foam board under the glass to see what effect it had on the reflection. Doing this darkened the reflection and added a slight gradient to the foreground that I knew would suit the monochrome conversion. In order to exaggerate the gradient, I needed to light the shot differently so I placed the foam board and glass on top of a small cardboard box inside the light tent to elevate it. This allowed me to place the flashgun behind the arrangement, pointing back at the infinity curve without the flashgun itself being in shot. It lit the white background in the same way, but would project less bounced light onto the surface of the glass, allowing more of the black to show through. I recomposed the shot to achieve this and adjusted the point of view slightly to look down on the forks. An aperture adjustment to f/14 and I had another shot to choose from – it’s amazing how slight changes in set-up can produce wildly different results.

In Lightroom, I selected my favourite images and converted them to black & white. I used the Spot Removal Tool to clean up any dust specs on the glass before applying a slight Curves tweak to increase contrast. Finally, I opened one of the shots on white in Photoshop, duplicated the image and used Layer Masks to create a pattern effect. I was pretty happy with all of the shots and found it difficult to pick a favourite – usually the sign of a photoshoot that has gone well.
Paper roses

You don’t need to be a whizz at origami to try this project. Cat MacBride shows you how...

Camera: Nikon D5200
Lens: NIKKOR AF-S 18-105mm f/3.5-5.6
Software: Adobe Photoshop CC

Catherine MacBride: Of the few Digital SLR Photography challenges that I’ve done, I have to say that the theme of flowers completely stumped me! Flowers are not something I photograph regularly and many of my photographer friends do some amazing floral images – I really didn’t want to show myself up!

But I was stumped. I thought about finding some interesting flowers to take macro shots of, or trying my hand at some flower arranging, but that just didn’t spark my imagination. It wasn’t until I was speaking with my sister who is planning her wedding and honeymoon that a little glimmer of an idea sprang to mind. I decided to make paper roses, but not out of plain paper – I was going to try to make some roses from maps to bring together the idea of weddings, travel and flowers all in one image.

I had made roses before but never out of paper, so I sat down with a few scraps of paper and worked out the best way of putting them together. When I was happy I knew where I was going with my roses I made a template using a small circle of card folded into six equal pieces in order to give myself a pattern to work to and to keep my flowers and petals a uniform size.

I cut my petals out of an old, outdated road map that had been destined for the recycling bin, keeping the edges as neat as possible. When all the petal patterns were cut out, I wrapped the petal ends over a pencil to give them a curl and used my glue gun to stick them all together in layers of increasing petal numbers. I used a length of wire as the stem and a means to hold everything together.

When everything was dry I covered the stems in strips of green paper to give my flowers a more finished appearance. I added a couple of green paper leaves to some of the stems and my road-map roses were ready to shoot.

My initial idea was to have my sister’s hands holding the roses like a wedding bouquet but test shots told me it didn’t look quite right – although I had made the roses life-size they were too big and the composition was wrong so I had to try a different approach. I found a jar to sit the flowers in while I waited for another idea to come to mind but they looked so simple and pretty just sitting in the open glass jar that I figured I should try a few test shots of them as they were.

I set my Nikon D5200 on a tripod with my 18-105mm lens attached and used LiveView to check and adjust the position of the roses until I found a composition I was happy with.

TOP: The trickiest part of the process was cutting, shaping and gluing the paper roses, which are made from old road maps.
ABOVE: I used an off-camera flash in a shoot-through umbrella to light the arrangement in the jar in front of a seamless blue backdrop.
LEFT: My original plan of having my sister holding the flowers like a wedding bouquet made for a nice image, but didn’t turn out as planned.

I used manual mode at ISO 125, an aperture of f/16 for front-to-back sharpness and a shutter speed of 1/160sec. I set my flash to the front and left of my camera on medium strength, triggering it with third-party wireless triggers and diffusing it through a shoot-through umbrella. I liked how the shot looked on the back of camera so I opened the Raw file and adjusted its clarity, contrast and shadows before adding a couple of textures to give the image a painterly feel.

Finally I had an image I was happy with and a bunch of flowers that wouldn’t die!
Smoke skills

Jordan Butter’s challenge to shoot a candle close-up was a smokin’ success, here’s why...

Camera: Nikon D5200
Lens: NIKKOR AF-S DX 18-55mm f/3.5-5.6
Software: Adobe Lightroom 4 and CS5

Jordan Butter: I’ll be honest with you — this close-up challenge was a tough one. A quick search of 500px or Flickr will tell you that, as far as photographic still-life subjects go, candles are pretty popular objects and it’s not surprising as they are aesthetically pleasing. However, coming up with a creative idea for an image wasn’t as easy as I thought it would be.

After much brainstorming and inspiration-searching, it dawned on me — the candle itself needn’t be the subject of the image; it just had to play a part in creating it. So I settled on the idea of an abstract smoke-trail image using the smoke from an extinguished candle.

Obtaining the images turned out to be the easy part — I set up a piece of black foam board on my kitchen counter to act as a backdrop and placed a candle holder in front of it. I put the unlit candle in the holder and set my Nikon D5200 up on a tripod, in portrait-orientation, to allow room for the smoke to rise into. I selected single-point autofocus and focused on the tip of the candle, before switching to manual focus to ensure it didn’t change.

I used manual mode at ISO 100, selected the maximum sync speed of 1/200sec and chose a mid aperture of f/8 for a workable depth-of-field. I then connected a wireless flash trigger to the camera and placed the receiver on a budget flashgun, which I rested on the counter to the right of the candle, pointing upwards where the smoke would trail. I selected manual mode on the flash and a power of 1/32 which, after a test shot, proved to be sufficient to illuminate the smoke — however, some of the light was spilling onto the background.

I used a small piece of black foam board and a black folder to flag the light from the background to solve this problem.

Before lighting the candle I opened the outside door to allow the kitchen to cool down, as smoke appears more prominent and lingers longer in colder environments. After half an hour, I shut the door and closed all of the blinds and doors in the room. This made sure no ambient light crept in and eliminated drafts that could blow the smoke out of frame. After lighting the candle, I allowed it to burn for 30-60 seconds to allow the wick to get hot, before blowing it out and firing off a few shots. After repeating this process several times, I found that when the smoke trailed to the opposite side of the frame to the flashgun, it ended up underexposed. To rectify this, I placed a second flashgun on the opposite side of the candle and dialled the power of both flashguns down to 1/64 — this ensured that the same amount of light reached the smoke, but made sure that it would be captured equally well, no matter which direction it went. The added bonus was that my recharge time between shots dropped thanks to the lower flash power, meaning I could fire off more shots before the smoke dissipated.

The steps I took in post-processing were a bit more involved — I imported my files into Lightroom 4 and picked out the best trails, which I then exported over into Photoshop CS5. Using the Lasso Tool, I selected each smoke trail and copied and pasted them onto an image I took of the lit candle with no smoke trails. I then changed the Blend Mode of each layer to Lighten to ensure the smoke showed through.

To add extra interest, I applied a colourful Gradient layer to each smoke trail and changed the Blend Mode of each Gradient to Color. Finally, I merged all of the layers together and duplicated them, before flipping them to create a mirrored pattern. A quick tweak to Curves and a spot of sharpening, and the image was complete. I decided not to include the candle in the composition in the end as it detracted from the abstract nature of the image.
Flying high
Catherine MacBrade’s paper still-life proves her imaginative ideas are not full of hot air

Camera: Nikon D5200
Lens: NIKKOR AF-S 18-105mm f/3.5-5.6 G
Software: Adobe Photoshop CS5

Catherine MacBrade: When I was asked to make a still-life from paper, I was over the moon! You see, I have a thing for paper the way most women have a thing for shoes. The creative possibilities of paper are endless! It didn’t take long for me to come up with an idea for my shot, but working the exact logistics out in my head took a little longer. I wanted the shot to require minimum Photoshop and simple lighting, so that meant all the work had to be done in the real world.

My idea was to create a hot air balloon scene, complete with an overboard passenger. All I needed for my shot was a couple of pieces of 170gsm coloured paper, a white balloon (with some spare balloons just in case), invisible thread, embroidery thread, a sharp precision blade, paper scissors, glue and a cutting mat. For a miniature still-life like this, the creativity comes in long before the shutter is fired.

I began by making some paper bunting, long enough to go around the top of the balloon. I found the easiest way to judge this was to blow the balloon up and measure it. When I had finished the bunting | marked four equal sections and attached four lengths of embroidery thread at each corner. It was important I kept everything equal otherwise the whole balloon would sit lopsided. I made sure the threads were long enough to fall below the balloon, allowing space for passengers and tying off.

The next thing on my to-do list was to make the basket. It was just a simple open cube shape in which I taped a weight so that it would hang properly. I tied off the four strings inside the basket and decorated it with some of the extra bunting. I then put the balloon and basket together and hung it in front of my paper backdrop with invisible thread. After straightening everything out I started work on the passengers. The passengers were actually drawn from silhouettes of my husband and son, and we had fun with these. I originally cut them out of white card, but they got lost in the image so I recut them in black card instead and they looked much better.

ABOVE: With a little time and effort, I created the bunting, basket and people for the balloon. I originally created small houses and trees but it made the composition too messy.

BELOW LEFT: A flashgun fired through an umbrella complemented the window light.

Everything was brought together on a blue paper backdrop and I checked my composition using LiveView on my Nikon D5200’s articulated screen. Initially I had set up tiny houses and trees as a backdrop to my balloon but felt it was too messy, so I changed it to some simple white paper clouds hung from invisible string.

I set the camera to manual mode with the zoom lens at the widest end. I positioned a flashgun on low power with an umbrella on the left to balance out window light coming in from the right and triggered it using a sync cable. The shot was taken at f/18, with an ISO of 640 at 1/160sec because things hanging from threads have a habit of moving. I chose a narrow aperture as I wanted to be sure everything was in focus — thankfully after a few tries, I got the shot that I was looking for.

When I was sure I was happy with the shot, I opened the image in Photoshop and carried out some basic processing in Adobe Camera Raw. I adjusted clarity, contrast, brightness and saturation, before deciding to add a texture to it. I downloaded the texture from Flypaper Textures (www.flypapertextures.com), to add some movement and detail to the background... and it was done. I showed the final image to my son and he said it made him smile — that was good enough for me!
How to give your still-life an ethereal glow

Add a new dimension to still-life subjects by learning how to use focus blur creatively.

Helen Dixon: So much about being a good photographer comes down to experimentation and creativity, whether it’s how you frame or compose a subject, the lighting or perspective, or simply breaking the rules to see what the result is like. The options are only limited by your ingenuity. This technique, for instance, which is known as defocus or focus blur, is unusual but effective and easy to do. It requires you to take two photographs of the same composition: one in focus, the other out of focus, and merge them together to create a halo. They can be merged in-camera, if your digital SLR is capable of capturing multiple exposures, or using software such as Photoshop. Either way it’s fun, simple and has huge creative potential.

The technique is well suited to still subjects, but it works particularly well on semi-translucent objects that are backlit like leaves and petals. For this tutorial we’ve used a lightbox to backlight some leaves, but if you don’t own one, you could create your own out of a sheet of Perspex and a table lamp, or stick the subjects to – or in front of – a window. It doesn’t have to be autumnal leaves either, but vibrant colours do work well. As an alternative, you could try backlighting a single flower like a rose for an elegant still-life.

Incidentally, when you’re shooting the out-of-focus image, it’s worth shooting a number of defocused images by manually focusing the lens to different focus distances, as you’ll notice this affects the extent of the halo effect.

Try a zoom lens instead

If you don’t own a macro lens, you could try this technique using a zoom lens, though expect a far more dramatic result. If you don’t have a lightbox you could always try backlighting the subject by a window or create your own version using a sheet of glass lit from underneath.

Multiple exposure facility

The multiple exposure facility required to do this technique in-camera isn’t available on every DSLR: in fact no Canon model offers this feature. Check your camera’s instructions to see if your DSLR is capable of multiple exposures and how to access this function if you do have it. Your DSLR will ask you to select the number of frames you want to take – in this case two. Turn on Auto Gain as this will ensure the exposure of the final image is correct. Take your shots and the images are merged automatically.

1 Set up Carefully position the leaves on top of the lightbox, which I line with a plastic sheet for protection. As it’s important to keep the camera static for both shots, I mount it on a tripod and fire the shutter with a remote release. I allowed me to use a small aperture to get good depth-of-field without a high ISO rating, which will increase image noise.

2 Tackle the metering With my camera set to aperture-priority mode, I dial in f/11 and take a shot. As the leaves are backlit, it’s tricks my multi-zone meter into underexposing the picture. I dial in three stops of positive exposure compensation for a correct exposure.

3 Shoot the out-of-focus image I switch the lens to manual focus and rotate the lens’s manual focusing ring. The idea is to blur the shapes of the leaves so they expand, but not beyond recognition. Make sure you can still see some detail and a clear outline.
Now the leaves should have a halo around them from the bottom layer. If you want to boost the colour a little, go to Layer>Flatten Image and then select the Hue and Saturation adjustment layer by clicking Layer>New Adjustment Layer> Hue and Saturation and tweak the colour as you see fit.

4 Layer the images In Photoshop, drag the sharp image on top of the out-of-focus image using the Move Tool. Duplicate the top layer and, with the Magic Wand Tool, select its white area. I expand the edges by 5 pixels to ensure the leaves’ fine edges are included.

5 Blend the images together With the white selected, press delete to reveal the image underneath. Then click on the middle layer and select Darken from the Blend Mode menu on the layers palette. You’ll see it’s set to Normal as default, but experiment with different options.
Camping by torch light

Stock photographer Catherine MacBride create a miniature model for her challenge

**Camera:** Nikon D7100

**Lens:** NIKKOR AF-S 18-105mm f/3.5-5.6

**Software:** Adobe Photoshop CC

Catherine MacBride: Believe it or not, when I heard that my close-up challenge was to use a torch, I was happy! I knew straight away I wanted to use torches to light my image, because for the life of me I couldn’t think of an interesting shot of a torch itself.

For the past few years I’ve been working on a photo a day project, and eventually there comes a day when you’ve forgotten your flash, batteries are dead, or you’ve left it too late to use natural light, and you have to use an alternative light source. Through trial and error I’ve found that a torch is a perfect alternative to light an image and gives your shot a completely different feel, which I like a lot.

While I was going to light my image with torchlight, I had to think up the perfect scene to light. It was while I was travelling that I came up with a plan for a camping scene where any torch would be perfectly at home. Not being able to go to work on the shot straight away, I drew a little doodle of my idea in one of the little notebooks I carry with me everywhere so I wouldn’t forget. I also sketched in where I thought the torch should be placed and the general composition of the shot.

With the weather taking a turn for the worse I had decided to make a miniature paper camping scene as it would be much easier to work with. On arriving home I first checked that my torch was in perfect working order, which it was, so I set about making my scene.

I began making my trees by cutting them from white A4 card and adding some details to the bark by making little horizontal cuts. I stuck a wooden skewer on the back of each using sticky tape, allowing the point of the skewer to sit below the tree trunk.

I pushed the trees into a sheet of foam board which secured them in place, and then set about making my tent.

I again cut it from white card but only gave it three sides so I could sit a torch inside and light my paper people, which I cut from black card. I sat everything together, turned the torch on and checked that my cut-out figures made nice strong silhouettes against the tent wall before adding my roof.

I set my Nikon D7100 on my tripod because of the low light conditions and set the two-second timer to avoid adding shake. I attached my NIKKOR 18-105mm lens and set the D7100 to manual mode. I dialled ISO 100, an aperture of f/16 (after going to the trouble of adding detail to my tree trunks, I wanted to be able to see it!) and a shutter speed of 0.5 seconds.

I had to move both my camera and elements of the scene around until I found a composition I was happy with, checking the scene on my LCD screen after every move. When I was happy with everything position-wise, I took my shot. I decided to add a second torch, which I sat on top of my camera to light the trees, which were a little dark with just the light coming from the tent.

I opened the image in ACR and adjusted its clarity, highlights and shadows before opening it in Photoshop, where I cloned out any light leaks from my tent and added two textures to the photograph feel more like an illustration. I added in a few sets of spooky eyes glowing from the shadows and I was done – a torchlit camping scene without leaving the house!
Get fruity

It’s amazing what close-ups you can create with just some sliced fruit and a lightbox

**Camera:** Nikon D800
**Lens:** NIKKOR AF-S 105mm f/2.8 VR IF ED
**Software:** Adobe Lightroom

Ross Hoddinott: You have to be a bit of a ‘fruitsake’ to be a professional photographer – well, that’s what my wife says anyway. I guess spending the afternoon photographing fruit might seem a little crazy to some. Please don’t get me wrong – I love fruit and I am partial to a tasty apple or orange, but it would be fair to say that fruit wouldn’t feature among my favourite subjects to shoot. However, you don’t get a choice of subject when taking part in a Digital SLR Photography challenge, so fruit it is. Time to think about how I can shoot it to suit my style of photography...

I’m no Photoshop whizz, so my effort would need to be captured authentically in-camera, without any jiggery-pokery on the computer later. Being a close-up enthusiast, it proved an easy decision to reach for my NIKKOR 105mm macro lens in order to photograph my subject close up. Although fruit can seem rather dull at first glance, citrus fruits are very beautiful when sliced and can be arranged to create interesting, repetitive or symmetrical patterns – either on their own or combined with other types of fruit. Also, many fruits are semi-transparent when cut up, making them well suited to being backlit. I’m a big fan of backlighting and have kept a large lightbox – a remnant from my film days – just for the purpose of illuminating small objects from behind. By placing the lightbox on the floor and positioning the camera overhead using a tripod, capturing backlit images is easy to do. Deciding on what camera settings to use was also quite simple – I selected my Nikon D800’s lowest ISO sensitivity of 100 to maximise image quality and, using aperture-priority, opted for an aperture of f/11 to create sufficient depth-of-field. The camera’s excellent Matrix metering did the rest of the hard work for me by setting the correct shutter speed, which was less of a concern with camera mounted on a tripod. While setting up the camera was simple enough, arranging the fruit to create an interesting composition was a different matter.

I intentionally selected fruit of various colours from my local greengrocer that also had a translucent quality when sliced.

I began to arrange them on the lightbox, beginning with single slices of kiwi, lemon and orange. I carefully surrounded the slices of fruit with bright red pomegranate seeds, as they added colour to the shot, and neatly filled the gaps between the slices.

**LEFT:** I bought fruit from my local greengrocer that I thought would illuminate well on a lightbox. Citrus fruit, such as lemons, oranges, kiwis and pomegranates are known to work well due to their semi-translucent qualities. Fruits that let light through from behind allow you to capture a lot of the delicate details like seeds and veins.

**BELOW LEFT:** Arranging the fruit on the lightbox was the most difficult part of this task. After going through a number of ‘boring’ options, I decided that a heart made from the pomegranate seeds added all-important interest to the shot.

**RIGHT:** The final shot was a frame-filling image of the fruit positioned around the heart. Some of the fruit is arranged so that it is falling outside of the frame to draw the eye to the heart in the centre of the image.

**BELOW RIGHT:** I tried a number of different lightbox set-ups and compositions with my fruit, which were bright and colourful, but unfortunately they all lacked in originality. I had to get my thinking cap on to come up with a way of presenting my fruit differently. But I think I found it!
However, the results were disappointing, looking rather uninteresting and unoriginal when I reviewed them on the D800’s large 3.2in LCD. What could I do to make my final image stand out more? I thought about playing on the ‘five a day’ theme, but just couldn’t think of how to convey this message in a close-up picture. However, this led to me thinking about how I ‘love’ to eat fruit. With the pomegranate seeds being such a vibrant red colour, I decided to arrange them into the shape of a heart. I then surrounded my fruity heart with the citrus slices. It took a bit of fiddling about to get the composition the way I wanted it to look, but finally I captured a shot I quite liked. I imported my images into Adobe Lightroom 4 and made a few minor tweaks to Contrast and Vibrance, before exporting my final image. The result looks bright, fresh and fun. Having finished taking my pictures, there was only one thing left to do... make a fruit salad ready for dessert!
House of cards

Who knew a deck of playing cards could be used to produce a great, unsuspecting still-life?

**Camera:** Nikon D5100
**Lens:** NIKKOR 18-55mm f/3.5-5.6 VR
**Software:** Adobe Photoshop CS5

Luke Marsh: Whenever I think of playing cards, I picture one of the many precocious, towering structures that I would spend hours trying to build as a child. They are memories I hold with both fondness and frustration, as I’d often find – usually near the point of completion – that my construction would be brought tumbling to the ground, either by an involuntary hand movement or a mischievous sibling.

I also found myself strangely intrigued by the name ‘house of cards’. Apart from the fact that stacked cards look nothing like your typical house, the phrase ‘house of cards’ reminds me of one of the many detective novels that my grandma would read, the cover art that always caught my eye.

For my project, I wanted to produce something that wouldn’t look out of place on one of those old book covers, and would finally give the name ‘house of cards’ some relevance to its physical appearance.

I decided to create a straightforward shadow montagge, the idea being that I could create a visual reference to the well-known phrase, without the viewer having to see the title – a bit like Catchphrase! To do this I’d need to shoot the stacked cards, then substitute its shadow for that of a stereotypical house in post-production.

When working on a photo project, I always like to use items you’d expect to find in most homes. This sits well with my level of photography and knowledge of kit, but, more importantly, makes the possibility of reproducing the shot for you, the reader, that bit more achievable.

I started out by making a home studio. This consisted of an angle-poise lamp, a kitchen stool and a roll of wallpaper – which I suspended, pattern side down, from a window frame and taped to the table top, creating an infinity curve. I then set up my Nikon D5100, with its 18-55mm lens, on a tripod in front of my makeshift studio table.

Next, I needed to build my house of cards. With thoughts of childhood frustration still lingering, I took no chances – a few strips of sticky tape placed on the top edge of each card ensured they couldn’t tumble mid-build. I also placed a length of tape inside the cards – enough to allow the cards to open and form the inverted “V”, but not so much that they can open completely.

I built the card stack in the spot that I knew they’d roughly be shot in to avoid having to move them after construction, and the process was quicker than expected, leaving me wondering why I hadn’t thought of the idea 30 years ago!

With my ‘house’ in place, I switched off all light sources, aside from the desk lamp, and manoeuvred its head until a long shadow was cast from the cards, stretching out into the empty space of my composition.

Tungsten light can create a colour cast, so by shooting in Raw format, I could easily tweak White Balance in post-production if I needed to. As my DSLR was tripod-mounted, I used a low ISO rating to avoid noise, set a mid-aperture of f/8 for sharpness and focused on the front row of cards.

I shot using the self-timer facility to avoid hand shake causing any movement of the camera, which can often be a problem in low-light exposures. Finally, I took a series of shots, which I viewed for composition and quality on the LCD monitor.

Once I was certain that I had the shot in the bag, I destroyed my construction – it’s much more fun when it’s intentional!

To get my house shadow, I created an outline of the house on my computer, which I printed and cut out of cardboard. I placed the house on the table, using Blu-Tack to enable it to stand upright.

The house shadow was more difficult to capture than I suspected, as it was as simple as placing it in the same position as the cards. Doing this obscured most of the shadow, and it took a bit of time to find the best combination of house position and lighting set-up. Once I’d got the best position, I used the same camera settings as before to keep post-production to a minimum, although the complications with the shadow set-up led to more manipulation than I had first anticipated.

With both pictures taken, I transferred the Raw files to the computer in order to correct the White Balance and start the process of creating the final montage.

**TOP ROW:** A few strips of strategically placed sticky tape makes card building a piece of cake! I turn to my artistic talents in order to create the perfect shadow.

**BELOW LEFT:** Using the D5100’s LiveView feature is not only great for composing, it can be used for focusing, too.

**LEFT:** My final ‘house of cards’ montage.

**RIGHT:** My final ‘house of cards’ montage. An interesting and arty montage, that, with any luck, is also a solid visual reference to its title.
1. **Edit the cards** I duplicate the image with Layer>Duplicate Layer... and then hide the original layer by clicking the eye icon next to it in the Layers palette. Using the *Polygonal Lasso*, I carefully draw around the cards, then go to Layer>Layer Mask>Reveal Selection to hide the background and therefore isolate the cards.

2. **Edit the house** I make a *Rectangular Marquee* selection around the shadow, but not the cardboard house, and go to Edit>Copy. Click on the *Background* layer of the cards file and go to Edit>Paste to place the shadow above it but below the isolated cards. I then use Edit>Transform>Distort to reshape the shadow.

3. **Merge the images** I click the eye icon of the base layer to make it visible again, then select the *Brush Tool* and set it to 50% *Opacity*. I choose the brush colour from the image by holding the Alt key and clicking in a desired area. I then paint over any harsh lines between the layers, taking my time to build up the effect gradually.

4. **Arty effects** I now save the file as a .psd then flatten and save as a TIFF. I duplicate the layer and use Image>Adjustments>Black & White... I then change the *Blend Mode* to *Color* and the *Opacity* to 30%. Finally, I paste in a stock texture, change the *Blend Mode* to *Soft Light* and *Opacity* to 90% to complete my image.
Control your viewers’ gaze by adding a vignette

Maximise the impact of your pictures with this classic technique

Caroline Schmidt: How to take your images from good to great, quite frankly, could simply be a few tweaks in Photoshop. A test of a great picture is how well it contains your eye within the frame: the longer you can control the viewers’ gaze, the more engaging the image. While composition plays a big part in this, adding a vignette can help, too. Essentially, the technique is to gradually reduce the image’s brightness from the focal point, fading off toward the edges, drawing the eye towards the point of interest.

While some photographers do whatever they can to avoid lens vignetting, if the effect is controlled for creative effect and used on an appropriate picture, like this one where the focal point is central in the frame, it can have massive impact. It can be as subtle or as strong as you like, but some of the most appealing vignettes have a very soft graduation and edges that blend with the image for a natural finish.

Anyone that worked in the darkroom will know that vignetting is not a digital technique – in fact, it’s been around since the dawn of photography – though there are now countless methods of creating one, each with differing effects. For now, try this modern version of the darkroom classic.

1. Create a copy Make any adjustments you need to before finishing up with adding a vignette. To copy the image, go to Layer> Duplicate Layer or drag the Background Layer down to the Create New Layer icon at the bottom of the Layers palette.

2. Draw your vignette Select the Rectangular Marquee tool and click and drag the marquee over the area you want to frame, or, in other words, your focal point. To soften the edge of the vignette, go to Select> Modify> Feather and type in 250px, then click OK.

3. Invert the selection At the moment, any adjustments you make will affect the area within the marquee selection, which is not what you want. To target the area outside of the marquee, creating a frame around your focal point, go to Select> Inverse.

4. Darken the edges Add a Levels adjustment layer (Layer> New Adjustment Layer> Levels) and slowly drag the black and grey triangle sliders to the right to darken the corners until you reach your desired effect. Once you’re done, go to Select> Deselect.

Blend modes

Why not try changing the Blend Mode of your Levels adjustment layer for different results? Do this by clicking on the adjustment layer in the Layers palette and then selecting the Blend Mode drop-down menu at the top of the Layers palette. Experiment with the different modes, but here are three of our favourites. You can also reduce the strength of the effect by reducing the Opacity slider for the Levels layer.
Classic beauty

The beauty of this technique is it darkens the colour gradually from the outer edges of the image, drawing the eye towards your point of interest.
Add a boost to black & whites

Stark white frost and snow can create stunning high-contrast black & white pictures, if you know how...

Caroline Schmidt: There are several ways to convert an image to black & white in Photoshop: Grayscale, Channel Mixer, Black & White adjustment layer and even dedicated plug-ins that do an amazing job, like Nik Software’s Silver Efex Pro. But regardless of how you do it, the best images are usually those that you treat individually and go to greater lengths to edit locally, as well as globally, for improved tonal range. You can do this by adjusting the colour channels in the Black & White and Channels adjustment layer, using Shadows/Highlights or the Dodge and Burn Tools to make localised shadow and highlight adjustments. The latter tools offer the most control, but irrevocably affect the image pixels, and we’d normally advocate avoiding destructive editing wherever possible. Alternatively, if you were to use a Levels adjustment layer and Layer Masks, you can produce similar and exceptionally punchy results that are fully editable and nondestructive. Learning how to work with Layer Masks is important for this technique, so read our panel on the right and consider buying our The Photographers’ Guide to Adobe Photoshop & Lightroom magbook (www.amazon.co.uk) for a breakdown of the basics.

Quick find

Layer Masks
Click the Layer Mask icon at the bottom of the Layers palette. A thumbnail will appear on the active layer in the Layers palette.

Adjustment Layers
Click and hold on the New Adjustment Layer icon at the bottom of the Layers palette, and scroll down the menu to find the desired adjustment.

1 Convert to black & white As a basic first step, make your colour image monochrome. Our preferred method is to use Layer>New Adjustment Layer>Black & White or to select Black & White from the New Adjustment Layer icon at the bottom of the Layers palette. Click Auto to instantly improve the tonal range.

2 Increase the shadows Add a Levels adjustment layer and drag the black triangle under the histogram to the right until you see the mid-tone and shadows deepen, instantly giving your image more punch and depth. At this stage, don’t worry if you lose highlight detail and get dense black patches, this can be corrected later.

3 Boost the highlights Repeat step two with a new Levels adjustment layer, but this time concentrate on the highlights by dragging the white triangle slightly to the left. You’ll see some smaller details start to reveal themselves, but you won’t be able to reveal all the pockets of black until you move on to step four.
4. Dodge and Burn: Click on the Layer Mask thumbnail attached to the Levels adjustment layer for the shadows. Select the Brush Tool, set the Hardness to 0% and the Opacity to 30-40%.

Select the Brush Tool, set the Hardness to 0% and the Opacity to 30-40%, and select as your foreground colour. Now brush over areas of the image that need lightening slightly to reveal hidden details in the shadows.
Flower triptych
After all these brilliant close-up tutorials you’ve tried, now you need a way to present them.

Caroline Schmidt: It’s shameful how many of our photographs rarely leave a computer’s hard drive; most of us have so many images in storage that we don’t know what to do with them. Creativity normally stops before we click ‘Save’ in Photoshop and rarely do our results stray beyond a straight 10x8in print. But that’s about to change! Venture into the depths of your hard drive and drag out some shots that have never seen the light of day, perhaps a series of images you’ve created using this Essential Guide to Close-Up Photography or the results of this tutorial. Presenting your images as a triptych (three panels) or a diptych (two panels) can refresh old images and make use of forgotten shots. Look for groups of images of the same colours, subjects or themes such as flowers, leaves or scenes from the same shoot. You could also try dividing a single image into three sections for a new look. Here I’ve chosen to match the colour of the background and flowers for a monotone-colour triptych.

1 Find your specimens
If you want to shoot a similar floral triptych, buy the coloured card first and then visit your local florist to select your subjects, trying to match the card to the colour of the flowers you choose. Gerberas and roses are very photogenic, but for more unusual images you could go for exotic specimens such as Birds of Paradise, peonies or orchids.

2 Adjust the lighting
I supported the flower in a small vase, with the coloured card attached to a pinboard behind it, and angled a Hama macro light above and to the side so that it added some shadows to the flower. As the room had plenty of natural light, I didn’t need a second light source but, if you feel your first light source is not powerful enough, use an angle-poise lamp within your set-up.

3 Apply camera settings.Set your DSLR to aperture-priority mode so you can control the depth-of-field – the shutter speed won’t matter as you’re using a tripod. Use an aperture between f/3.5 – f/6.3 and experiment with the angle of the light to avoid casting shadows on the card.

4 Repeat Follow steps two and three with the various cards and flowers, then open the Raw files in Photoshop. You may find the colours are not true to life due to the temperature of the lighting you’ve used, so tweak the White Balance before you convert your Raw files.

5 Edit Do any necessary tweaks to your images, then resize each of your three final shots by clicking Image > Image Size and changing the width to five inches. Save the images and then close them. Then open a new file File > New and set a paper size (in this case A3).
6 Create guidelines To help you position your images, click Rulers under the View menu. Leave space around the images as a frame by dragging the ruler’s guides to leave a 3in border at the top and bottom, 2in at the sides and one in the middle to help you to align your images.

7 Insert the images Go to View>Snap and click Guides. This will allow you to clip your images to the lines you’ve created once you drop your images on the canvas. Open your images one by one and drag them onto your canvas using the Move Tool, so they snap to the grid.

8 Finish with a border To add a black border around the triptych, add four more guides approximately 1-2cm from the images then add a new layer and resize it to fit to these guides. Click Edit>Stroke and set to 10px. To remove the guides go to View>Show and unclick Guides.

TOP TIP
GET THE LIGHT RIGHT!
Front lighting can cast shadows on the background, to fill these shadows you’ll need to use a second light or handheld reflector to illuminate the background. Alternatively, play with the angle of the front light to illuminate both the background and the flower.
Close-up equipment

Essential macro gear to help you take stunning close-up images
Tested: Budget Macro LED ringlight

For less than £30, you can equip yourself with a macro LED ringlight. It isn’t bad, either. Let’s take a look...

Reviewer: Daniel Lezana
Product: Ring 48 Macro LED
Price: £28

AN LED RINGLIGHT is a relatively new innovation in the world of photography. It looks much like the ringflash units that have long been used by close-up enthusiasts and attach the same way – via the lens’s filter thread. While its purpose is also to illuminate nearby subjects, it has a number of notable differences to ringflash (see panel over the page), the main one being the lights remain constantly on, rather than flashing at the moment of exposure. This is because rather than housing flash tubes, the ringlight is fitted with several small white LED lights, much like you’ll find in pocket torches. These produce a cleaner, brighter light than the traditional light bulb, while also consuming less power and lasting far longer. They’re also relatively inexpensive to produce, which is why LED torches can be picked up from a DIY store for £1 and why ringlights sporting 48 of the bright little blighters can be bought for under £30.

Whether or not these budget lights are worth investing in is what this article sets out to discover. With dedicated ringflashes costing well into three figures, you could be in for a substantial saving if our Ring 48 unit proves to be a star performer.

We ordered our unit from Amazon and were pleased to find it was delivered to our door within a couple of days. Costing less than £30, you would be forgiven for thinking this is the most basic of lights but, in truth, it has more than you may have bargained for. For your £28 (including delivery!), your kit contains the ringlight, the hotshoe-mounted power controller, a mains plug and six adaptor rings that allow you to fit the ringlight to lenses with filter threads ranging from 49mm to 67mm.

You’ve two options when it comes to power – you can use two AA alkaline or rechargeable batteries when out and about, or when indoors switch to using the supplied three-volt mains adaptor instead if you so wish. This isn’t a bad choice – looking around at other models, many use battery power only.

The ringlight is made up of 48 small white LED lights, which remain constantly lit – in other words, there is no option to use them as a flash. Your only control of the light output is a switch on the side, which allows you to have all 48 LEDs lit, the 24 on the left side of the ring, or the 24 on the right side.

The power controller is a unit that is attached to the camera via the hotshoe mount. On one side are two sockets – an Output socket at the top that connects to the ringlight and the DC-in socket that connects to the mains power via the supplied adaptor. On the opposite side is the on/off switch that also selects between battery and mains power; with a red light that illuminates while the unit remains switched on.

Compared to the better-known macro ringflash units, our Ring 48 model is very basic. The Canon MR-14EX, for example, boasts twin modelling lamps and flash, a far higher power setting, E-TTL wireless autoflash and an illuminated LCD panel to make it easier to use. You prefer one of these, do you? Then feel free to part with £460 and be on your merry way...

Decided to hang around now to learn more about the Ring 48 that costs £28? Good. Then let’s carry on and find out just what is possible (and what isn’t) with our budget-priced mail-order ringlight.

The primary purpose of this type of light is for use in close-ups and that’s where we’ll be focusing our attention in this article. However, as the sales blurb and instructions state, the Ring 48 is also suitable for portraits. I was dubious about this statement, to be honest, as I assumed the low power of the unit would mean you would need to be within close quarters to the subject to provide sufficient illumination and at this close range, 48 LED lights are sure to prove very uncomfortable for the subject. However, in the interest of editorial integrity, I decided that before using it for close-ups, I’d give it a try shooting a head and shoulders portrait. For all the images, I set the camera to aperture-priority mode at f/4 with the ISO rating set at 400. I’d then make adjustments to both to ensure the shutter speeds avoided shake and to vary depth-of-field.

Ring 48 Macro LED

Guide price: £28
Number of LED lights: 48
Variable control:
All, left or right
Weight: 165g
Supplied accessories:
Battery pack, power controller, ring head, charger, six adaptor rings (49mm, 52mm, 55mm, 58mm, 62mm, 67mm)

You’ll find this ringlight under various guises (Ring 48 and Neewer to name but two) at under £30. You can’t really argue with the price considering the adequate build quality and useful, if limited, range of features. If you can live with its limitations, you’ll find it a fairly versatile light for close-up photography.

Above: The outfit for this test was the Canon EOS 550D with Tamron 60mm f/2 macro lens. The Ring 48 attaches to the front via the 55mm ring.

Right: A gerbera with a green ring binder behind it was well-lit by the LED ringlight.
For the portrait, I enlisted a colleague to sit in the studio and face the prospect of 48 LED lights at close range. As it turned out, the brightness of the LEDs was better than expected, meaning I could shoot from a reasonable distance and still capture a head and shoulders portrait while handholding the camera. Therefore, while bright, I was able to take a number of frames before the lights proved too dazzling. Results were better than expected and not too far off what you could achieve with a ringflash adaptor like the Orbis or RayFlash. But enough about that, as we’re primarily interested in how it performs for close-ups.

I used the excellent Tamron 60mm f/2.8 macro lens for all the images in this test, which gave an effective focal length of 96mm on my Canon EOS 550D, which uses an APS-C sensor.

Unfortunately, the wet weather meant I wasn’t able to try the ringlight out in the garden for close-ups on flowers, still-lifes and insects, so I had to concentrate on indoor subjects, primarily flowers. However, this restriction on subject matter forced me into looking for creative ways of shooting my subjects to provide enough variety to the images.

I started off by taking a straightforward picture of a small gerbera. With the ringlight attached to the Tamron lens using one of the supplied adapter rings, the lighting from the ringlight proved shadowless as expected, making it ideal for capturing some abstract images of its petals. As well as using different viewpoints and apertures, I also tried changing the colour of the backgrounds, using nothing more fancy than coloured ring binders! I then used a similar set-up to shoot some images of a rose but from further away.

Way back in autumn, I collected a number of brown and red leaves for future use in still-lifes. They’ve sat in a box under my desk since then, but at long last, I had my opportunity to photograph them. My first attempts of shooting the leaves weren’t great, with the dry textures of the leaves not being particularly photogenic.

So instead, I took the ringlight off the lens and placed it on the floor facing the camera, then placed a leaf in the space between so that the light shone through it. The backlit effect through the translucent leaf gave far more striking results, especially when using two different coloured leaves in the image.

Having done this, I discovered that using the ringlight off-camera really opens up the picture-taking possibilities in terms of creative ways of lighting the subject. Regrettably, I didn’t have enough time to try out a few of my ideas, including shooting jewellery with the ringlight directly above or backlighting a sheet of white paper and placing flowers, ferns and thistles in front to create silhouettes.

However, in the short time I did have to use it, I was left in no doubt that if you’re willing to experiment a little, you’ll find this budget ringlight to be a brilliant aid to your close-up photography — for that, it comes highly recommended.
You don’t have to leave the ringlight attached to the lens – in fact, taking it off opens up far more options for creative lighting!
Tested: Raynox macro lens

With a budget of £50 in our back pocket, we discover how good a budget close-up attachment is, and whether it would be a worthwhile addition to your kit bag. Are they worth the extra cash over a simple set of filters? We challenged ourselves to find out...

**Challenge:** Daniel Lezcano  
**Budget:** £50  
**Theme:** Macro conversion lens

MACRO PHOTOGRAPHY is more popular than ever. This has much to do with the fact that more and more high-quality products are becoming available at affordable prices, allowing photographers the chance to try out high-magnification close-up photography for the first time.

Earlier in this guide, we included the brilliantly affordable Ring 48 LED ringlight (on page 154) and covered useful accessories like close-up filters (page 26) and extension tubes (page 28), proving that you don’t need to spend very much to have the kit you need to take great close-ups.

This test centres around a Digital SLR Photography reader’s query, who wondered if a Raynox macro attachment was worth the extra cost over close-up filters. We hadn’t tried the Raynox before, so in order to provide the definitive answer, we ordered one, along with a set of close-up filters, to see which tools represent the best buy.

The Raynox is an intriguing bit of kit. It’s effectively a close-up filter with a clip-on mount that allows it to be fitted to a variety of lenses. Two versions are available: the 4.8 dioptre DCR-150 and the eight-dioptre DCR-250 – the latter being the model we’re reviewing here. The design of the Raynox offers a couple of distinct advantages over standard close-up filters. The first is that the lens optics are technically far superior, boasting three elements and anti-reflection coatings on all external surfaces. Budget close-up filters generally only have one element that lacks any coating. This should mean that the Raynox is sharper from the centre right through to the edges. The coating should also result in better contrast and less colour fringing. The other benefit is that the clip allows the Raynox to be used on lenses with filter threads from 52mm to 67mm, rather than being limited to one particular filter thread size as with standard close-up filters. These advantages come at

**ABOVE:** The Raynox can be used with the lens set to AF or M; I found both methods worked well.  
**RIGHT:** To show the close-up capabilities of the Raynox, this shot was taken on a Canon 28-80mm at 80mm and set to minimum focus.  
**BELOW:** Spend an afternoon in the garden with the Raynox and you’ll discover the potential for capturing great close-up images, such as dandelion clocks and abstracts of flowers.

a price, though, with the Raynox costing £44 as opposed to less than £20 for a set of close-up filters. Also, with the Raynox you’re limited to one magnification (eight dioptres in the case of the DCR-250); with a set of close-up filters, you have a choice.

Visit your local photo dealer, or websites like eBay and Amazon, and you’ll discover a variety of close-up filters to choose from. We opted for a set from Polaroid that cost £13 including postage. The set includes a +1, +2, +4 and +8 dioptre filter (which can be combined for added power), all supplied in a very neat nylon wallet. We chose a 58mm
BECAUSE THESE ACCESSORIES ALLOW YOU TO GET CLOSER TO THE SUBJECT THAN NORMAL, YOU CAN CAPTURE IMAGES THAT BOAST A MUCH HIGHER LEVEL OF MAGNIFICATION THAN A STANDARD LENS

filter size to fit our lenses, although all sizes from 37mm to 77mm are available.

When shooting close-ups with the Raynox (or close-up filters), you can leave the lens on AF and shoot as normal. Because these accessories allow you to get closer to the subject than usual, you can capture images that boast a much higher magnification than a standard lens can achieve. However, you need to be aware of a couple of constraints.

The first is that with the Raynox attached, your lens is incapable of focusing at longer distances, in other words, you’re limited to close shooting distances only. The other is that you need to avoid using wide-angle focal lengths with the Raynox as it can lead to severe vignetting, because it’s physically smaller than the front element of some lenses. This only occurs when used with lenses with wide-angle focal lengths, including kit zooms.

Our comparison set on the next page illustrates an extreme example of this. The Raynox website states you should stick to focal lengths of 50mm (full-frame) or 75mm (APS-C) to avoid signs of darkening at the edges and our tests verify this. Because the Raynox DCR-250 uses an adaptor to clip it to lenses, you’re free to experiment with different focal lengths of lenses, as long as filter threads are between 52mm to 67mm.

You’re best off using it with prime lenses rather than zooms to maximise image quality, but you should take test shots with all suitable lenses – at different focal lengths if they’re zooms – and see how results vary.

For this article, I predominantly used two low-cost zooms – the latest Canon EF-S 18-55mm IS STM kit zoom and a 15-year-old Canon EF 28-80mm lens. The camera was the entry-level Canon EOS 700D.

While autofocus is convenient for general photography, it’s not always ideal when shooting at such close focusing distances, so I’d strongly suggest you consider switching the lens to manual focus and taking control yourself. With certain subjects like flowers, using manual focus allows you to choose exactly where to focus – leaving AF switched can result in the wrong area of the flower being sharply recorded due to the AF sensor locking on to the closest part of the subject.

Raynox DCR-250

Because these accessories allow you to get closer to the subject than normal, you can capture images that boast a much higher level of magnification than a standard lens.

- **Raynox DCR-250 SUPER MACRO CONVERSION LENS**

| **Price:** £43 from Amazon (price includes Amazon Prime delivery) |
| **Optical construction:** Three lenses in two groups, all coated optical glass |
| **Magnification:** Eight dioptres |
| **Design:** Lens element with 49mm front filter thread and 43mm rear thread, which attaches to a universal adaptor that clips to lenses from 52mm to 67mm |
| **Supplied accessory:** Storage case, caps |
| **Size:** 53x18mm |
| **Weight:** 60g |
| **Website:** www.raynox.com |
Shooting close-ups

- Take your time to ensure perfect focus as depth-of-field is very limited with close-ups.
- Keep an eye on your exposure times to try and avoid shake – increase the ISO as well as adjusting the aperture.
- Sharpness is best at the centre, so compose your subject so that the focal point is in the middle of the frame.
- If shooting insects, aim for a morning start when they’re more docile.
- Zooms offer versatility in composition, but use prime lenses for the ultimate in quality.
- Try a variety of lenses. Each offers different magnification ratios and focusing distances.
- Keep a silver/white reflector handy to bounce light onto your subject.
- Minimise aberrations by using mid-aperture settings, such as f/6.3 to f/8.
- Don’t always try for maximum magnification – sometimes less is more in terms of visual impact.
- Close-up filters can be combined but doing so will degrade image quality.
- Experiment with focusing techniques – using manual focus and physically moving forwards and backwards works well.

ABOVE: Using the Canon EF-S 18-55mm at 18mm includes the Raynox in the image. There is no sign of this problem when the lens is at 45mm.

ABOVE RIGHT: Shot from the same position, these images show the effect of using the Raynox and Polaroid close-up filters on the Canon 18-55mm.

If you’ve never used manual focus before, don’t be put off; you’ll find it easier than you think and the camera’s AF confirmation icon in the viewfinder (as well as the AF beep) will activate when you have perfectly focused on the subject.

The method I’ve found easiest to use is to set the lens to manual focus and its minimum focusing distance. I then physically move myself closer and further away until the subject appears sharp within the viewfinder.

This approach is obviously for when you are handholding the camera. If you’re using a tripod, the process is more laborious as you physically have to shift its position. If your tripod has a centre column that can be placed in a horizontal position, your life is made a little easier, as you can set your camera up so that it’s effectively at one end of an ‘arm’, meaning you only have to pull the column forwards or backwards to achieve focus.

These two methods assume you want to maximise magnification, but in reality you’ll find that you can get so close with the Raynox that you’ll often not push it to its limits to compose a nice image. As you can see from the butterfly images, while the Raynox allows you to capture detailed images of the
insect’s eye, moving further back sets it against a colourful backdrop for visual impact.
As well as the challenges faced with achieving maximum magnification, another problem you will face is the close shooting distances you’ll be working with. With the Raynox fitted, you can get within a few centimetres of your subject, so there is a real risk of blocking light from reaching your scene or of scaring away flighty creatures. It seems that I’ve focused mainly on the restrictions rather than the benefits of the Raynox, but that’s simply because it’s a relatively unknown product, so I wanted to cover its use before moving on to its performance. Thankfully, in this respect, I’ve pretty much nothing but great praise for the Raynox DCR-250. The quality of the images produced using the Raynox is excellent, with decent resolution throughout the image area and no major evidence of a drop-off in image sharpness, even towards the edges. While low-powered close-up filters like a +2 and +4 retain good sharpness, more powerful offerings like a +10 show a marked drop in quality, so the performance of the +8 Raynox stands out as exceptional. I also really like how the clip-on adaptor allows it to be removed and replaced quickly. This proves useful when you want to quickly change lenses and transfer the Raynox from one to the other, but also when you quickly want to switch from shooting high-magnification close-ups to more general scenes without it in place. While working out around £40 may seem a lot to pay for a +8 dioptre close-up lens when kits with four different strengths of close-up filters are available for less than £15, the fact is that the extra expense is worth it. The difference in image quality is markedly better, while the universal adaptor effectively means the Raynox covers five of the most popular filter sizes, given the versatility to be swapped between lenses of different sizes. Given the choice, I’d definitely stump up the extra and choose the Raynox DCR-250 over a set of close-up filters. In terms of flexibility and quality, it’s hard to beat.
Canon MP-E 65mm f/2.8 1-5x Macro lens

Wildlife professional photographer Matt Cole provides an expert insight into Canon’s unique macro lens that boasts incredible magnification ratios from 1x to 5x life size!

SPECIFICATIONS
Guide Price: £1,250 / Street Price: £850
Construction: Ten elements in eight groups
Diaphragm blades: 5x
Minimum focus: 24cm
Minimum aperture: f/16
Maximum magnification: 5x
Filter thread: 58mm
Focusing: Manual
Size: 81x98mm
Weight: 710g

As a wildlife and nature photographer with a passion for insect macro photography, I take a variety of different styles of macro images from wide-angle habitat shots to high-magnification macro and everything in between. To take such a diverse range of images I need to use a selection of macro lenses with focal lengths ranging from 35mm to 150mm. However, for images with high magnification there is only one lens capable of shooting beyond life size (1x) without the need for extension tubes and that is the Canon MP-E 65mm.

The MP-E 65mm is a lens like no other. It is effectively a large, variable extension tube that is capable of a magnification range of 1x to 5x. It is manual focus only and expands in length from 9.5cm at 1x magnification to a sizeable 22.5cm at 5x magnification. It is perhaps not surprising that such an unusual lens takes a bit of getting used to. The working distance from the end of the lens to the subject is approximately 10cm at 1x magnification and a mere 4cm at 5x magnification. At such magnifications the depth-of-field becomes extraordinarily shallow. At f/8 it ranges from 1.1mm to 0.13mm (yes, that’s millimetres) at 1x to 5x magnification, respectively.

Given these characteristics, it is no wonder that many photographers consider the MP-E 65mm to be a difficult lens to master. However, by following a few tips and with a reasonable amount of practice it is possible to obtain excellent results from this lens.

The Canon MP-E 65mm allows you to shoot tiny subjects at high magnification. It’s a tricky lens to master, but if your technique is right then stunningly sharp images are entirely possible.

The golden rule when using the MP-E 65mm is to expose images using an external flashgun. This allows images to be taken handheld as the flash effectively freezes motion blur. Natural light images are possible but a tripod and a focusing rail are required and the limited working distance and depth-of-field make it difficult to position the camera correctly. Furthermore, the resultant long shutter speeds mean that the faintest breath of wind would render the subject blurred. The use of flash overcomes many of these difficulties.

When using flash it is important for the flash head to be as close to the subject as possible, which rules out the use of a hotshoe-mounted flash. The flashgun of choice for many users of the MP-E 65mm is the Canon MT-24EX twin flash. The alternative would be a regular external flashgun (e.g. a Canon Speedlite) on a side bracket that is flexible enough to allow the...
flash head to be positioned above the subject. It is also important that the flash is heavily diffused to prevent harsh shadows and burnt-out highlights. Unfortunately there are virtually no effective, commercially available diffusers for the MT-24, which is why photographers who use this lens/flash combination resort to DIY options. There are some commercially available options for diffusing a regular flashgun although many provide insufficient diffusion. The best options is a small softbox, although these may still require additional diffusion. Note that ringflashes are generally not favoured as they can be extremely difficult to diffuse.

Having set up the flash, the next step is to decide on the aperture. With this lens there is a very evident trade–off between depth–of–field and diffraction softening. A smaller aperture will increase the former at the expense of the latter. At minimum magnification, stopping down beyond f/11 or thereabouts will result in a noticeable softening of the image as a result of diffraction. At maximum magnification such softening will be noticeable even at larger apertures and so I rarely stop down beyond f/5.6 or f/6.3 when working at 5x magnification. This inability to work at smaller apertures further limits the already shallow depth–of–field and is one reason why users of this lens often resort to focus stacking to increase effective depth–of–field.

My recommendation to shoot without a tripod may surprise some but it is reasonably straightforward at least towards the lower end of the magnification range. The camera should be held firmly and pushed against the eye to minimise movement (unfortunately LiveView is not an option!). A useful trick is to hold the leaf or stick on which the subject is sitting with the left hand and to rest the end of the lens on that same hand. The subject and camera then move as one making it reasonably straightforward to ensure that the focus plane is placed in the right position, typically over an insect’s eye. It goes without saying that the insects photographed with this lens need to be cooperative, which is why it’s best to photograph early in the morning before they have warmed up.

Verdict

The Canon MP-E 65mm f/2.8 1–5x Macro is a unique lens requires specific techniques in terms of set-up, lighting and handling. For this reason it is not an ideal lens for those just starting out in macro photography. However, once mastered, it reveals itself to be of the highest optical quality and can produce highly original macro images with great impact. Of all the macro lenses that I own this would be the one lens that I couldn’t manage without and I would thoroughly recommend it to any keen macro photographer looking to work at a higher magnification.

<table>
<thead>
<tr>
<th>Build quality</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>Ease of use</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Performance</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Value</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Overall</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
How to use your metering & White Balance cards

The 18% grey card can be used to ensure perfect exposures when you’re shooting in tricky lighting conditions. Both reference cards can also be used to set a custom White Balance, but how you do this depends on your camera (refer to your camera’s manual). In the meantime, here is a brief explanation to get you started.

DIGITAL CAMERAS USE sophisticated exposure systems with a choice of metering patterns to suit different lighting situations. The systems work on the assumption that the area of the scene being metered is a mid-tone, or 18% grey to be precise: the average if all dark, light and mid-tones were mixed together. It’s the basis of all metering patterns and works really well, but can render incorrect exposures when the overall scene or subject is considerably lighter or darker than 18% grey. For example, very dark areas can fool the metering system into overexposing the image, while very light areas can fool the camera into underexposure, as the light meter will take a reading that renders it as a mid-tone.

As a camera is trying to render an image ‘grey’, it’s your job to ensure you compensate to keep the tones true to life. You can do this by either using one of your camera’s exposure override facilities, such as exposure compensation, the AE-Lock button or by metering from an area of the scene that has a mid-tone. And that’s where our grey card comes in. Using it is very simple as our step-by-step guide below illustrates.

The key thing to remember is that you need to place the grey card in similar lighting to your subject – for instance, don’t place it in a shaded area if your subject is bathed in sunlight. Also, make sure that the card fills the metering area – we recommend you use spot or partial metering as the card won’t need to fill the entire image area, but any is suitable. You can either lock the exposure using your camera’s AE-Lock facility or note the aperture and shutter speed, then switch to manual mode and dial in these settings. This latter method isn’t suitable on days where lighting is tricky. The card has AF reference lines to help your camera’s autofocus lock on to it. However, you don’t necessarily need it to be in focus to work correctly. The grey card (as well as the white card) can also be used to take a custom White Balance reading from, too.

1. **Getting started** If shooting in difficult lighting conditions, such as capturing a backlit subject, place the grey card in the same lighting as your subject and angle it towards you.

2. **Take a meter reading** Ensure that the entire metering area is filled by the grey card (in this instance we’re using spot metering) and lock the exposure with the AE-Lock button.

3. **Compose & shoot** With this exposure locked, you can compose your scene and take your shots. When you check it on your LCD monitor, the exposure should be perfect.
The Essential Guide to
CLOSE-UP PHOTOGRAPHY

Understanding the basics
Essential techniques and terms explained to prepare you for the world of close-ups

Explore still-life close-up
A variety of inventive ways to photograph everyday objects in your home and garden

Nature masterclass
Expert advice and essential techniques for great close-ups of flowers and insects

The wonder of water
Discover a number of brilliant ways you can use water in your close-up photography

Creative close-ups
A wealth of ideas and inspiration on how to add a creative edge to your close-up images

Understanding macro kit
A look at macro lenses, close-up filters and extension tubes, plus great budget options

INSIDE!
EXPERT ADVICE TO HELP YOU TAKE BETTER PICTURES

FROM THE EXPERTS AT
Digital SLR Photography